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Chương 1:tổng quan


WiseImage là một bộ biến đổi raster thành vectơ. Sử dụng WiseImage, Bạn có thể biên tập, cập nhật và tự động số hóa những hình ảnh Scan như bản đồ, bản vẽ, những bức họa và đồ họa khác. 

WiseImage là một trình biên tập hybrid (gồm có raster và vector).


Những bản vẽ hybrid gồm có ảnh đơn sắc, grayscale và màu với những phần tử vectơ. Nhiều hình ảnh raster có thể được load, và số lượng hình ảnh điều khiển trong một thời gian làm việc chỉ bị giới hạn bởi bộ nhớ của máy. WiseImage cho phép không giới hạn những hình ảnh đã nạp được thu xếp trong không gian làm việc .


Những trạng thái khác nhau của những đối tượng raster và vectơ sử dụng những thao tác khác nhau để xử lý chúng. Một số trường hợp rõ ràng trực giác, một số trường hợp đòi hỏi phải xử lý tinh tế, một số trường hợp yêu cầu hiểu biết những khái niệm đặc biệt.


Phạm vi chính WiseImage là ứng dụng là CAD / CAM, GIS, EDM / TDM, Repro.

Những đối tượng Vectơ được tạo ra và biên tập sử dụng sự đa dạng của những công cụ. Những Vectơ có thể được nhập khẩu vào trong WiseImage hoặc xuất khẩu tới khuôn dạng file  *. DXF.


WiseImage hỗ trợ đa số các khuôn dạng rastter image bao gồm RLC, TIFFxe "TIFF", PCX, CALS  và BMP.


Về căn bản, WiseImage dựa vào kỹ thuật sau :


-Vectorization - chuyển đổi những line, cung, vòng tròn raster thành đối tượng vectơ . WiseImage hỗ trợ thủ tục vectơ tự động, chọn và trace (vạch theo) .


-Rasterization - chuyển đổi đối tượng vectơ thành raster image


- Đoán nhận những ký tự và symbol dựa trên hình dạng và sự phức tạp của chúng.


-Binarization - Pick chấm điểm màu trên raster image để xác định màu 


-Calibration -Loại trừ những trạng thái không rõ ràng của ảnh scan,  hoặc sự biến dạng từ những lỗi do scanner.


-Sự hiệu chỉnh và cách lọc một hình ảnh cho vectơ.

-Layering - Sự chuyển dịch yêu cầu thông tin từ lớp hình ảnh này sang lớp khác 


-Tạo ra đối tượng vectơ và raster mới .


-Load và điều khiển nhiều hình ảnh raster với nhiều khuôn dạng.


WiseImage hỗ trợ tất cả kỹ thuật với nhiều công cụ bổ sung cho phép giải quyết  những nhiệm vụ phức tạp .Tại sao không đơn giản vấn đề vectơ ? Nếu bạn là người tập sự trong WiseImage bạn có thể hỏi một câu hỏi : “ Có quá nhiều nút và lệnh? Tại sao không đơn giản nhấn nút và bắt đầu vectơ ngay lập tức? ”. Nếu bạn thực hiện thao tác này trên vài hình ảnh khác nhau, bạn có thể sớm nhận ra quy tắc : Kết quả Vectơ tự động chỉ hòan hảo trên những hình ảnh đơn giản. 



Hướng dẫn này mô tả xung quanh kỹ thuật và những thủ tục mà cho phép biến đổi những đối tượng và những hình ảnh raster, sử dụng những thao tác thông thường được áp dụng tới những đối tượng vectơ:


1.
Thay đổi những thuộc tính đường, cung, vòng tròn (lengths, colors, geometry, vân vân) mà không thực hiện thao tác phân biệt vectơ .


2.
Vạch theo những thực thể raster như thể chúng là những đối tượng vectơ và tạo ra những hình ảnh từ những đối tượng được chọn .


3.
Đoán nhận hacth, mũi tên, ký tự, symbol.


4.
Tìm kiếm những đối tượng raster và thay thế đối tượng vectơ có hình dạng tương tự. 


5.
Loại bỏ vết lốm đốm từ hình ảnh hoặc đối tượng quá nhỏ trên lớp riêng biệt.


6.
Điều khiển màu trên những hình ảnh màu, hình thành những chi tiết phức tạp và chuyển đổi trực tiếp những hình ảnh màu hoặc sử dụng những thủ tục lớp


7.
Lựa chọn những đối tượng với hơn 40 cách, bao gồm sự chọn lọc với việc đoán nhận bản chất và kiểu những đối tượng.


8.
Sửa chữa những sự biến dạng của việc scan trong một phạm vi rộng và cải thiện một cách đáng kể chất lượng của những hình ảnh nghèo nàn.


9.
Tạo ra nhiều bản sao của đối tượng chọn với một lệnh đơn.


10.Tạo ra scrip và chạy nó 

Những điểm mới trong WiseImage pro V10:

+Giao diện:


- Profiles: để chuyển và chia sẻ những sự thiết đặt WiseImage.


- Full Screen mode: để mở rộng không gian làm việc rõ ràng.


- Command line: cho sự thực hiện tiện lợi và nhanh các Lệnh WiseImage và chính xác 


- Symbol Recognition Template Library: Một nguồn đơn cho những Khung mẫu Ký hiệu mà có thể được sử dụng cho sự vạch dấu Ký hiệu, chuyển đổi raster thành vectơ, chọn lọc đối tượng lai, sự Tìm kiếm và Thay thế.


+Những đặc tính Tài liệu:


-Quản lý những kiểu đường mới và phức tạp


-Text style cho quản lý văn bản và tính tương thích tiện lợi với những tiêu chuẩn Cad với  sự hỗ trợ text nghiêng.


-Bổ sung hỗ trợ để làm việc với những hình ảnh 16M pixels width/64R pixels height.


-xóa bỏ những đối tượng không dùng từ một tài liệu WiseImage.


- Thuộc tính tuỳ biến sử dụng cho cho tất cả những đối tượng WiseImage.


- Những tùy chọn mage Transparency cho hình ảnh raster đơn sắc, grayscale và màu.


-Hiển thị và in những đường phức tạp 


+ Vectorization: Tự động chuyển đổi từ raster tới Vectơ cho những hình ảnh màu và grayscale.


+Biên tạp Vector: Sửa chữa Tự động Polylines với một thiết đặt những tùy chọn phong phú để hòa trộn, và kết hợp polylines. Cải thiện kiểu soạn thảo Polyline với nhiều đoạn và những sự chọn lọc và thao tác các nút.


+Quản lý file:


xuất khẩu file AutoCAD DWF ( Khuôn dạng Thiết kế Mạng).


hỗ trợ định dạng JPEG 2000.


Xuất-nhập khẩu khuôn dạng Mapinfo và ESRI .


Nhập khẩu / Xuất khẩu một văn bản và kích thước từ / tới một file DWG.

Chương 2: Các version của WiseImage


Những sản phẩm gì WiseImage có? Chương trình WiseImage được chia thành hai nhánh: Những phiên bản để làm việc trong AutoCAD và những phiên bản chạy độc lập trong Windows. Những phiên bản cũng bị chia cắt bởi tính hoạt động, cho ví dụ vài đặc tính không có trong phiên bản standard WiseImage, nhưng có trong phiên bản Pro. Những thông tin về sản phẩm và những phiên bản phần mềm khác có thể được tìm thấy trên www.csoft.com.

Những sự khác nhau giữa WiseImage và WiseImage Pro: chính sự khác nhau giữa WiseImage Pro và phiên bản standard của WiseImage là để so sánh tới WiseImage Pro, WiseImage thiếu những đặc tính sau: Vectơ tự động, sự đoán nhận văn bản, và vài công cụ cho soạn thảo và sửa chữa vectơ. 


Đây là danh sách của những lệnh không có trong WiseImage: Raster to vector; Những tùy chọn chuyển đổi ; Huấn luyện OCR; Soạn thảo những văn bản được thừa nhận; Nối những vectơ Tới …; Trim vectơ; Mở rộng vectơ; Làm Gãy vectơ; tới sự giao nhau; Tạo ra chamfer; Sắp thẳng hàng góc và khoảng cách. 


WiseImage có lệnh này nhưng hội thoại tương ứng không có tab Recognition và Texts 


Demo versions Gồm có những phiên bản Demo cho Windows và cho AutoCAD. Phiên bản Demo cho Windows không có hàm lưu những kết quả, phiên bản cho AutoCAD cho Xử lý có giới hạn những hình ảnh. 


Những hệ thống giúp đỡ cho những hệ thống và những tài liệu WiseImage đều khác nhau 

Những phiên bản WiseImage có thể làm việc với phiên bản Windows: MS Windows 98, MS Windows NT 4.0, MS Windows 2000, MS Windows ME, MS Windows XP.

Với AutoCAD:2000/2000i/2002/2004/2005/2006 và 

AutoCADLT: 2000/2000i/2002/2004/2005/2006 

WiseImage có thể cũng được sử dụng với những phiên bản sản phẩm AutoDesk khác nhau, dựa vào AutoCAD, Cho ví dụ, Mechanical Desktop, Architectural Desktop, AutoCAD Map. Trong trường hợp, nếu vài phiên bản AutoCAD được thiết đặt bạn sẽ được hỏi để chọn những phiên bản mà bạn muốn thiết đặt WiseImage. Với những license AutoCAD có thể cũng làm việc với WiseImage cho Windows

Cài đặt: Chạy tập tin Setup.exe, chương trình sẽ yêu cầu nhập serial, với bản đã bẻ khoá, nhập một số bất kỳ, cài đặt bình thường. Sau khi hoàn thành, vào mục đăng ký để đăng ký license

Chương 3: cơ sở WiseImage

i-Cơ sở WiseImage 
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WiseImage có thể chuyển đổi những hình ảnh raster tới những đối tượng vectơ trên máy tính. WiseImage là một trình biên tập bản vẽ đối tượng lai và raster để chuyển thành vectơ. Sử dụng WiseImage, Bạn có thể soạn thảo, cập nhật và tự động l vectơ những hình ảnh scan như những bản đồ, những bản vẽ, những bức họa và đồ thị khác. Những bản vẽ Lai (hybrid) gồm có một hình ảnh đơn sắc, grayscale và màu mà raster chồng với những phần tử vectơ. Nhiều hình ảnh raster có thể được load, và số lượng những hình ảnh raster điều khiển trong một phiên làm việc không giới hạn. WiseImage cho phép những hình ảnh đã nạp sẽ tùy thích được thu xếp trong không gian làm việc vô hạn định.

Những đối tượng Vectơ tạo ra và soạn thảo sử dụng sự đa dạng của những công cụ. Những bản vẽ Vectơ có thể được nhập khẩu vào trong WiseImage hoặc xuất khẩu tới khuôn dạng file AutoCAD *. DXF. WiseImage hỗ trợ đa số các khuôn dạng raster bao gồm RLC, Tiff, PCX, CALS và BMP.

WiseImage hỗ trợ tất cả kỹ thuật với nhiều công cụ bổ sung và cho phép bạn giải quyết những nhiệm vụ phức tạp và khác thường. 
ii-WiseImage Document


Không gian làm việc document không giới hạn;


lớp, những thuộc tính gán cho đối tượng bởi lớp;


Không giới hạn số lượng load ảnh đơn sắc, grayscale, và những hình ảnh màu, 


Cất giữ những hình ảnh trong một file tài liệu như được nhúng trong những file riêng biệt 


Những thư viện cho vectơ, raster, và Hybrid;


Clip đa giác và chữ nhật trên những hình ảnh raster;


Điều khiển thứ tự hiển thị những đối tượng ;


Thông tin có tính chất thuộc ngữ;


Ngôn ngữ scrip, hỗ trợ VB scrip;


hỗ trợ scanner , hỗ trợ định hướng cho những scanner ;


Mở và lưu những file DWG cho AutoCAD R14/  2000 ...;


Mở nhiều trang TIF , cách trình bày, và lưu trữ

Chương 4: giao diện
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i-Trình bày hoặc che giấu những thanh công cụ.


Từ Thực đơn View, chọn Show Toolbar, rồi chọn tên thanh công cụ ,hoặc nhấn phải trên bất kỳ thanh công cụ nào và lựa chọn một thanh công cụ mong muốn từ thực đơn ngữ cảnh

ii-Trình bày hoặc che giấu thanh tình trạng trên màn ảnh.


Từ Thực đơn View, chọn View. hoặc nhấn phải trên thanh Tình trạng và lchọn Show Status Bar từ thực đơn ngữ cảnh.

iii-Trình bày hoặc che giấu thước đo trên màn ảnh.


Từ Thực đơn View, chọn Rulers.hoặc kích nút [image: image3.png]


 trên thanh công cụ View. hoặc nhấn phải trên những thước đo và lựa chọn Show Rulers từ thực đơn ngữ cảnh.

iv-Chia nhiều cửa sổ tài liệu


Thực đơn View chứa đựng lệnh để chia cửa sổ thành hai hoặc bốn ô . Bạn có thể thiết đặt  những kiểu khác nhau cho sự trình bày hình ảnh trong mỗi ô vuông , đặc biệt, sự thiết đặt hệ số phóng đại khác nhau . Nó có thể hữu ích khi bạn làm việc với những chi tiết nhỏ và bạn không muốn mất toàn bộ hình ảnh ra khỏi tầm nhìn
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   chia thành 4 khung
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  chia thành 2 khung ngang
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  chia thành 2 khung dọc
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   xem kiểu đơn

v-Named views
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 xe "Named views"

Cơ chế của named view gồm có một hộp danh sách

 của những thiết đặt tầm nhìn và hai nút trong thanh công 

cụ Properties . Bạn có thể tạo ra một tầm nhìn

 mới bởi việc nhập tên của nó hộp hoặc nhấn  nút [image: image9.png]


. 

Chương trình giữ vị trí và tỷ lệ cửa sổ tài liệu. Hoặc, chọn 

tầm nhìn từ danh sách, tự động khôi phục cấu hình . 

 Để xóa một tầm nhìn, lựa chọn nó từ danh sách và nhấn nút [image: image10.png]


. Những thiết đặt có sẵn không được sửa mà cũng không xóa được .


vi-Cửa sổ Xem trước


Đa số các hội thoại WiseImage trang bị một cửa sổ xem trước, bạn có thể quan sát kết quả của một thao tác trên một phần hình ảnh được chọn trong khi điều chỉnh những tham số của nó. Những hiệu ứng của những tham số điều chỉnh được phảnửanh trong cửa sổ xem trước. Bạn có thể mở vài cửa sổ xem trước, cho phép quan sát những sự thay đổi trên vài đoạn hình ảnh đồng thời.
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Phần hình ảnh trình bày trong ô vuông tráI trái của hội thoại được gọi là một vùng xem trước. Một khung màu trong hình ảnh cho biết vùng xem trước. Bạn có thể quản lý vùng xem trước sử dụng Thanh công cụ Preview Dragger xuất hiện với việc mở hội thoại.


vii-Birds Eye 


Trình bày cửa sổ, nơi bạn có thể lựa chọn một bộ phận của tài liệu để zoom và pan.

khởi động lệnh : Từ Thực đơn View, chọn Birds Eye. hoặc Kích nút [image: image13.png]


 trên thanh công cụ View

viii-ẩn những vectơ


Tắt hiển thị những đối tượng vectơ trên màn ảnh. Những đối tượng được ẩn không thể chọn với những lệnh lựa chọn. Khởi động lệnh này từ thực đơn View (hoặc kích nút [image: image14.png]


) đặc biệt thuận lợi để định hướng trong file tài liệu WiseImage có chứa đựng nhiều đối tượng phức tạp hoặc được tạo ra bởi người dùng khác, và cũng cho những người mới bắt đầu. 

ix-ẩn những raster


Tắt hiển thị những hình ảnh raster trên màn ảnh. Những đối tượng được tắt Không thể chọn với những lệnh lựa chọn; Thưkc hiện lệnh này từ Thực đơn View (hoặc kích [image: image15.png]


 ) giúp định hướng trong file tài liệu WiseImage, mà chứa đựng nhiều đối tượng phức tạp …

x-hiển thị chiều rộng


Những Toggles để trình bày/ dấu đối tượng chiều rộng đường.  Khi Show Width tắt, những đối tượng được cho thấy như khung dây , để lộ ra những chi tiết nhỏ xíu và rác không cần thiết. Để khởi động lệnh :  Từ Thực đơn View, chọn Show Width. hoặc Kích nút [image: image16.png]


 trên thanh công cụ view. hoặc kích nút SW trên thanh trạng thái.

xi- Command Line


Hàng Lệnh là một cửa sổ văn bản từ đó những Lệnh WiseImage tương tác có thể được gọi và xử lý. Hàng lệnh phi đồ họa sử dụng giao diện cung cấp môi trường cho phép thi hành và những lệnh, hiển thị những sự nhắc nhở của nó trên màn ảnh, thực hiện những sự tính toán toán học , vân vân bằng việc sử dụng những ký tự riêng lẻ và những từ khóa tương tác. 


Phương pháp chuẩn của sự tương tác với WiseImage được thực hiện bởi việc sử dụng những cửa sổ hội thoại, Inspector , những thanh công cụ, và những thực đơn nhắp phải. Hàng Lệnh có thể được sử dụng cùng chung với mọi tương tác để tăng tốc hội thoại của người dùng với chương trình. Nó tiện lợi cho những người dùng đã và đang  làm việc với giao diện AutoCAD. Hàng Lệnh WiseImage nhập vào không phải phụ thuộc kiểu chữ hoa hoặc thường .


Những Lệnh, những bí danh và shortcuts: để nhập một Lệnh từ bàn phím, nhập đầy đủ tên lệnh trong hàng và nhấn enter hoặc phism space để thi hành . 


Một Lệnh bí danh là sự viết tắt được nhập trong Hàng Lệnh thay vì nhập toàn bộ tên Lệnh.


Những phím tắt hàng Lệnh tương tự như những bí danh nhưng giới thiệu một tập hợp những Lệnh nhóm lại bởi một tiêu chuẩn nhất định, ví dụ phím tắt S bắt đầu giới thiệu một tập hợp lệnh chọn lọc: 

[image: image17.png][All/Unselect/auto/Window/Polygone/Fence] <Selectdll>:





Danh sách đầy đủ của những tên Lệnh những bí danh và những phím tắt được đăng ký có thể được thấy trong cửa sổ dòng lệnh bởi việc nhập dấu ‘  ( Dấu nháy). 


Command Line prompt :WiseImage mặc định nhắc 

Command:

Nhưng nó thay đổi phụ thuộc vào Lệnh hiện thời hoặc trạng tháI chương trình. Lệnh nhắc có thể bao gồm miêu tả những thông báo mà được hỉên thị trong dòng trạng thái khi Lệnh đang chạy: Specify center point for circle:


Nó có thể bao gồm những từ khóa trong những dấu móc vuông phân ra bởi dấu gạch chéo, khi một sự lựa chọn cần phải được tạo :

[image: image18.png][Auto/aRc/Circle/Hatch/Line/Outline/Shape/line Following] <TraceAuto>:




 

bạn có thể nhập bất kỳ từ khóa nào bằng tay hoặc chỉ cần kích vào nó. Một từ khóa chỉ rõ trong những dấu móc là từ khóa " Theo mặc định ". Để chọn nó, nhấn phím Enter (phím kết thúc nhập). Để chọn một từ khóa, bạn có thể nhập một trong những từ khóa trong những dấu móc. Bạn có thể vào chữ hoa hoặc những thường. 

xii- Yêu cầu tảI 


WiseImage có cấu trúc mô đun, cho phép cất giữ những tài nguyên hệ thống và tăng tốc độ khởi động chương trình và làm việc. 


Kiến trúc mô đun cũng cho phép nhanh chóng và đơn giản bật tắt bổ sung  những mô đun WiseImage (plug-ins). 


Đây là những câu hỏi hay gặp của người ding:


- Tôi không thể khởi động lệnh bởi vì nó là không hoạt động ( màu xám)


Lựa chọn những đối tượng trong tài liệu. Để thi hành lệnh thật cần thiết để lựa chọn những đối tượng để áp dụng tới những lệnh này 


-Tại sao vài lệnh nghiêng trong thực đơn và có những mũi tên ở những góc biểu tượng khi khởi động chương trình?

Những phương tiện này là những mô đun của những lệnh không được sử dụng với bạn, tại sao cái đó chúng Không load. Cơ chế này cất giữ những tài nguyên hệ thống.

xiii-Những lệnh xuyên suốt


Một vài lệnh nào đó có thể được gọiữuyên suốt, trong khi lệnh khác đang thi hành. Những lệnh như vậy : thay đổi tỷ lệ hiển thị, đo ( hội thoại Measure) và những lệnh khác. Sau một lệnh xuyên suốt đã được hoàn thành, Lệnh chính sẽ trởlại.

xiv-Giao diện tiếng Anh trong Những phiên bản WiseImage


Nếu bạn làm việc với phiên bản WiseImage quốc gia ( tiếng Tây ban nha e.g.,) tất cả các thông báo và những văn bản khác hiển thị trong ngôn ngữ quốc gia.  Nếu bạn muốn chuyển tới giao diện tiếng Anh, hãy làm thủ tục sau. (Ghi nhớ rằng, nếu bạn thay đổi tới giao diện tiếng Anh , mọi thiết đặt của những thực đơn, những thanh công cụ, những phím khóa và những từ khóa được làm với lệnh Customize sẽ mất.) 


1. Bắt đầu lệnh Customize từ thực đơn Tools ([image: image19.png]


). Trên Tab Toolbars  kích vào Reset All và xác nhận việc thiết lập lại. Hoàn thành sự thực hiện chương trình.


2. Tìm thư mục nơi chương trình được thiết đặt. ví dụ : " "C:\Program Files\Consistent Software\Product Name\" 


3. Tìm file Với mở rộng .WLD, định vị trong thư mục sản phẩm và thay đổi đuôi mở rộng 


4. Khởi động chương trình, giao diện được thay đổi.  Để trả lại giao diện cũ, thiết lập lại mọi thứ với Reset All (được mô tả trong bước 1). Đóng ch​ơng trình. Thay đổi đuôI mở rộng của file WLD (đã thay đổi ở bước trên) trở lại .WLD.

Chương 5: quá trình hoạt động

i-Tạo:

1-Tài liệu mới


Tạo ra một tài liệu WiseImage mới có kích thước vô tận. Một tài liệu WiseImage cho phép cất giữ dữ liệu raster và vectơ cùng lúc. Hơn nữa, những hình ảnh raster có thể được chèn vào như những sự tham khảo tới những file ngoài. Những file tài liệu WiseImage có đuôi mở rộng *.CWS. 


phiên bản Spotlight 4.x cũng làm việc với khuôn dạng CWS, nhưng những phiên bản này trước đây, để chuyển và trao đổi dữ liệu giữa phiên bản 5 và phiên bản 4 cần sử dụng lệnh Xuất khẩu để thu được khuôn dạng thích hợp để đọc trong phiên bản 4.0;  phiên bản 5 có thể đọc định dạng 4 và ghi lại dữ liệu tới định dạng 5.Để khởi động lệnh : Từ thực đơn File, chọn New. hoặc Kích nút [image: image20.png]


 trên thanh công cụ chính.

2-Tạo raster image mới


1.Chọn Neww image từ thực đơn Insert
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2.Nhập kích thước hình ảnh trong hộp Width và Height  hoặc từ danh sách Standard Paper Sizes, lựa chọn kích thước hình ảnh.

*
Danh sách này chỉ chứa đựng những khuôn dạng Sheet có trong danh sách Paper Formats  của hộp thoại Options. Bạn có thể  thêm hoặc giảm bớt danh sách này.  (xem phần “ Điều chỉnh ứng dụng ” ).


3.Lựa chọn một định hư​ớng cho khuôn dạng sheet xác định trong hộp Orientation 

4.Lựa chọn độ phân giải hình ảnh trong DPI, và những đơn vị phép đo sẽ được sử dụng trong Units.


5.Kích OK.


Chỉ rõ một điểm chèn, tỷ lệ  hoặc góc quay .

Thu nhận một hình ảnh từ scanner và chèn nó trong tài liệu hiện thời.


Từ thực đơn Insert, hãy chọn New Image from Scanner.hoặc Kích nút [image: image22.png]


 trên thanh công cụ chèn.


Tạo hình ảnh mới từ sự chọn lọc


Thay đổi một tập hợp chọn lọc tới một hình ảnh riêng biệt. Khi những đối tượng được lựa chọn, lệnh tạo ra một hình ảnh mới với những kích thước tính toán bởi ranh giới của toàn bộ đối tượng.


1. Lựa chọn những đối tượng vectơ.


2. Khởi động lệnh từ thực đơn hoặc thanh công cụ.


3. Trong hội thoại trình bày hình ảnh mới bạn có thể thay đổi những tham số của Hình ảnh raster tạo ra( DPI, kiểu  màu ) hoặc chấp nhận.


Những hộp Chiều rộng và Chiều cao tự động trình bày kích thước của những đối tượng tính toán trên cơ sở ranh giới toàn bộ của tất cả các đối tượng được chọn.


Làm sao để tạo ra một hình ảnh mới từ những đối tượng raster và vectơ được chọn?


1. Lựa chọn những hình ảnh raster và những đối tượng vectơ.


2. Khởi động lệnh từ thực đơn hoặc thanh công cụ.  Nếu bạn tạo ra một hình ảnh trên cơ sở của những hình ảnh raster khác, thì những thuộc tính của hình ảnh như vậy được thừa kế từ những hình ảnh này. Trong trường hợp những hình ảnh này có khác nhau về DPI, không gian màu (hai hình ảnh được lựa chọn với 300 DPI và 200 DPI), Hội thoại New Image xuất hiện sử dụng cái nào Bạn có thể chỉ rõ những thuộc tính này cho hình ảnh mới hoặc chấp nhận dòng nhắc.


Khi tạo ra một hình ảnh trong kiểu RGB , 8-bit indexed, grayscale, cần phải chỉ rõ màu ban đầu [image: image23.png]Initial color



 cho hình ảnh mới.


Hình ảnh đang tồn tại xuyên qua hình ảnh mới từ sự chọn lọc luôn luôn có tỷ lệ = 1.0 và góc quay bằng 0, dù bản chính hình vẽ được quay hoặc tỷ lệ khác nhau.


Hình ảnh mới sẽ có thuộc tính màu nền mặc định.  Nếu những hình ảnh nguyên bản có ranh giới Clip, thì chỉ dữ liệu rõ ràng được sử dụng khi tạo ra một hình ảnh mới. 

Để khởi động lệnh : Từ thực đơn insert, chọn New image from selection. Hoặc kích là nút [image: image24.png]


 trên thanh công cụ insert.

3-Khung mẫu tài liệu và raster 

Khung mẫu tài liệu:


Khung mẫu là tài liệu WiseImage trên cơ sở của đó một tài liệu mới được tạo ra. Khung mẫu đại diện tài liệu WiseImage và có thể chứa đựng dữ liệu của tất cả các kiểu ( raster, vectơ). Những khung mẫu có thể được sử dụng



khi việc tạo ra một tài liệu mới và khi mở một hình ảnh raster. Khung mẫu có thể cố định hoặc được chọn từ danh sách mỗi lần một tài liệu mới được tạo ra hoặc một hình ảnh được mở.


Làm sao để tạo ra khung mẫu của người dùng? 


1. Chuẩn bị một tài liệu bởi việc vẽ khối khung và tiêu đề. 


2. Lư tài liệu trong khuôn dạng CWS.


Làm sao để sử dụng những khung mẫu? 


Có vài cách để làm việc với những khung mẫu. Tạo ra một tài liệu mới ( Hoặc mở một hình ảnh) luôn luôn sử dụng cùng khung mẫu đó. Chọn tham số Use default và chỉ rõ tên File trong tùy chọn Default File Name. Bật tuỳ chọn Ask for file   nếu bạn sử dụng vài khung mẫu khác nhau.



Từ nay trở đi, mỗi lần một tài liệu mới được tạo ra ( Hoặc một raster được mở) bạn có thể chọn file khung mẫu từ hộp thoại.
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Nếu file khung mẫu không sẵn có hoặc đường dẫn tới chúng được chỉ không đúng, thông báo xuất hiện : File not found" và một tài liệu mới sẽ được tạo ra mà không có khung mẫu.


Làm sao để tắt cách dùng của những khung mẫu?


1. Nhấn CTRL +E NTER để mở hội thoại Preferences.


2. Trong mục sử dụng, bật tùy chọn none của mục tương ứng.


Chú ý!Khi một tài liệu mới đang được tạo ra trên cơ sở của khung mẫu, tài liệu được sử dụng như khung mẫu không được mở trong WiseImage cùng lúc.


Cách dùng những khung mẫu


Mục này của Preferences được thiết kế để những khung mẫu điều khiển cho tài liệu mới và mở những hình ảnh raster. Nhìn thấy nhiều thông tin về sử dụng khung mẫu tài liệu hơn.
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None :
Những khung mẫu được sử dụng;


Use default:
File chỉ rõ trong tùy chọn khung mẫu Mặc định đ​ợc sử dụng nh​ khung mẫu hiện thời;


Default template: thiết đặt tên cho file khung mẫu. Nếu bạn chỉ rõ tên cho file, nó phải được định vị trong thư mục TEMPLATES của thư mục gốc WiseImage.  Nếu không, hãy chỉ rõ đường dẫn đầy đủ tới file khung mẫu. Nhớ là không có khoảng trống nào ở vị trí đầu hoặc cuối của đư​ờng dẫn;


Ask for file:
Mỗi thời gian một tài liệu mới được tạo ra hoặc một hình ảnh raster được mở, bạn được nhắc để chọn một tài liệu sẽ được sử dụng như khung mẫu. 

ii-Mở và lưu:

1- Mở


Mở một hình ảnh hiện hữu hoặc những bản vẽ của tài liệu WiseImage và AutoCAD. Khi tạo sự chọn lọc, hiển thị danh sách khuôn dạng kiểu file hỗ trợ có thể được mở với WiseImage.

[image: image28.png]FSpported File Types.





Thông tin về vị trí raster khi mở :


Nếu khuôn dạng chứa đựng bất kỳ thông tin bổ sung nào, thì nó được sử dụng khi mở. Khi mở Geo TIFF  thông tin trên vị trí raster được sử dụng khi hình ảnh được định vị, cũng như khi việc mở raster với world-file ( nếu option trong Preferences đã bật) Thông tin vị trí, tỷ lệ và góc được đọc trong tàii liệu. Tùy chọn trong Preferences ảnh hưởng nhiều trang TIFF được mở.


Trong thực đơn File, có một danh sách của 5 file sử dụng sau nhất.


Những định dạng mở được trong WiseImage:


Đuôi mở rộng                                     Dữ liệu                   
 phần mềm

CWS (7.0, 6.0, 5.0, 2.0)


Raster+Vector

WiseImage /Spotlight

DWG (2004, 2000, R14, R13, R11, R10)
Vector+ Raster
AutoCAD

DXF (2004, 2000, R14, R13, R11, R10)
Vector+ Raster
AutoCAD

TIF (+Multipage, +Georeferenced)

Raster + geodata
-

RLC





Raster
-

BMP





Raster
-

JPG/JPEG




Raster
-

JP2/J2K (JPEG 2000)



Raster
-

PNG





Raster
-

PCX





Raster
-

C4





Raster
-

CAL





Raster
-

TG4





Raster
-

CIT (+ Multipage)



Raster
-

ECW (limited edition)



Raster
-

SID





Raster
-

CT4





Raster
-

T4





Raster
-

CG4





Raster
-

GP4





Raster
-

MIL





Raster
-

WS





Vector


Spotlight 3.x

VC5





Vector


Spotlight 3.x

VC4





Vector


Spotlight 3.x


Khi lưu trong DWG, những tham số và những sự thiết đặt WiseImage cũng được cất giữ; chúng sẽ được sử dụng khi file này được mở sau này. Lưu ý, khi mở file DWG trong AutoCAD bạn có một thông báo, những tài liệu này chứa đựng Proxy-objects. Bạn có thể lờ đi thông báo này, nó không ảnh hưởng gì công việc của bạn.


Ghi chú : không nênmở những tài liệu CWS được tạo ra với WiseImage 5. X trong phiên bản Spotlight 4.x, những tài liệu tạo ra với phiên bản mới hơn có thể chứa đựng những kiểu đối tượng mới, mà chưa đ​ợc hỗ trợ bởi phiên bản trước đây. Để những tài liệu trong WiseImage cao hơn được mở trong Spotlight 4.X, sử dụng lệnh Export trong khuôn dạng CWS 2.0. 

Để khởi động lệnh : Từ thực đơn File, chọn Open. hoặc Kích nút [image: image29.png]


 trên thanh công cụ chính.


Explore


Công cụ Explore được ửư dụng để tải những file trong một tài liệu WiseImage. công cụ này cung cấp tất cả các khả năng làm việc với những file Windows Explorer. Nó mở nhiều hình ảnh tại một thời điểm hoặc chèn vài hình ảnh raster một lúc, phân loại những file bởi kiểu, kích thước, vân vân.


1.Chọn Explore từ thực đơn File.


2.Lựa chọn một khuôn dạng file từ combo - box ở đáy hội thoại.


3.Trong ô vuông hội thoại lựa chọn những file ( Để chọn liên tục giữ phím SHIFT ) và di chuyển chúng với con chuột vào vị trí nào đó trong màn ảnh.  Nếu bạn di chuyển những file raster vào trong một tài liệu mở chúng sẽ được chèn vào.


Để khởi động lệnh : Từ thực đơn File, chọn Explore.

2-Lưu dữ liệu:


+Lưu tài liệu:


Nếu một tài liệu đã được tạo ra trong thời gian làm việc hiện thời, thì chương trình mở hội thoại Save As.


-Cất giữ trong khuôn dạng Color Workspace ( CWS):


Có vài phiên bản của khuôn dạng Color Workspace. WiseImage 5 sử dụng CWS 2.1, phiên bản chương trình trước đây (Spotlight 4) làm việc với CWS 2.0. Như vậy, ghi nhớ rằng bạn cần sử dụng khuôn dạng CWS 2.0 để chuyển dữ liệu từ WiseImage 5 đến Spotligh 4. Sử dụng lệnh Save As và Export chọn ColorWorkspace 2.0 từ danh sách khuôn dạng khi lưu / Xuất khẩu. 


-Lưu trữ trong khuôn dạng AutoCAD ( DWG)


Khi lưu trong DWG, Những tham số và những sự thiết đặt WiseImage cũng được cất giữ; chúng sẽ được sử dụng khi file này được mở. Lưu ý, Khi mở file DWG trong AutoCAD bạn có một thông báo, những tài liệu này đó chứa đựng Proxy-objects. Bạn có thể lờ đi thông báo này 


Để lưu tài liệu hoặc hình ảnh :


1. Chạy lệnh từ thực đơn hoặc thanh công cụ. 


2. Hình ảnh hoặc tài liệu sẽ được lưu


Ghi chú quan trọng :


Lệnh Save xóa quá trình UNDO. Nếu bạn bạn không muốn xóa UNDO khi lưu những hình ảnh, chọn Save từ hội thoại Image.


Để khởi động lệnh : Từ thực đơn File, chọn Save .hoặc kích nút [image: image30.png]


 trên thanh công cụ chính.

+ Save multipage:


Lưu những hình ảnh lựa chọn như những trang trong multipageTIFF ,bạn có thể lưu vài file raster định vị trong tài liệu WiseImage cho mộừuile đơn.


Để lưu trữ trong khuôn dạng nhiều trang :


1. Lựa chọn một hoặc vài hình ảnh ( chú ý rằng, chỉ những hình ảnh được chọn mới trở thành nhiều trang). Để tạo ra và cất giữ file nhiều trang:


2. Khởi động lệnh từ thực đơn.


3. Chọn thư mục nơi đến trong Look In..


4. Nhập tên trong File name.


5. Kích OK.


Để khởi động lệnh : Từ thực đơn File, chọn Save multipage.


+ Save raster image:


1. Từ thực đơn Tools, chọn Image, rồi kích Save As Trong hội thoại.


2. Lựa chọn khuôn dạng file raster, nếu bạn muốn thay đổi khuôn dạng hiện thời.


3. Lựa chọn thư mục muốn cất giữ hình ảnh.


4. Nhập tên mới trong Tên File hoặc lựa chọn một từ danh sách, nếu bạn muốn thay thế File hiện hữu.


5. Kích save


+Lưu với định dạng file nén (ECW):


Bạn có thể lựa chọn tỷ lệ nén từ combo box. Sử dụng tỷ lệ 20 : 1 Bạn có thể nén hình ảnh từ 500 Mb xuống còn 25 Mb, với tỷ lệ 2 : 1 nén còn một nửa. Tỷ lệ cũng ảnh hưởng kích thước file và chất lượng của hình ảnh bị nén. Những tỷ lệ cao giảm bớt kích thước file có chất lượng tồi hơn. Định dạng ECW có thể đặt sao cho có thể đạt được những kết quả tốt bởi sự điều chỉnh.


-Kích thước Block( Theo mặc định  64x64)


Định nghĩa kích thước khối để sử dụng trong quá trình nén.


Để cất giữ một hình ảnh trong khuôn dạng ECW


1. Trong hội thoại lưu những hình raster, chọn ER Mapper Wavelet-compression (*.ECW) từ combo - box.


2.  Để chỉ rõ tỷ lệ , hãy nhấn nút Options. lựa chọn tỷ lệ tối ưu 


3. Vào tên, và kích OK.


-Giới hạn kích thước hình ảnh


Khi cất giữ trong khuôn dạng ECW, kích thước hình ảnh không được vượt hơn 500 Mb. Kích thước này được tính toán bởi công thức : Chiều rộng ( pixcel) x Chiều cao (pixcel) x chiều sâu màu ( những mẩu).


 Cho ví dụ, bạn có thể cất giữ cho một hình ảnh True Color của khuôn dạng A0 với độ phân giải 300 dpi, kích thước của nó là nhỏ hơn 500 Mb. Trong khi với những hình ảnh " Indexed colors ", giới hạn kích thước này thích hợp cho những hình ảnh kích thước nào lớn gấp đôi  khuôn dạng A0 


+ AutoCAD version:


-Phiên bản: Từ hội thoại này bạn có thể chọn phiên bản khuôn dạng DWG hoặc DXF.


-Chuyển đổi vào trong UCS ( Hệ thống Tọa độ của người dùng)


Tham số này được sử dụng khi lưu và Xuất khẩu. Nếu nó được thiết lập, khi cất giữ những đối tượng trong khuôn dạng DWG, những tọa độ và kích thước của những đối tượng chỉ rõ với đơn vị phép đo người dùng ( cho ví dụ Centimet) sẽ được tính toán lại tới một file tương ứng trong DWG. 


+chú giải cho khung mẫu của lệnh

 
Cho phép bạn thêm và soạn thảo những chú giải tới file khung mẫu. 


Để xem những chú giải :


1. Trong Explorer ,nhấn phải trên file và chọn Properties từ thực đơn ngữ cảnh.


2. Từ hội thoại Properties, chọn tab Summary. 


+Chú giải tài liệu 


Làm sao để thêm những chú giải vào file tài liệu?

Trong hội thoại lưu hoặc xuất khẩu, kích vào nút Option ( Bạn đã lựa CWS chọn trong danh sách khuôn dạng). Vào văn bản trong hội thoại, và kích OK. 
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Làm sao để xem những chú giải mà không khởi động chương trình?


 1. Trong Explorer, nhắp phải vào file và chọn Properties từ thực đơn ngữ cảnh.


2. Từ hội thoại, hãy chọn tab Summary. 


Nội dung và số của những tab trong hội thoại Property có thể khác nhau phụ thuộc vào hệ thống 


Làm sao để xem những chú giải tài liệu trong chương trình?


Khởi động Open( thực đơn File) kích vào nút [image: image32.png]


, và chọn Properties từ thực đơn 
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3-Mở/Lưu định file:


*Định dạng file:


WiseImage hỗ trợ định dạng sau:

Đuôi mở rộng
  tên định dạng
Ver.
        khả năng sử dụng    
Software/Company

+HYBRID (VECTOR+RASTER) FORMATS:

CWS

Color WorkSpace
7

Open/Save/Export
WiseImage 7, 10






6

Open/Save/Export
WiseImage 6






5

Open /Save/Export
WiseImage 5

DWF

Design Web Format
4.2, 5.5, 6.0
Export


Autodesk AutoCAD

PDF

Portable Document Format

Import/Export

Adobe Acrobat

+VECTOR FORMATS:

WS

WorkSpace File
5

Open


Spotlight 3.x

VC5

Vector Data File
5

Open


Spotlight 3.x

VC4 

Vector Data File
4

Open


Spotlight 2.x

DWG

AutoCAD Drawing
2004

Open/Save/Export
Autodesk AutoCAD

                        







  2004, 2005, 2006

2000

Open/Save/Export





Autodesk AutoCAD











 2000, 2000i 2002






14

Open/Save

AutodeskAutoCAD14






13

Open/Save

AutodeskAutoCAD13






11

Open/Save

AutodeskAutoCAD11






10

Open/Save

AutodeskAutoCAD10

DXF
Drawing Exchange Format
2004

Open/Save/Export
AutodeskAutoCAD











 2004, 2005, 2006






2000
Open/Save/Export
AutodeskAutoCAD2000, 











2000i 2002






14

Open/Save

AutodeskAutoCAD14






13

Open/Save

AutodeskAutoCAD13






11

Open/Save

AutodeskAutoCAD11






10

Open/Save

AutodeskAutoCAD10

MIF+MID
MapInfo Interchange Format
3.0
Export


MapInfo.

DGN
Microstation Design File


Import


Bentley Eng.

PLT
HPGL/2 Plot File



Import/Export

Hewlett-Packard.

SHP
ESRI shape-file

3

Import/Export

ESRI Inc.

RASTER FORMATS*

TIFF
Tagged Image File Format


Open/Save


TIFF
Georeferenced TIFF



Open/Save


TIFF
Multipage TIFF



Open/Save/Export


BMP
Bitmap





Open/Save


JPG
Join Photographers Expert Group

Open/Save


JPEG
Join Photographers Expert Group

Open/Save


JP2
JPEG 2000




Open/Save


JPK
JPEG 2000




Open/Save


PNG
Portable Network Graphic


Open/Save


PCX
PCX





Open/Save


RLC
Run Length encoded file


Open/Save


CAL
CALS





Open/Save


CIT
Intergraph Raster Type 24


Open/Save


CIT
Multipage CIT




Open/Save/Export


ECW
Enhanced Compressed Wavelet

Open/Save


C4
JEDMICS C4




Open/Save


CT4
JEDMICS CT4



Open/Save


T4
JEDMICS T4




Open/Save


TG4
JEDMICS TG4



Open/Save


SID
LizardTech SID File



Open/Save


CG4
JEDMICS CG4



Open/Save


GP4
JEDMICS GP4



Open/Save


MIL
MIL





Open/Save


 * sử dụng những file World và TAF (mà bạn có thể lưu trữ thông tin trên hình ảnh định vị
+Khác

VBS
Visual Basic Script, Java Script

Execute


JS
Java Script




Execute


TXT 
Text





Import


+Internal WiseImage formats
Đuôi mở rộng
Tên
nơi sử dụng

ghi chú

CLB

Clipbook 
Clipbook 


MRK

End Markers
Create Marker 


SHF

Fill Shapes 
Create Fill Shape 


TPL

Command's template


Xem sử dụng những khung mẫu thích hợp








 với WiseImage cho AutoCAD

OCR

OCR set
Train OCR 
Không tương thích với WiseImage cho AutoCAD

SRT

Symbol Recognition Template Library (SRTL)



CSF

WiseImage Script
Script Studio 
Có khuôn dạng văn bản và có thể được sửa 








đổi với bất kỳ trình biên tập văn bản nào


*Tùy chọn định dạng file raster


Khi lưu trữ raster hình vẽ bạn có thể đặt định dạng những tùy chọn raster và tạo ra một danh sách những khuôn dạng áp dụng trong lệnh Save As của hội thoại Images.

Bạn có thể tạo ra một những khuôn dạng custom dựa vào một file một hiện hữu áp dụng trong:


-lệnh Save As củ) hội thoại Images.,


- lệnh Open,


- lệnh chèn hình ảnh.


Để thiết đặt những tham số khuôn dạng 


1.Nhấn nút Options trong hội thoại của lệnh Save As của mages Manager.

2.Đặt những tham số cần thiết của khuôn dạng được chọn.


Để tạo một danh sách khuôn dạng 


1.Chọn Preferences từ thực đơn Tools.


2.Trong hội thoại Preferences mở ô vuông danh sách của những khuôn dạng file Raster .


3.Lựa chọn checkboxes cho những khuôn dạng mong muốn.


Để tạo ra một khuôn dạng custom dựa vào một một khuôn dạng hiện hữu


1.Lựa chọn một khuôn dạng cơ sở trong hội thoại Preferences, trong mục Raster file formats 


2.Nhấn nút Add. Đặt tên và mô tả cho một khuôn dạng mới. Nhấn nút Options.


3. Thiết đặt những tùy chọn cần thiết  trong hội thoại. Hội thoại là khác nhau phụ thuộc vào khuôn dạng cơ sở mà bạn lựa chọn.


4.Nhấn Ok. Khuôn dạng mà bạn tạo ra sẽ xuất hiện trong danh sách Files of type của lệnh Save của hội thoại Images ảnh và Open.


+Định dạng Tiff


-Tùy chọn định dạng Tiff:


Thiết đặt những tùy chọn cho khuôn dạng Tiff. Theo mặc định một hình ảnh mới được lưu trữ với cấu tạo Tiled 

Làm sao để nhìn những thuộc tính hình ảnh raster trong chương trình?


Nếu bạn làm việc trong Windows 2000 : 
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Khởi động Open ( thực đơn File)  kích vào nút [image: image35.png]


 và chọn Properties từ thực đơn .


Nếu bạn làm việc trong Windows 98 : 


Khởi động Open và kích vào nút [image: image36.png]


.
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Format: 
Thiết đặt thứ tự byte.


Compression: Thiết đặt sự nén : Non-compressed, CCITT Group 3, CCITT Group 4.


Organization: 


-Native-  Không thay đổi tổ chức nào.


-Striped- Những tập hợp t​ớc bỏ tổ chức. 

-Tiled- thiết đặt cấu trúc lợp ngói.


Save Thumbnail Image: lưu thumbnail của hình ảnh để xem trước.


Để trình bày hội thoại này : Từ hội thoại Save hãy chọn Options.


GeoTiff

Đây là khuôn dạng TIFF ,có thể cất giữ thông tin bổ sung về những tọa độ, geo, snap và phép chiếu. Khi mở hoặc chèn file như vậy, dữ liệu này được đọc và raster được đặt  trong tài liệu phù hợp tới dữ liệu này. Nếu vị trí đã đ​ợc thay đổi, dữ liệu lưu  vị trí được ghi đè lên. Khuôn dạng GeoTIFF được hỗ trợ bởi đa số các chương trình map


Làm sao để lưu trữ thông tin vị trí hình ảnh raster?


Một vài ứng dụng biên tập hình ảnh, như​ WiseImage, bạn chỉ rõ thông tin về vị trí hình ảnh và cất giữ thông tin này trong file hình ảnh raster ( khuôn dạng Geo Tiff) hoặc trong file có liên hệ ( world file). 

Làm sao để lưu trữ raster trong khuôn dạng Geo Tiff ?


1. Từ hội thoại Save, chọn khuôn dạng Geo TIFF.


2. Vào tên và kích OK.


Làm sao để nhìn những thuộc tính trong file ?


Khi làm việc trong Windows 2000 : Khởi động Open ( thực đơn File) và kích vào nút [image: image38.png]


; chọn Properties từ thực đơn  .


Khi  làm việc trong Windows 98 : Khởi động open( thực đơn File) và kích vào nút [image: image39.png]


.


+Tiff Multipage:


-Chèn trang từ Multipage tiff:


Sử dụng lệnh chèn hình ảnh bạn có thể chèn một hoặc vài trang từ Multipage TIFF đến tài liệu hiện thời.


 Một bộ phận từ những trang riêng biệt chèn đến tài liệu, WiseImage có thể làm việc với file raster nhiều trang giống như làm việc với tài liệuữtem phần kiểu tài liệu nhiều trang). 
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Làm sao để chèn một trang từ multipage TIFF đến tài liệu?


1. Khởi động lệnh Insert Image.


2. Trong hội thoại,  chọn file Multipage TIFF cần thiết.


3. kích vào số trang , nhìn những hình ảnh trong cửa 

sổ xem trước và bật checkboxes cho cái mong muốn, và kích OK.


4. Bạn được nhắc để chỉ rõ vị trí của những trang được chèn vào trong tài liệu.


Sử dụng bảng những thuộc tính bạn có thể nhìn thông tin bổ sung trên về độ phân giải, kích thước hình ảnh , kiểu nén , kiểu màu và những nội dung khác.
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Làm sao để lưu một sửa đổi?


Để cất giữ những sự thay đổi làm những trang tới cùng 

file đó, Sử dụng lệnh Lưu trữ raster (hội thoại Image Manager).

  Nếu bạn muốn cất giữ tất cả những sự thay đổi một lần, hãy sử 

dụng lệnh lưu tài liệu 


Trong quản lý hình ảnh trang của Multipage TIFF, trông

 như sau: RasterFileName Page#..

Bạn có thể quản lý thứ tự trang sử dụng những nút với những 

mũi tên [image: image40.png]Py





- Kiểu tài liệu nhiều trang:


Bạn sử dụng kiểu tài liệu nhiều trang để làm việc với file raster nhiều trang như tài liệu.  Nếu một raster mới được tạo ra, thì thêm một trang mới ;  nếu một raster bị xóa, thì trang tương ứng bị xóa.


Dữ liệu Vectơ được thêm khi làm việc trong kiểu này sẽ mất nếu tài liệu đóng.


Để tự động chuyển tới kiểu này bạn cần phải bật tùy chọn Enter Multipage Mode Automatically trong hội thoại Preferences khi sự mở Multipage-TIFF. 


Để bật Multipage document mode bằng tay sử dụng nút[image: image41.png]


 trên thanh công cụ Multipage 


Bạn có thể sử dụng nút Next/Previous trên thanh công cụ Multipage để chuyển qua lại giữa các trang.

 
- Làm việc với nhiều trang TIFF:


WiseImage có thể mở và cất giữ những hình ảnh trong khuôn dạng TIFF-Multipage. Khuôn dạng này là một định dạng lưu hình ảnh mà cho phép bạn giữ vài hình ảnh ( những trang) đơn trong Tiff- file. file Nhiều trang tạo ra với WiseImage là bảng trao đổi với những chương trình khác mà hỗ trợ đọc và cất giữ khuôn dạng này.


+Định dạng ECW


Khuôn dạng ECW (Enhanced Compressed Wavelet) được dùng để cất giữ dữ liệu raster màu (True Color, grayscale, indexed colors) dựa vào công nghệ wavelet  cho phép đạt được tỷ lệ nén cao. Công nghệ này có hiệu quả để giảm bớt số lượng dữ liệu.


Khuôn dạng ECW được sử dụng để cất giữ số lượng lớn thông tin đang tồn tại trong ảnh vệ tinh và ảnh hành không 


- Saving geo-data :


Khi cất giữ một hình ảnh, chương trình ghi vị trí của góc trên trái và tỷ lệ của nó. Khi mở hoặc chèn hình ảnh, thông tin này được sử dụng để định vị hình ảnh trong tài liệu. Ngoài bản thân hình ảnh, chương trình còn lưu giữ thumbnail, 


-Giới hạn kích thước hình ảnh:


Khi làm việc trong WiseImage, có một giới hạn kích thước nhất định cho những hình ảnh sẽ được cất giữ trong  khuôn dạng ECW : những hình ảnh không bị nén không được vượt hơn 500 Mb. Giới hạn này không có gì với kích thước file vật lý trên đĩa; nó được tính toán như sau : chiều rộng ảnh ( pixcels) x chiều cao ảnh pixcels) x số bits. 


Số bits của hình ảnh grayscale và chỉ số hóa thì bằng 1, với những hình ảnh màu là = 3.


Chiều rộng và chiều cao của một hình ảnh raster được trình bày trong Inspector ( Kích thước pixcels).


Kích thước của một hình ảnh để mở thì không giới hạn.


- Những thuộc tính hình ảnh trong định dạng ECW


Những thuộc tính hình ảnh raster được trình bày trong hội thoại Open với tùy chọn option được chọn.

Size on disk

Kích thước file Vật lý

Projection

Phép chiếu ( chưa được sử dụng trong việc mở)

World Origin X
Tọa độ X của góc trên trái hình ảnh 

World Origin Y
Tọa độ Y của góc trên trái

Datum


Chưa được sử dụng

Type


Kiểu Dữ liệu : Grayscale (1 bite) hoặc True Color ( những 3 bite)

Bands


Số băng sử dụng

Compression

bày ra tỷ lệ nén

World Scale X

 tỷ lệ Hình ảnh

World Scale Y

 tỷ lệ Hình ảnh 

Cell Units

đơn vị

Size
 

Kích thước hình ảnh 


+ Kích thước trên đĩa:



Khuôn dạng ECW cho phép bạn nénnhững hình ảnh với những tỷ lệ cao mà không có bất kỳ sự mất mát chất lượng. Những hình ảnh true color (24 bites), ảnh hành không có thể được nén từ 20 : 1 và 50 : 1 so với kích thước hình ảnh không bị nén. 


Bảng sau cung cấp sự nén tiêu biểu nào sẽ được sử dụng cho những kiểu hình ảnh khác nhau phụ thuộc mục đích :

Kiểu dữ liệu

Mục đích




mức nén

ảnh hàng không màu

Để in những bản đồ chất lượng tốt


25 : 1

ảnh hàng không màu

Phân phối qua Internet hoặc e-mail


40 : 1

ảnh hàng không Grayscale
Để in những bản đồ chất lượng tốt

 từ 10 : 1 đến 15 : 1

ảnh hàng không Grayscale
Phân phối qua Internet hoặc e-mail

 từ 15 : 1 đến 30 : 1


Khi cất giữ dữ liệu trong  khuôn dạng ECW, có hai phương pháp để sử dụng : Lossless (Tiêu hao) và Lossy. (Không tiêu hao).


- Lossless


Phương pháp này cho phép bạn tái tạo chính xác hình ảnh bị bị nén tới một hình ảnh nguyên bản. Lợi thế chính là không có những sự mất mát chất lượng hình ảnh sau khi nén . Sự bất lợi là nén không tổn hao có giới hạn nói chung là 2 : 1 hoặc 3 : 1, nghĩa là hình ảnh có thể được nén 2 - 3 lần.


- Lossy


Phương pháp này cho những tỷ lệ nén cao tuy nhiên dữ liệu (là chất lượng) sẽ bị mất. Sử dụng phương pháp này có thể nén những hình ảnh từ 20 : 1 đến 50 : 1. Để nén những những hình ảnh color images (24 bits) bạn có thể áp dụng những tỷ lệ 10 : 1 tới 20 : 1, với grayscale và indexed  lên tới 50 : 1.


Làm sao để lựa chọn sự nén tối ưu


Trong trường hợp nén những hình ảnh đơn dự định sẽ được nén tiếp( bạn muốn hòa trộn chúng vào trong một hình ảnh lớn) khuyến cáo rằng bạn sử dụng phương pháp nén nhiều lần. Cho ví dụ, nếu bạn định cất giữ hình ảnh đầy đủ với tỷ lệ 20 : 1 bạn, cần phải áp dụng tỷ lệ 10 : 1 hoặc 5 : 1 để nén nhiều lần.


+Định dạng JPEG


Khuôn dạng JPEG cho phép chỉ rõ mức nén hình ảnh; nhưng kết quả thao tác này có thể có sự mất mát thông tin không thể phục hồi. Để giảm bớt hiệu ứng trực quan của sự mất mát thông tin bạn có thể áp dụng mức nén không thấp hơn 80 %; việc cất giữ một hình ảnh trong khuôn dạng này cho phép bạn giảm bớt đáng kể kích thước file.


Khuôn dạng này cũng cho phép nén một hình ảnh không với sự mất mát thông tin nào.

Chú ý rằng mỗi thời gian lưu trong định dạng JPEG hình ảnh được lưu lại với thông tin mới được xem xét; những phương tiện này, chất lượng hình ảnh là thấp với mỗi thao tác lưu. 

[image: image42.png]JPEG Options.

Image Qualty






Chất lượng Hình ảnh:


Low -chất lượng Thấp, mức nén cao.


High -chất lượng cao , mức nén thấp.
iii-Nhập khẩu, xuất khẩu:

1- Nhập khẩu:


Lệnh này nhập khẩu dữ liệu từ những tài liệu trong những khuôn dạng chương trình khác. Trong quá trình nhập khẩu, một số dữ liệu có thể được thay đổi hoặc mất, một số kiểu đối tượng có thể được lờ đi.


Một danh sách những khuôn dạng sẵn có được định nghĩa bởi phiên bản chương trình và những sự thiết đặt cho phiên bản WiseImage . Để thêm khuôn dạng ngoài thư viện sử dụng tùy chọn External Filters của Preferences.


Danh sách những khuôn dạng có sẵn luôn luôn chứa đựng DGN  của chương trình Microstation 


Làm sao để nhập khẩu file?


1. Khởi động lệnh và chỉ rõ một file để nhập khẩu: Từ thực đơn File, chọn Import. hoặc kích nút [image: image43.png]


 trên thanh công cụ Miscellaneous (Hỗn hợp.)


2. Những đối tượng không tồn tại trong WiseImage ( như Splines, polygon) sẽ bị làm gãy xấp xỉ tới những đối tượng hiện hữu. Khi thử nhập khẩu những đối tượng không được hỗ trợ, thông báo xuất hiện : " bản vẽ chứa đựng những thực thể mà không thể được tải ".


Khi lưu trữ dữ liệu nhập khẩu bạn được nhắc sử dụng khuôn dạng CWS.

2- Nhập khẩu định dạng file DGN:


Nhập khẩu được thực hiện với lệnh Import.

Trong quá trình nhập khẩu, một số kiểu đối tượng được lờ đi; những cái thì khác bị gãy thành những đối tượng đơn. Bảng sau cung cấp những đối tượng của khuôn dạng DGN và những đối tượng t​ơng ứng sau khi nhập khẩu trong WiseImage.

DGN
WiseImage

Line 
->LineShape
->IgnoredPolyline ->PolylineCurve
->PolylineArc
->Arc Circle 
->CircleEllipse -> EllipseText 
->Text

3- Nhập khẩu shap file

Bạn có thể nhập khẩu dữ liệu từ những file khuôn dạng shap phiên bản 3 cho một tài liệu WiseImage sử dụng lệnh import.


Bạn có thể nhập khẩu một file đơn cũng như những tài liệu phức tạp gồm những tập hợp file. Những đối tượng tạo ra có thể được đặt lên những lớp vào hai cách : 


1. Những đối tượng của một kiểu nhất định được đặt lên một lớp riêng biệt.


2. Những đối tượng được đặt lên lớp với tên file. 


Những tùy chọn :


-Objects and Layer name:


Tham số này chỉ rõ tên lớp chứa những đối tượng nhập khẩu. Tất cả kiểu đối tượng chứa đựng trong khuôn dạng shap được chia tách thành ba phạm loại : piont, Polyline, Polygon.


- Import folder


Nhập khẩu tất cả các file .SHP  từ thư mục.


- Create layer with filename

 Nếu checkbox này chọn, thì chương trình tạo ra một lớp với tên file từ đó dữ liệu được xuất khẩu. Những đối tượng được đặt lên lớp này. 


Làm sao để nhập khẩu những đối tượng?


1. Chạy lệnh Import


2. Lựa chọn ESRI Shape file từ combo box


3.  Để làm những sự thiết đặt , nhấn nút Options. Chương trình giữ những sự thiết đặt đã làm.  Để  nút Options là hoạt động, bạn cần phải lựa chọn bất kỳ hình dạng file nào.  Nếu bạn muốn nhập khẩu một tập hợp của những shape-files chỉ một lần, thì bạn cần lựa chọn Import folder checkbox. 


4. Kích OK.


Sự tương ứng đối tượng


Point

Point


Polyline
Polyline


Polygon
Polyline


Multipatch
lờ qua (không biết)

4-Xuất khẩu:


Xuất khẩu tất cả hoặc lựa chọn dữ liệu tới những khuôn dạng của những chương trình khác ( chủ yếu là những khuôn dạng dự định để cất giữ dữ liệu vectơ). Khi xuất khẩu ( Hoặc nhập khẩu) vài đối tượng có thể được lờ đi  ( Nhập khẩu những đối tượng raster tới Mapinfo) hoặc làm vỡ thành đối tượng phần tử của chúng. Cho ví dụ, khi xuất khẩu tới khuôn dạng MID ( Mapifo), những đối tượng raster chứa đựng trong tài liệu được lờ đi.

 
Xuất khẩu trong định dạng CWS thay vì sử dụng lệnh Save as sẽ tiện lợi hơn, trong trường hợp nếu bạn cần lưu một bản sao của một tài liệu đang mở cho một file riêng biệt ( hoặc một phần sử dụng duy nhất tùy chọn Chọn lọc) và tiếo tục làm việc với tài liệu nguyên bản.

[image: image564.png]



Để chọn một khuôn dạng phiên bản xuất khẩu:


1. Trong hội thoại Export, kích Options. 


2. Chọn phiên bản đòi hỏi và kích OK.


Để xuất khẩu những đối tượng được chọn:


1. Lựa chọn những đối tượng để xuất khẩu.


2. Đặt checkbox Selection Only. Nếu không 

có đối tượng nào được lựa chọn khi khởi động lệnh,

 tùy chọn của xuất khẩu đối tượng khôángử dụng được.


3. Khởi động Export từ thực đơn hoặc thanh công cụ.


4. Vào tên file và kích OK.


Khuôn dạng xuất khẩu



đối tượng xuất khẩu 

WiseImage (5.x – 7.x) (CWS)


Đối tượng raster và vector


AutoCAD (DWG, DXF, DWF) 


version R14 (AutoCAD LT 97) và cao hơn

Image


Adobe (PDF)





Raster image


Multipage TIFĐ



Multipage CIT



AutoCAD (DWG, DXF) of version R13 




(AutoCAD LT95) và thấp hơn


đối tượng vector


MapInfo (MID) 


HPGL/2 (PLT, HP, HPG)


ESRI (SHP) 



Thông tin chi tiết được cung cấp trong mục những khuôn dạng File. 

Khởi động lệnh: Từ thực đơn File, chọn Export. hoặc kích [image: image44.png]


 trên thanh công cụ Miscellaneous.
5-Tuỳ chọn xuất khẩu Mapinfor:


Khi xuất khẩu những đối tượng bạn có thể lựa chọn những thuộc tính để xuất khẩu :


1. Khởi động lệnh  Export, chọn Mapinfo file (MID) từ danh sách khuôn dạng và kích Options.


 2. Sử dụng hội thoại để lựa chọn hệ thống tọa độ và thuộc tính mong muốn. Kích OK.


3. Vào tên file trong hội thoại Xuất khẩu và kích OK để xuất khẩu.


Hai file có đuôi mở rộng MIF và MID được tạo ra. Khi Xuất khẩu vài đối tượng bị gãy thành phần tử (xem bảng ở dưới). Khi được xuất khẩu, những hình ảnh raster chứa đựng trong tài liệu WiseImage được lờ đi.


Ghi chú : Để xuất khẩu những thuộc tính đối tượng mà không phải là cho WiseImage, nhưng cho Mapinfo, làm những bước sau :


1. Thêm những thuộc tính custom tới những đối tượng, thuộc tính mà đồng nhất vào những thuộc tính đối tượng Mapinfo


2. Bật checkbox Custom data trong hội thoại Mapinfo Export Options

Bảng quan hệ giữa WiseImage và  đối tượng Mapinfo.


WiseImage objects


Mapinfo objects

Line 




Line


Point 



 
Point


Arc 




Arc


Circle 




Circle


Polyline 



Polyline


Rectangle 



Frame/Region


Text 




Text


Multiline text


 
Text


Raster image



Ignored (lờ qua)

6-Xuất khẩu tới khuôn dạng shape-file:


Để cất giữ dữ liệu trong khuôn dạng Shap, bạn cần phải sử dụng lệnh Xuất khẩu. Những tham số sau điều khiển xuất khẩu dữ liệu:


Những tùy chọn :


-File Fix


ở đây bạn có thể chỉ rõ những hậu tố cho tên của những file mà bạn muốn xuất khẩu dữ liệu. Tên đầy đủ được hình thành như sau : tên File + hậu tố. Nếu bạn đã nhập DATA trong hội thoại Save file và hậu tố POINTS  cho một file chứa đựng những điểm, khi đó tê file  DATA_POINTS sẽ được tạo ra như một kết quả xuất khẩu.


- Layer Name, Elevation, Extended data, Custom data


Nếu bạn muốn xuất khẩu những thuộc tính đối tượng, bạn cần phải lựa chọn các checkboxes.


Để xuất khẩu tới khuôn dạng Shap: 


1. Chạy lệnh Xuất khẩu.


2. Lựa chọn khuôn dạng ESRI Shape file.


3. Để thiết lập xuất khẩu, nhấn nút Options. 

Nếu bạn muốn xuất khẩu những thuộc tính, bạn cần lựa chọn checkboxes thích hợp (Layer Name, Elevation, Extended data, Custom data). Những sự thiết đặt xuất khẩu cần phải được cất giữ giữa những phiên làm việc.


Sự tương ứng đối tượng

WiseImage

ESRI shape-file


Point
->

Points


Line
->

Polylines


Rectangle->
Polylines and Polygons


Arc
->

Polylines


Circle
->

Polygons


Ellipse
->
Polygons


Polyline ->
Polylines and Polygons (if closed)


Spline
->
Polylines


Text ->
Ignored


Multi-string text ->
Ignored


Hatch
->
Ignored


Khi được xuất khẩu, những đối tượng phức tạp như đường Dim và khối thì được bung ra thành những đối tượng đơn giản.

iv-Thao tác với Raster


Với WiseImage bạn có thể mở hoặc chèn những hình ảnh raster và kết hợp chúng với những đối tượng vectơ. Sự chọn lọc đối tượng raster trong WiseImage làm cho raster biên tập dễ như với vectơ. Sử dụng WiseImage, biến đổi những line raster vào trong những đối tượng vectơ thì đơn giản. Pick một đối tượng raster trên WiseImage, khi đó chương trình tự động đoán nhận hình dạng của nó và tạo ra vectơ. Bạn có thể chọn và xóa raster nguyên bản. Xóa một line raster nguyên bản, cung, hoặc vòng tròn không để lại những sự gãy và những chỗ trống trong những vị trí cắt ngang những đường raster. Một hình ảnh raster được chèn vào trong bản vẽ được thu xếp như sự tham khảo ngoài ( liên kết hình ảnh) hoặc như một tài liệu bộ phận của WiseImage ( hình ảnh nhúng). Khi chèn hình ảnh từ file hiện hữu, WiseImage chèn vào hình ảnh raster được tạo ra một đường dẫn tới file hình ảnh, tỷ lệ, góc quay, điểm chèn vào, và những thuộc tính khác. Bạn có thể sửa đổi hoặc xóa sự tham khảo tới hình ảnh raster vào bất kỳ thời gian nào. Bạn có thể cất giữ những hình ảnh Raster bên trong một tài liệu WiseImage như tài liệu nhúng ( chú ý rằng nó tăng thêm kích thước của file tài liệu WiseImage). Những hình ảnh Raster có thể được quay, thu phóng, sao chép, di chuyển, và pick. WiseImage hỗ trợ những gần như tất cả định dạng file hình ảnh chuẩn, sử dụng trong đồ họa máy tính, quản lý tài liệu, Map và những hệ thống thông tin địa lý ( GIS). Những hình ảnh có thể là bitonal ( đơn sắc), grayscale 8 bít, màu 8 bít, hoặc 24 bít . Trong trường hợp những hình ảnh bitonal, những điểm nền được đối xử như một dạng trong suốt. Mỗi hình ảnh được chèn vào trong một tài liệu WiseImage sẽ có viền của nó. Bạn có thể lựa chọn một hình ảnh bởi việc chỉ rõ một điểm trên viền này ;  Nếu bạn chỉ rõ một điểm nằm trong một hình ảnh, hình ảnh sẽ không được lựa chọn. Bạn có thể cũng lựa chọn những hình ảnh sử dụng hội thoại lựa chọn hình ảnh.  Bạn có thể thay đổi ranh giới một hình ảnh và của đặc tính nó có, bao gồm : - Lớp, màu ranh giới; tính rõ ràng trên màn ảnh; tỷ lệ, góc quay, chiều rộng, và chiều cao; sự trong suốt;- Tình trạng chỉ đọc.


 Trong WiseImage, Kích thước hình ảnh raster giới hạn tới 10,000,000 điểm theo trục thẳng đứng và 65,000 điểm nằm ngang. 10 triệu điểm đại diện một hình ảnh quét  xấp xỉ 250 mét dài. Bạn có thể chèn nhiều hình ảnh raster trong tài liệu.  Bất kỳ hình ảnh hiện hữu nào có thể được tải từ file của nó, và sau đó đặt trong không gian làm việc ở vị trí đ​ợc chọn. Những hình ảnh có thể được soạn thảo, cất giữ, và đóng. Bạn có thể cũng tạo ra những hình ảnh raster mới trong WiseImage. Để mở raster image, từ thực đơn File chọn Open lựa chọn hình ảnh trong danh sách. WiseImage sẽ mở một tài liệu mới chứa đựng duy nhất một hình ảnh. Hình ảnh đã nạp sẽ được chèn ở điểm 0,0 với tỷ lệ 1 và góc quay 0. Bạn có thể thay đổi hình ảnh và cất giữ nó. WiseImage cất giữ những hình ảnh trong khuôn dạng của nó theo mặc định.  Nếu trong thời gian làm việc bạn thêm vài đối tượng khác trong tài liệu, thì WiseImage không thể cất giữ tất cả nội dung tài liệu trong file hình ảnh. Trong trường hợp này bạn cần phải hoặc cất giữ một hình ảnh bỏ dữ liệu nào đó, hoặc cất giữ tài liệu trong File .CWS. 


Để chèn một hình ảnh vào trong một WiseImage hiện thời,chọn mage từ thực đơn chèn.  Sau khi lựa chọn một hình ảnh trong hội thoại, bạn cần đặt nó trong không gian làm việc tài liệu. Khi chèn bạn có thể chỉ rõ một điểm, tỷ lệ hoặc góc quay trong cửa sổ Inspector. 

Để tạo ra một hình ảnh raster mới


1. Chọn New Image từ thực đơn Insert
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2. Vào kích thước hình ảnh trong Width và Height hoặc từ danh sách Standard Paper Sizes,. Danh sách này chỉ chứa đựng những khuôn dạng giấy chuẩn có trong danh sách Paper Formats của hộp thoại Options. Bạn có thể thêm hoặc giảm bớt danh sách này.


3. Lựa chọn một sự định hướng cho khuôn dạng giấy trong Orientation

4. Lựa chọn độ phân giải trong DPI, và đơn vị sử dụng trong Units.


5. Kích OK.


Chỉ rõ một điểm chèn vào, tỷ lệ hoặc góc quay.


 Bạn có thể cũng chèn hình ảnh mới từ scanner.
1-Thay đổi những thuộc tính hình ảnh:


Bạn có thể thay đổi những thuộc tính hình ảnh với cửa sổ Inspector và trong hội thoại Images.

2-Quản lý những hình ảnh :


Hội thoại Images liệt kê những tên của tất cả những hình ảnh raster tải vào trong tài liệu WiseImage.


Để mở hội thoại Images Chọn Images từ thực đơn Tools hoặc kích nút [image: image46.png]


 trên thanh công cụ Properties.
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Để thay đổi những thuộc tính của một hình ảnh, lựa chọn nó từ danh sách.


Name: Trong hộp này, bạn có thể nhập tên một hình ảnh.


File Name: hiển thị tên file ảnh được chọn. 


Những thuộc tính Read-Only và Visible :điều khiển khả năng thay đổi những hình ảnh. Chúng được đại diện bỡi [image: image48.png]


 và [image: image49.png]


 và hai checkboxes trong Details (chi tiết) của hội thoại. Bạn có thể cũng đặt giá trị  TRUE  và FALSE cho​ những thuộc tính này danh sách chi tiết  hoặc trong cửa sổ Inspector. Tính Rõ ràng những hình ảnh cũng được bật/tắt với lệnh Show/Hide Rasters. 


References


Hình ảnh được tạo ra hoặc mở một lần và có thể được chèn vào ( Và hiển thị) trong nhiều lúc. Sự Tham khảo cho thấy số thời gian hình ảnh có hiển thị trong tài liệu. Cho ví dụ, trong trường hợp này bạn có thể lựa chọn, sao chép, và pan hình ảnh, trường Reference sẽ chứa đựng 2.

Nếu hình ảnh  không được chèn vào bất cứ nơi đâu trong tài liệu, thì sự Tham khảo sẽ chứa đựng 0. có nghĩa rằng dữ liệu hình ảnh vẫn còn tồn tại trong tài liệu và sẵn sàng sẽ được cho thấy lần nữa;


để xóa nó, bạn phải nhấn nút [image: image50.png]


.


Color :Trình bày màu của một hình ảnh ( cho những hình ảnh đơn sắc). Bạn có thể chọn một màu để phân biệt những hình ảnh. tùy chọn By layer gán một màu cho tất cả các hình ảnh trên lớp; By block gán màu của khối cho một hình ảnh mà là bộ phận của khối.


Layer: Bạn có thể quan sát những thuộc tính của một lớp mà có một hình ảnh thuộc về nó và di chuyển hình ảnh từ lớp này sang lớp khác.


Details: Nút này mở danh sách đầy đủ của những tùy chọn hình ảnh. 


Preview :là cửa sổ xem trước cho thấy toàn bộ hình ảnh và những chi tiết. 


Các nút:

 
[image: image51.png]



Tạo ra một hình ảnh mới.

 
[image: image52.png]



Xóa một hình ảnh từ tài liệu.

 
[image: image53.png]



lưu một hình ảnh.

 
[image: image54.png]



 Lưu một hình ảnh cho một file mới.

 
[image: image55.png]



 Làm cho hình ảnh được chọn là nhúng. Hình ảnh chưa đ​ợc liên kết tới file và tồn tại chỉ trong tài liệu. 


Up
di chuyển hình ảnh hoặc trang của multipage TIFF lựa chọn lên trên. 


Down
di chuyển hình ảnh hoặc trang của multipage TIFF lựa chọn xuống dưới. 


Nhúng thay vì liên kết images: trong WiseImage bạn có thể mở một hình ảnh từ một file, xử lý và cất giữ nó. Trong khi bạn làm việc, WiseImage nhớ tên của file từ đó dữ liệu hình ảnh được lấy và bạn có thể cất giữ thay đổi bất kỳ thời gian nào bởi việc nhấn nút Lưu trữ trong hội thoại Image. Bạn có thể cũng xử lý những hình ảnh nhúng. Đó là những hình ảnh mà cư trú trong những tài liệu WiseImage. Những hình ảnh nhúng có thể được liên kết. 


Để làm cho hình ảnh là nhúng, Lựa chọn một hình ảnh trong hội thoại Image ảnh và nhấn nút [image: image56.png]


  Từ <Embedded> xuất hiện trong cột Tên File. Bạn có thể tạo ra những hình ảnh Nhúng áp dụng những lệnh WiseImage New Image 


Để làm liên kết hình ảnh nhúng :


1. Lựa chọn một hình ảnh và nhấn [image: image57.png]


.


2. Lựa chọn một tên file và một khuôn dạng hình ảnh trong hội thoại Save As.


3. Nhấn OK.

3-Kiểu xem trước ( Mờ đục, nửa trong suốt, Trong suốt):


Sử dụng những tùy chọn này bạn có thể chọn kiểu trình bày của  những hình ảnh đơn sắc trong cửa sổ xem trước.  những kiểu này ảnh hưởng những lệnh làm việc với hình ảnh màu và kết quả của chúng trong hình ảnh đơn sắc. 


Các kiểu xem trước:


-Mờ đục(Opaque ) :  hiển thị hình ảnh đơn sắc trên nền trắng; một hình ảnh màu nguyên bản được ẩn đi.


-Nửa trong suốt(Semitransparent): làm mờ một ảnh màu màu nguyên bản và hiển thị  hình ảnh đơn sắc trên ảnh  màu.


-Trong suốt (ransparent): hình ảnh trong suốt không có bóng mờ


Kiểu Mặc định
: Mô tả những tùy chọn được sửa đổi trong hộp thoại  Preferences .

4-Làm việc với Clipboord


+Copy: menu Edit > Copy.


+Paste:


dữ liệu chèn từ Clipboard vào trong tài liệu. lệnh này sử dụng cho dữ liệu  bên trong chương trình và cũng với dữ liệu di chuyển giữa những ứng dụng. Để đặt dữ liệu của WiseImage trong Clipboard sử dụngnhững lệnh  Cut, Copy.


Những tùy chọn :


Phụ thuộc vào dữ liệu tới Clipboard bạn thu được những đối t​ưng sau khi paste


Trường hợp thứ nhất : Đặt một vùng raster được chọn trong Clipboard. Khi chép một vùng raster được chọn và dán nó tới cùng tài liệu đó, vùng này thuộc về raster của nó và được hòa trộn khi hủy bỏ lựa chọn. Tuy nhiên khi dán tới tài liệu khác, raster chọn lọc được dán như một raster nhúng riêng biệt. Bạn có thể dán dữ liệu raster như một hình ảnh riêng biệt tới cùng tài liệu đó Chúng được sao chép từ việc sử dụng lệnh Paste riêng biệt.


Trường hợp thứ hai: đặt đối tượng vectơ trong clipboord


Những đối tượng Vectơ được đặt trong nội bộ clipboord của WiseImage ong; do vậy chúng không phải là sẵn sàng để dán tới những chương trình khác.


Chú ý rằng khi chèn dữ liệu raster cùng với dữ liệu vectơ tới những ứng dụng khác, dữ liệu vectơ bị bỏ sót.


Trường hợp thứ ba : Đặt toàn bộ hình ảnh raster trong clipboord. Toàn bộ hình ảnh raster ( được lựa chọn như những đối tượng vectơ) sẽ được dán tới tài liệu như những hình ảnh raster riêng biệt.


Trường hợp thứ tư​ : đặt đối tượng raster lai trong clipboord. Nếu được sao chép và sau đó dán từ cùng tài liệu đó, những đối tượng lai được dán như đối tượng lai , tuy nhiên nếu được dán tới tài liệu khác, thì chúng được dán như những đối tượng vectơ.


Để khởi động lệnh :  Từ Edit menu, chọn Paste. hoặc nhấn phải trong cửa sổ chương trình và chọn Paste từ thực đơn ngữ cảnh.


+Paste special:


Chèn dữ liệu raster từ Clipboard trong một hình ảnh xác định.


Để khởi động lệnh :  Từ Edit menu, chọn Past special. hoặc nhấn phải trong cửa sổ  và chọn Past special. từ thực đơn ngữ cảnh.


+Paste separate: 


Chèn raster chọn lọc từ Clipboard như một hình ảnh riêng biệt.

Để khởi động lệnh : Từ Edit menu, chọn Paste Separate. hoặc nhấn phải trong cửa sổ chương trình và chọn Paste Separate từ thực đơn ngữ cảnh.

5-Làm việc với text


+Text: Thêm text tới tài liệu: Draw  menu >Text. hoặc kích nút [image: image58.png]


 trên trên thanh công cụ chính.


+Multiline text: 


1. Khởi động lệnh: Draw menu> Multiline Text.

2. Vào văn bản bằng tay bên trong hội thoại hoặc chèn nó từ file trên đĩa. Để chèn, sử dụng nút  [image: image59.png]


 và chỉ rõ file mà chứa đựng văn bản. File phải trong khuôn dạng văn bản.


3. Chọn kiểu phông và kích thước .

4. Chỉ rõ một điểm cơ sở cho văn bản . Chú ý khi tạo ra văn bản kiểu RDRAW , cũng như trong trường hợp việc vẽ mọi đối tượng khác, nó là những thực thể vectơ. 



+Biên tập Multiline text :


để biên tập văn bản bạn sử dụng cùng hội thoại đó như trong trường hợp tạo thành văn bản.


1. Khởi động Inspector.

2. Chọn đối tượng văn bản và kích nút trong thuộc tính text. [image: image60.png]




+Sử dụng những  phông SHX.


Không kể kiểu phông True type [image: image61.png]


, WiseImage hỗ trợ những phông SHX [image: image62.png]


. Những   phông SHX phát triển bởi công ty AutoDesk; 


Trong WiseImage bạn có thể mở những những bản vẽ AutoCAD, chứa đựng kiểu phông  SHX  (  Nếu một phông đòi hỏi không tìm thấy, nó sẽ được thay thế); bạn có thể sử dụng những phông SHX  khi  làm việc với những khuôn dạng bản vẽ AutoCAD và những tài liệu Wiseimage.


Không giống  những phông True type , được đăng ký trong MS Windows và sẵn sàng cho tất cả các chương trình kể cả WiseImage, để sử dụng những  phông SHX bạn cần chỉ rõ đường dẫn tới thư mục phông đó . Đường dẫn này được chỉ rõ trong Folders section  của hội thoại những ​Preferences 

Tìm kiếm những phông SHX có hiệu lực chỉ được thực hiện khi khởi động chương trình; như vậy nếu bạn đã thay đổi đường dẫn tới những phông SHX hoặc đặt những phông mới trong thư mục, thì bạn cần khởi động lại chương trình để làm cho chúng là có hiệu lực


Nếu bạn cài đặt một trong những phiên bản AutoCAD, thì bạn có thể sử dụng  tập hợp của những phông SHX của AutoCAD . 


Thiết đặt phông:


Khi chuyển những tài liệu tạo ra trong AutoCAD tới máy tính khác, ngoài những file DWG / DXF , bạn cũng cần chuyển những file phông SHX sử dụng.


Nếu trong việc vẽ sử dụng phông SHX mà chưa đ​ợc tìm thấy, thì WiseImage sẽ sử dụng một trong số những phông SHX định vị trong thư mục với phông SHX định nghĩa trong  Preferences. Nếu không có phông SHX trong thư mục, thì những văn bản sẽ được trình bày như những hình chữ nhật rỗng.


Làm sao để thay đổi kiểu phông?


Bạn có thể lựa chọn một phông ( True type hoặc SHX) khi tạo ra một văn bản hoặc sử dụng thuộc tính Font  của đối tượng văn bản .


Để lựa chọn một kiểu, kích vào trường giá trị Text font, hai nút [image: image63.png]


 sẽ xuất hiện.


Nếu một đường dẫn tới phông chư​a được chỉ rõ hoặc không có những file của phông SHX  tìm thấy bởi một đường dẫn xác định, nút để lựa chọn  phông SHX sẽ không xuất hiện.


Nhấn nút yêu cầu ( SHX hoặc True type ) hội thoại chọn lọc phông sẽ xuất hiện. Khi  lựa chọn một  phông SHX, Bạn Có thể xem trước nó. Chỉ những phông định vị trong thư mục với những phông SHX  được sử dụng  trong WiseImage, sẵn sàng cho sự chọn lọc.


+biên tập text raster:


lệnh này sử dụng để nhập một văn bản trong hình ảnh raster và tự động làm sạch một vùng cho văn bản. 


Bạn có thể soạn thảo những văn bản trong hình ảnh của tất cả các kiểu màu ( black-white, 8-bit, grayscale, 24-bit).  Nó tiện lợi để thiết đặt màu văn bản cho hình ảnh màu. 


Sự khác nhau là  lệnh này thực hiện vùng nhập tự động làm sạch.  Nếu bạn muốn nhập một văn bản trong hình ảnh raster mà không làm sạch vùng này, hãy sử dụng lệnh text với kiểu RDRAW ở  trên 


Để nhập một văn bản trực tiếp trên hình ảnh raster, bật kiểu RDRAW với nút ở tại đáy cửa sổ WiseImage. Tắt kiểu này để thu được một đối tượng văn bản như một kết quả.


1. Khởi động lệnh từ thực đơn Draw>Raster>Edit Raster Text. hoặc trên thanh công cụ.  


2. Nhập văn bản từ bàn phím hoặc clipboard.


3. Chỉ rõ một vùng hình chữ nhật trên hình ảnh raster sẽ bị làm sạch  


 Sau khi bạn đã nhập văn bản và chỉ rõ kích thước vị trí của vùng, lệnh được hoàn thành.

Để nhập một văn bản mà không có rasterizing? RDRAW phải tắt. 


+Biên tập những văn bản OCR 


Những văn bản được đoán nhận được biên tập sử dụng hộp thoại đặc biệt với thanh công cụ. Thanh công cụ Text Correction chứa đựng một hộp edit và các nút :


[image: image64.png]


 Tìm  văn bản đầu tiên.
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 Tìm văn bản trước đây.


[image: image66.png]


Tìm văn bản tiếp theo.
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 ẩn/ hiện văn bản OCR.
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 Xóa đối tượng văn bản hiện thời từ tài liệu.
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 Chấp nhận văn bản và loại trừ đối tượng văn bản hiện thời từ danh sách của những văn bản được thừa nhận.


[image: image70.png]


Lựa chọn tất cả văn bản được thừa nhận.


Để biên tập những đối tượng văn bản đoán nhận  :


1. Khởi động lệnh từ thực đơn hoặc thanh công cụ.


Nếu chương trình không phát hiện ra bất kỳ văn bản được thừa nhận nào, thì thông báo được trình bày, và sau đó lệnh kết thúc.


Nếu tìm thấy, chương trình lựa chọn văn bản đầu tiên và được thừa nhận và pan hình ảnh để văn bản này được cho thấy trong trung tâm màn ảnh và mở hộp thoại, trình bày văn bản đầu tiên.


2.  Để sửa đổi một hàng văn bản, hãy vào một giá trị mới  trong hộp soạn thảo sử dụng cửa sổ  Inspector , Size, Font và những thuộc tính khác của những đối tượng văn bản có thể được thay đổi.


Để chấp nhận văn bản, nhấn nút Accept chấp nhận. Chương trình sẽ loại trừ văn bản này từ tập hợp văn bản được thừa nhận và sẽ tự động theo đuổi tới văn bản  đoán nhận sau .


Sử dụng  nút delete để xóa văn bản.


Sử dụng nút navigation để làm cho văn bản là hiện thời.


Sử dụng nút Hide Text  để che giấu hoặc hiện Văn bản đoán nhận để nhìn thấy Văn bản raster nằm bên dưới.


3. Lặp lại bước 2 cho tất cả các văn bản được thừa nhận.


Để thay đổi hoặc xóa những thuộc tính của tất cả các văn bản được thừa nhận, chọn nút Selects all để lựa chọn tất cả các văn bản được thừa nhận. Sử dụng cửa sổ Inspector để thay đổi kích thước, phông và những thuộc tính khác của tất cả các đối tượng văn bản. Nhấn nút delete sẽ Xóa tất cả các văn bản.


Để khởi động lệnh : Từ thực đơn Convert , chọn Edit OCR Text.

Chương 6: các công cụ chính

i-Inspector


Cửa sổ Inspector được sử dụng để trình bày thông tin trên một lệnh hiện thời hoặc đối tượng được lựa chọn , cũng như cho những lệnh điều chỉnh và biên tập đối tượng

 
Mỗi lệnh WiseImage có những thuộc tính của nó. Thay đổi những thuộc tính này trong cửa sổ Inspector , đối tượng tương ứng trên màn hình sẽ được cập nhật thay đổi. Thông thường trong môi trường Windows những lệnh mà yêu cầu thông tin bổ sung được thực hiện trong thứ tự sau :


1. khởi động một lệnh;


2. Hội thoại xuất hiện ;


3. Sau khi nhấn Ok, lệnh thực hiện theo nội dung xác định. Cửa sổ Inspector có thể hiểu như hội thoại chung cho sự điều chỉnh những lệnh WiseImage, như thao tác sửa đổi những đối tượng hoặc điều kiện của nó : di chuyển chuyển , tỷ lệ, quay, v.v., và  cũng tạo ra đối tượng mới . 


Thông thường  Inspector được mở tự động.
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Phụ thuộc vào tập hợp lệnh và kiểu chọn lọc hiện thời, Inspector trình bày nhiều thuộc tính của lệnh.

 
Khi một bộ phận của raster được lựa chọn. Bạn có thể di chuyển sự chọn lọc, thay đổi điểm cơ sở , thay đổi kích thước , sửa đổi những giá trị trong hộp, 

 
Cửa sổ Inspector cho phép điều chỉnh lệnh quay đối tượng vectơ chọn. Quay một đối tượng vectơ, bạn có thể chỉ rõ trung tâm , góc, và bao nhiêu thời gian lệnh sẽ được thực hiện 


 Inspector được sử dụng như một công cụ soạn thảo bổ sung. Bạn có thể sửa đổi một đối tượng trên màn ảnh với con chuột, hoặc nhập chính xác những giá trị trong hộp Inspector .


Nếu không có một sự lựa chọn nào trong tài liệu, thì cửa sổ Inspector trình bày những  thiết đặt tài liệu hiện thời, định nghĩa những thuộc tính tạo ra những đối tượng : Cho ví dụ, Nếu  Line Width chứa đựng giá trị " 1 mm ", tất cả những line, polylines, cung, vòng tròn, hình ê-líp, hình chữ nhật và splines nếu được tạo ra sẽ có chiều rộng này.

1-Inspector

a-Làm việc với cửa sổ Inspector

 
 Nếu không có Inspector trên màn ảnh, thì bạn có thể mở nó sử dụng lệnh Inspector từ thực đơn Tools, hoặc nhấn nút [image: image72.png]


 trên thanh công cụ Object Properties . Bạn có thể sử dụng những phím ALT +ENTER hoặc ALT + F1.


Cửa sổ Inspector thông thường được neo cố định; có thể thay đổi vị trí sử dụng kỹ thuật Windows chuẩn.

 
Bộ phận trên của cửa sổ Inspector  chứa đựng danh sách lọc và những nút điều khiển lọc .


+Filter list: chứa đựng một danh sách của lọc hiện hữu . 
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 : Tạo ra một  lọc mới.
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 :Xóa một lọc được chọn.
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 nút biên tập Lọc : bật kiểu biên tập. 
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: bật/tắttất cả các thuộc tính của lọc.

[image: image77.png]


: Che giấu tất cả các thuộc tính không hoạt động trong thời gian tạo thành lọc.
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Danh sách trong cửa sổ Inspector bắt đầu với tên lệnh hiện thời và thông tin chung của lệnh. Nội dung danh sách có thể thay đổi phụ thuộc vào bản chất lệnh.
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bộ phận còn lại của danh sách chứa đựng những thuộc tính lệnh hoặc thuộc tính của bất kỳ những đối tượng nào được chọn. Nếu không có sự chọn lọc, thì những danh sách hiển thị những sự thiết đặt tài liệu hiện thời sẽ được áp dụng để tạo ra đối tượng. Nội dung danh sách có thể thay đổi phụ thuộc vào bản chất lệnh.


Trong khi đọc thông tin trên cửa sổ Inspector, hãy nhớ những quy tắc sau :


Màu đen được sử dụng để cho biết những thuộc tính thay đổi được. Bạn có thể sửa đổi giá trị của những thuộc tính này bởi việc nhập những giá trị mới tới trường thích hợp. Inspector không cho phép những thay đổi cho những thuộc tính mà không phù hợp với kiểu thuộc tính được chọn.


Màu xám được sử dụng để cho biết những thuộc tính mà bạn không thể thay đổi trong cửa sổ Inspector, cũng như những thuộc tính bị phụ thuộc vào giá trị những thuộc tính khác ( Cho ví dụ, khi lựa chọn một vòng tròn trong thuộc tính Length chứa đựng độ dài vòng tròn, bạn chỉ có thể thay đổi bởi việc sửa đổi bán kính vòng tròn).


Nếu bạn đã lựa chọn vài đối tượng, thì danh sách chứa đựng tất cả các thuộc tính của tất cả các đối tượng được chọn. Bạn có thể dễ dàng sửa đổi những giá trị này; cho ví dụ, nếu lựa chọn một vòng tròn và một line, thì việc sửa đổi giá trị Bán kính sẽ chỉ sửa đổi vòng tròn được chọn; và  sửa đổi giá trị Góc sẽ chỉ thay đổi hướng quay của line.


Nếu giá trị thuộc tính chưa được chỉ rõ ( hộp trống rỗng), có nghĩa là giữa những đối tượng được chọn, giá trị của thuộc tính này thì khác nhau. Bởi việc vào một giá trị mới trong hộp thuộc tính trống , bạn có thể định nghĩa  giá trị đó là giá trị chung cho những thuộc tính của tất cả các đối tượng được chọn nếu thích hợp.


Vài sự thiết đặt trở thành hiện thời sau khi sửa đổi ; trong trường hợp này chúng cũng được trình bày trong những danh sách thích ứng của những thuộc tính. Cho ví dụ, nếu bạn thay đổi kiểu Hatch cho một đối tượng, kiểu này sẽ là  hiện thời , bằng cách kiểm tra cửa sổ Inspector với không có sự chọn lọc nào, bạn có thể xem kiểu Hatch sẽ được áp dụng tiếp theo cho đối tượng tạo ra .


Vài thao tác phức tạp có thể được thực hiện chỉ với con chuột  trong khi sử dụng Inspector như một công cụ thông tin. Nhưng nếu bạn muốn sự chính xác bạn phải sử dụng cả con chuột lẫn Inspector .


toàn bộ hành vi của Inspector kiểm soát bởi những sự thiết đặt trong mục Inspector của hội thoại Preferences


b-Tùy biến thuộc tính 


Bạn có thể thêm những tùy chọn người dùng vào những đối tượng WiseImage. Nhắp phải trên cửa sổ Inspector và chọn Add Property . Bạn có thể thêm dữ liệu Text, Integer Number, Float number, Yes/No (Boolean) như một giá trị cho thuộc tính mới. Sự Tạo thành những thuộc tính mới có hiệu lực từ WIOA script..

Những thuộc tính custom có thể hữu ích cho sự nghiên cứu script . Bạn có thể cất giữ thông tin bổ sung trong bất kỳ đối tượng nào trong tài liệu cho những mục đích WIOA script của bạn. Đó cũng là một khả năng nhập khẩu / Xuất khẩu những thuộc tính bổ sung tới những khuôn dạng khác nơi những thuộc tính này tồn tại.

c-Lọc


Lọc là những danh sách thuộc tính đưa vào cửa sổ Inspector. Bạn có thể tạo ra một lọc mới  từ lọc <all>, Nhấn nút [image: image80.png]


 và biên tập danh sách mở của những thuộc tính. Bạn chỉ có thể  loại trừ những thuộc tính từ danh sách này. Bạn có thể loại bỏ lọc hoặc tạo ra những cái mới sử dụng lọ hiện hữu . Lọc <all> thì không bao giờ xóa được .


Để tạo ra một lọc mới :


1. Nhấn nút lọc Mới.


2. Soạn thảo danh sách bởi việc thiết lập on/off của hộp hiểm ở tại tên thuộc tính. Khi biên tập bạn có thể sử dụng nút [image: image81.png]


 để on/off tất cả các thuộc tính của lọc và nút [image: image82.png]


 để che giấu tất cả các thuộc tính không hoạt động trong thời gian tạo lọc.


3. Soạn thảo tên lọc trong hộp tên hoặc bỏ qua 


4. Kích nút [image: image83.png]


  để chấp nhận cái Lọc.


Để loại bỏ một lọc :


1. Lựa chọn một lọc từ danh sách. 


2. Kích [image: image84.png]


 


3. Xác nhận sự xóa trong hộp thoại.


Để biên tập một lọc :


1. Lựa chọn một lọc từ danh sách và nhấn [image: image85.png]


 .


2. Soạn thảo danh sách bởi việc thiết lập on/off của hộp kiểm ở tên thuộc tính . 


3.  Nếu bạn muốn tạo ra một lọc mới từ một cái hiện hữu, hãy chỉ rõ tên của nó. Kích nút [image: image86.png]


 để " unpress "  và để chấp nhận những sự thay đổi.

d-Những kiểu lọc


Bạn chỉ có thể đặt hai phương án của những kiểu lọc : Lựa chọn Command sensitive hoặc Single từ hội thoại Preferences ( xem những kiểu lọc Inspector). Nếu kiểu Command sensitive đã bật, với mỗi lệnh cửa sổ Inspector hiện ra lọc ứng dụng mới đây nhất . Trong kiểu Single lọc chungđược hiển thị. 

2-kiểu lọc Inspector


Sử dụng kiểu để quản lý filters của Inspector. Tạo ra lọc, và bạn có thể thay đổi một số thuộc tính để trình bày khi những lệnh là thi hành. Phương án chọn ngầm định là Single; Có nghĩa là lọc chỉ được áp dụng cho tất cả các lệnh. Cho ví dụ, bạn tạo ra lọc với thuộc tính  duy nhất  ( hiển thị tên của lệnh thi hành). Sau khi lọc này được kích hoạt, Inspector trình bày duy nhất tên của lệnh thi hành.  Nếu bạn bật kiểu Command Sensitive, thì bạn có thể thiết đặt lọc cho mỗi lệnh riêng rẽ. 


Command sensitive
Chọn kiểu lọcriêng biệt  sử dụng cho mỗi lệnh.


Single*

Chọn kiểu đơn sử dụng cho tất cả các lệnh.


* sự thiết đặt mặc định


3-Những thuộc tính đối tượng chung


Đa số các tiết mục trong cửa sổ Inspector là rõ ràng, dễ hiểu. dưới đây có vài tiết mục cần phải giải thích:


-By Block: tùy chọn hiển thị khối được sử dụng. Đối tượng kế thừa màu, linetype và những thuộc tính khác của khối chứa đựng nó.


-By Layer: tùy chọn hiển thị lớp được sử dụng. Đối tượng kế thừa màu, linetype và những thuộc tính khác liên quan đến lớp của nó.


-Elevation:  trường giá trị độ cao. Bạn có thể sử dụng nó khi chuẩn bị thông tin cho những hệ thống GIS.


-Extended Data: trường cho thông tin tùy ý. Bạn có thể sử dụng nó khi chuẩn bị thông tin cho những hệ thống GIS.


-Hyperlin: Tùy chọn này cho phép bạn gán một siêu liên kết cho bất kỳ đối tượng nào.

ii-quản lý ảnh

1-Hội thoại quản lý hình ảnh


Hội thoại này kết hợp chặt chẽ trên cơ sở thiết kế những đặc tính để quản lý ảnh raster chứa đựng trong tài liệu WiseImage. Bạn có thể xóa, tạo ra những những hình ảnh raster mới trên cơ sở những thuộc tính của cái đã có, sửa đổi tên raster hợp lý, điều khiển tính rõ ràng, khóa raster sửa đổi, và lưu những hình ảnh raster được chọn 

Hộp thoại Images hiển thị tên của tất cả những hình ảnh load vào trong tài liệu WiseImage. 
Để mở hội thoại image: chọn Image từ thực đơn Tools hoặc kích nút [image: image87.png]


 trên  thanh công cụ Properties .

[image: image88.png]File name

Details

Laer 7 9 0 Detat
Calor 8 Layer
Elevation 000"

Extended Data

Hypeiirk

Image Name map

Path CFrogram Fles\ Consistent SoftwareWiselm






Để thay đổi thuộc tính của một hình ảnh, lựa chọn nó từ danh sách.

Name


Trong hộp này, bạn có thể nhập tên hợp lý một hình ảnh. 
File name


Hiển thị tên file hình ảnh được chọn.

Những thuộc tính Read-Only và Visible

Những thuộc tính này điều khiển khả năng thay đổi những hình ảnh của bạn. Chúng được đại diện bởi những biểu tượng [image: image89.png]


và [image: image90.png]


 ) và hai checkboxes trong Details của hội thoại. Bạn có thể thiết đặt giá trị TRUE và FALSE cho những thuộc tính này trong danh sách Details hoặc trong cửa sổ kiểm soát.

References


Hình ảnh được tạo ra hoặc mở một lần và có thể được chèn vào ( và hiển thị) nhiều lúc. Reference cho thấy số của thời gian mà hình ảnh được chèn trong tài liệu. Cho ví dụ, trong trường hợp này bạn có thể lựa chọn, sao chép, và pan hình ảnh, mục Reference sẽ chứa đựng  số2 .

 
Nếu hình ảnh không được chèn vào bất cứ nơi đâu trong tài liệu, thì sự Reference sẽ chứa đựng 0. có nghĩa là dữ liệu hình ảnh vẫn còn tồn tại trong tài liệu và sẵn hiển thị lần nữa; để loại bỏ nó, nhấn nút [image: image91.png]



Color


Trình bày màu của một hình ảnh ( cho những hình ảnh đơn sắc). Bạn có thể chọn một màu để phân biệt những hình ảnh trong cửa sổ kiểm soát hoặc những thanh công cụ Properties.  Tùy chọn By layer  gán màu của lớp cho những hình ảnh mà thuộc về lớp này; và By block  gán màu của khối cho một hình ảnh  là bộ phận của khối.

Layer


Bạn có thể thấy lớp ở đó có chứa một hình ảnh và di chuyển hình ảnh từ lớp này sang lớp khác ( Thật sự là hình ảnh không “ Di chuyển ”; nhưng thuộc tính Layer của hình ảnh thay đổi).

Details


Nút này mở danh sách đầy đủ của những thuộc tính hình ảnh. 

Preview


Cho thấy toàn bộ hình ảnh và cho phép xem những chi tiết. Những nút và những tùy chọn được mô tả ở phần trước

Buttons


[image: image92.png]


 Tạo một ảnh mới


[image: image93.png]


 Xóa một hình ảnh từ tài liệu


[image: image94.png]


 lưu hình ảnh


[image: image95.png]


 lưu tên mới


[image: image96.png]


  Làm cho hình ảnh được chọn là “nhúng”. Hình ảnh chưa được liên kết tới file và tồn tại chỉ trong tài liệu. 


[image: image97.png]


 Di chuyển  hình ảnh hoặc trang chọn (trường hợp nhiều trang) lên trên. 



[image: image98.png]


 Di chuyển  hình ảnh hoặc trang chọn (trường hợp nhiều trang) xuống dưới.

2-Lưu hình ảnh raster liên kết hoặc nhúng


Trong điều kiện lưu giữ trong tài liệu, tất cả các hình ảnh đều được chia tách thành hai nhóm : Liên kết và nhúng. 


Raster nhúng được cất giữ trong file tài liệu. Cho ví dụ, tài liệu của bạn gồm có 30 hình ảnh raster, và nó được cất giữ trên đĩa như một file đơn với đuôi mở rộng CWS. 


Tài liệu nào chứa đựng những hình ảnh raster nhúng được mở nhanh hơn, so với hình ảnh raster liên kết vì bộ phận load đã mở hình ảnh raster nhúng.


Hình ảnh được tạo ra với những lệnh : New image, New image from selection, Acquire, New image from scanner  là hình ảnh raster nhúng (theo mặc định. )


Nếu bạn muốn lưu hình ảnhraster nhúng cho file, thì sử dụng nút [image: image99.png]


.


Hình ảnh raster liên kết được cất giữ trên đĩa riêng rẽ từ file tài liệu. Trong trường hợp này tài liệu chỉ chứa đựng mối liên kết tới file. Chương trình ghi đường dẫn tuyệt đối cho file ( ví dụ. P:\RASTERS\MONO\PROCESSED\00052.tif).


Khi mở một tài liệu chứa đựng những hình ảnh raster liên kết, WiseImage tìm kiếm những hình ảnh raster bằng đường dẫn đã lưu. Nếu hình ảnh raster chưa được phát hiện ra bởi đường dẫn xác định, thì chương trình tìm kiếm trong thư mục tài liệu. Nếu không phát hiện ra, thì một đường viền của nó được trình bày trong tài liệu cùng với chuỗi đường dẫn của hình ảnh . Liên kết hoặc nhúng hình ảnh raster được chèn vào trong tài liệu nhiều lần, trở thành read-only. Một số của sự chèn vào được trình bày trong cột Refs.

3-Xóa hình ảnh raster từ tài liệu


Sau khi bạn đã xóa raster như đối tượng vectơ, định nghĩa của nó được cất giữ trong danh sách của những hình ảnh, được chứa đựng trong tài liệu ( trong trường hợp raster nhúng, nó được định vị bên trong tài liệu). Để loại bỏ hoàn toàn một hình ảnh sử dụng nút [image: image100.png]


 


Bạn có thể huỷ sự xóa với lệnh Undo từ thực đơn Edit . Bạn không thể xóa một hình ảnh trong những trường hợp sau : được định vị trên lớp khóa ( Mở Layer Manager và mở khóa Lớp, khi đói thử xóa lần nữa.) - Khối đã được tạo ra trên cơ sở hình ảnh raster mà bạn thử xóa ( Mở Block Manager, xóa Khối, và thử xóa hình ảnh lần nữa).

4-Làm tăng tốc độ tải một tài liệu chứa đựng nhiều hình ảnh raster


Mở quản lý ảnh và kích vào cột eye, bitmap hiển thị. Như vậy bạn tắt hiển thị của nội dung hình ảnh raster, và tất cả các hình ảnh raster đều được trình bày như những viền trống.Lưu tài liệu (lệnh save ). Sau này mở tài liệu này, bạn có thể bật hiển thị của những hình ảnh raster mà bạn sẽ làm việc ; những hình ảnh khác chưa bật sẽ không nhìn thấy.

iii-quản lý lớp



Một tài liệu WiseImage gồm có những lớp trên đó có thể tổ chức những đối tượng WiseImage. Bởi việc thiết đặt những đối tượng trên những lớp, bạn có thể điều khiển tính nhìn thấy của chúng và dễ dàng làm những sự thay đổi.


Mỗi đối tượng WiseImage thuộc về một lớp nhất định có một thuộc tính riêng.

Những đối tượng tạo ra có thể có những thuộc tính mặc định của một tài liệu WiseImage hoặc thừa nhận một số thuộc tính từ lớp chứa chúng. 

Nh​ư vậy, nếu bạn muốn những thuộc tính của những đối tượng tạo ra kế thừa những thuộc tính của lớp chứa đựng chúng, Chỉ rõ By layer trong hộp tương ứng của những thuộc tính tài liệu WiseImage. Nếu không, những đối tượng tạo ra sẽ thừa kế những thuộc tính của một tài liệu WiseImage. 


Bạn có thể tạo lớp, đặt tên, và gán những thuộc tính cho lớp( màu hiển thị, linetype, lineweight, ...). Một lớp có thể ẩn hoặc bày ra, khóa hoặc mở , có thể lựa chọn hoặc không chọn lọc. Có một lớp là lớp hiện thời. Khi bạn bắt đầu một tài liệu mới, nó luôn luôn chứa đựng một lớp mặc định với những thuộc tính trùng với những thuộc tính tài liệu WiseImage. Bạn có thể tạo ra vô số lớp. Một lớp mới thừa kế những thuộc tính của lớp mà được lựa chọn khi tạo ra. Lớp tạo mới luôn luôn thấy được, không khóa, và có thể lựa chọn. Chương trình gán cho tên New Layer (N), N là số thứ tự. Bạn có thể tạo ra và xóa bớt lớp, lấy thông tin trên những thuộc tính của nó, và thay đổi chúng sử dụng hội thoại Layers.
1-Tạo ra một lớp


Để tạo ra một lớp mới , nhấn nút [image: image101.png]


 trên hội thoại layer.

Nếu muốn tạo ra lớp mới kế thừa những thuộc tính của lớp khác , lựa chọn lớp đó trước khi tạo ra lớp mới. 

2- Xoá lớp


Có thể xóa một lớp, mà không chứa đựng bất kỳ những đối tượng nào. Nếu bạn cần xóa một lớp, có chứa đựng những đối tượng, phải xóa những đối tượng đó trước


Lựa chọn một lớp rỗng để xóa từ hội thoại và nhấn nút [image: image102.png]



3-Đôi tên lớp


Bạn có thể đổi tên một lớp vào bất kỳ thời gian nào. Để đổi tên một lớp :Lựa chọn một lớp để đổi tên và sau đó kích tên đang hoạt động của nó và vào tên mới 

4- Làm cho một lớp hoạt động


Bạn luôn luôn tạo ra một đối tượng trên lớp hoạt động ( hiện thời). Đối tượng này có thể giả thiết những thuộc tính từ lớp chứa nó, nếu bạn thiết đặt giá trị By layer bên trong hộp thuộc tính tài liệu WiseImage. Một lớp hoạt động cần phải luôn luôn hiện thời. Để làm cho một lớp là hiện thời: lựa chọn một lớp trong hội thoại layer, và sau đó kích biểu tượng [image: image103.png]


 hoặc bật checkbox Active trong cửa đầy đủ layer.

5-Điều khiển tính thấy được của Lớp


WiseImage không trình bày hoặc phác họa những đối tượng được đặt trên lớp không nhìn thấy. Lớp Hiện thời thì luôn luôn rõ ràng. Một lớp không nhìn thấy không thể thiết lập là hiện thời. Để bật hoặc tắt lớp :


Lựa chọn một lớp trong hội thoại lớp, và sau đó kích biểu tượng [image: image104.png]


 

6-Khoá, mở lớp


Bạn không thể soạn thảo những đối tượng trên một  lớp khóa; tuy nhiên, những đối tượng vẫn thấy được và có thể lựa chọn chúng và nhìn thấy những thuộc tính của nó. Bạn có thể khóa lớp hiện thời , và có thể tạo ra và chèn những đối tượng trong nó. Có thể cũng sử dụng những lệnh mà không thay đổi những thuộc tính của những đối tượng định vị trên lớp khóa ( cho ví dụ bạn có thể lựa chọn những vectơ và chuyển đổi chúng tới một hình ảnh raster được chèn vào trong lớp khác không bị khóa ). Bạn có thể áp dụng đối tượng snap với những đối tượng trên lớp khóa . Bạn có thể tắt tính nhìn thấy những lớp khóa cũng như thay đổi những thuộc tính của chúng.

Để khóa hoặc mở khóa những lớp, lựa chọn một lớp , và sau đó kích biểu tượng khóa 
[image: image105.png]


 
7-Mở hộp thoại quản lú lớp

Chọn Layers từ thực đơn Tools hoặc kích nút [image: image106.png]


 trên thanh công cụ thuộc tính.
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Bạn có thể mở rộng cửa sổ bằng cách  nhấn nút Details để trình bày đầy đủ  những thuộc tính lớp sẽ được kế thừa bởi những đối tượng tạo ra trên nó và được chèn vào trong lớp.

iv-quản lý khối


Từ thực đơn Tool , chọn Blocks.hoặc kích nút [image: image108.png]


 trên thanh công cụ Properties.

Đây là một cửa sổ qủan lý khối; nó cho biết một số khối hiện có trong một tài liệu và những sự tham chiếu tới khối. Cửa sổ này cho phép đổi tên và xóa những khối. Những khối được tạo ra với lệnh block, bạn có thể gán những thuộc tính cho những Khối.


-Nút xóa [image: image109.png]




Xóa định nghĩa khối từ tài liệu. Những khối được cất giữ bên trong một tài liệu. Bạn không thể xóa một khối mà có những khối khác tham chiếu (những khối được tạo ra trên về cơ sở của khối này. )


-Nút lưu [image: image110.png]


 


Lưu giữ giữ những đối tượng trên cơ sở của một khối được tạo ra trong một tài liệu WiseImage trên với một tên xác định.

[image: image565.png]



-Trường Name
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-Refs 


Trình bày một số của sự tham khảo tới định nghĩa khối.  Nếu số này bằng 0, thì có nghĩa là khối không được chèn vào trong tài liệu và chỉ được cất giữ bên trong file tài liệu. Có thể sử dụng một khối khác được xem như là một sự tham khảo khối, thì một số tham khảo sẽ lớn hơn 1.


-Color 


Chỉ rõ màu cho những đối tượng trong khối; những đối tượng phải có thuộc tính By Block.

· Layer 

Trình bày một lớp trên đó một điểm chèn khối được định vị và cho phép cho thay đổi nó.


-Nút Details>>


Mở một khu vực bổ sung của hộp thoại nơi có cửa sổ xem trước và những thuộc tính bổ sung 

· Details 


Chứa đựng một danh sách của những thuộc tính điểm chèn khối, mà có thể được thay đổi. Cho ví dụ, bạn có thể sửa đổi chèn khối. Chú ý rằng nếu một khối có nhiều lần chèn vào trong tài liệu, thì những thuộc tính của điểm chèn của nó có thể chỉ được thay đổi với cửa sổ Inspector..
· Preview window 


Trình bày một sự sao chép nhỏ hơn của khối. Với những nút "+" và "-" bạn có thể thay đổi tỷ lệ hiển thị khối.


+Định nghĩa lại tất cả sự chèn vào trong tài liệu ( ví dụ thay đổi những sự lồng vào của một thư mục với những sự lồng vào của khối khác) :


Giả thiết rằng bạn có một tài liệu mà chứa đựng số nào đó của khối lồng vào có tên "Clset_tube ". Bạn muốn thay đổi chúng với một khối với nội dung khác. Bạn làm như sau :


1. Tạo ra một khối nhập một tên khối " clset_tube " và chỉ rõ điểm cơ sở của khối. 


2. Bạn có một thông báo " Are you sure you want to replace block? "  Chọn Ok để xác nhận. 


-Xóa một khối :


 Mở cửa sổ khối , lựa chọn tên khối muốn xóa và kích vào nút xóa.


-Đổi tên một khối :


1. Mở cửa sổ và nhấn đúp vào tên khối 


2. Bây giờ bạn có thể sửa đổi tên khối, nhấn Enter để hoàn thành. Chú ý rằng bạn không thể nhập một tên khối hiện có; bạn sẽ có mộtóthong báo " không thể đổi tên khối " "!"


- Lưu giữ nội dung khối trong tài liệu:


1. Mở cửa sổ khối, lựa chọn tên khối mà nội dung nào bạn muốn lưu giữ tới một file tài liệu riêng biệt.


2. Nhấn [image: image112.png]


  . Trong cửa sổ, vào một tên và chỉ rõ một thư mục để lưu giữ file tài liệu.  Khi lưu giữ, một khối bung ra những đối tượng thành phần với một mức. Có nghĩa là nếu bạn lưu giữ trong cách này một khối tạo ra trên cơ sở hai khối khác, bạn thu được hai khối đã lưu trong tài liệu. Nếu bạn muốn lưu giữ một khối mà không được bung ra tới những đối tượng, sử dụng cửa sổ Clipbook.
 

v-kiểu đường


Để khởi động lệnh : Từ thực đơn Tools , chọn Style
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1-Kiểu đường là gì?


Mỗi đối tượng vectơ WiseImage có một kiểu đường liên quan đến nó (xem thuộc tính kiểu đường trong Inspector). Kiểu đường là một định nghĩa xác định một dash-gap (nét-khoảng hở) và độ dài tương đối của những nét và những chỗ trống. Bạn có thể sử dụng bất kỳ kiểu đường chuẩn nào cung cấp bỡi WiseImage, hoặc có thể tạo ra những kiểu đường mới. Tất cả các kiểu đường WiseImage chuẩn không thể xóa hoặc đổi tên, tuy nhiên chúng có thể được sửa đổi tuỳ thích.

2- Quản lý kiểu đường


Nó được sử dụng để tạo ra, xóa và sửa đổi những kiểu đường. hộp danh sách Pen Styles  cho thấy tất cả các kiểu trong tài liệu. Nó hỗ trợ nhiều trong sự chọn lọc ( Với phím SHIFT hoặc CTRL), và khả năng kéo, thả


+Trường Locked: WiseImage có một số kiểu chuẩn, mà có thể được sửa đổi nhưng không được đổi tên hoặc đã xóa.  Những kiểu này rõ rệt bởi một ký hiệu phím đưa vào trường này.


+Name: Trình bày tên kiểu đường.


+ Pattern: hiển thị sự trình bày trực quan một kiểu đường 


+ Description: hiển thị đầy đủ thông tin về một kiểu đường được chọn: tên, số của những cặp mẫu, các cặp phân cách ra bởi dấu phẩy.


+ New: trình bày hội thoại Pattern Style để tạo ra một kiểu đường mới.


+Nút New Copy: Cho thấy cửa sổ hội thoại Pattern Style cung cấp những tham số kiểu đường được chọn để tạo ra một sự sao chép của kiểu đường này. Tên kiểu đường với kiểu đường mới theo mặc định là: " Copy of CopiedLineStyleName ", ở đây CopiedLineStyleName là tên của Một kiểu đường sao chép.


+Nút Modify: Cho thấy hội thoại để sửa đổi một kiểu đường được chọn. Chú ý rằng tất cả các Kiểu đường WiseImage chuẩn đều rõ ràng với ký hiệu chìa khóa và không thể xóa hoặc đổi tên, nhưng có thể tùy thích sửa đổi.


+Nút Delete: Xóa kiểu đường chọn.


Cảnh báo : cẩn thận để không xóa một kiểu đường mà được sử dụng bởi vài đối tượng tài liệu.  Nếu một kiểu đường sử dụng được loại bỏ, thì sau này tài liệu mở lại, tên của kiểu đã bị xóa này sẽ được trình bày trong những dấu móc tam giác cho tất cả các đối tượng mà sử dụng kiểu này, nhưng thật sự những đối tượng này sẽ được trình bày trong một kiểu đường đặc.


+Nút Import…: Nhập khẩu kiêu đường từ file định nghĩa AutoCAD linetype (. File LIN). Một file LIN có thể chứa đựng những định nghĩa của nhiều kiểu đường phức tạp và đơn giản. File này có một khuôn dạng ASCII.


+Nút Close : đóng hội thoại quản lý.

3-Hội thoại Pattern Style


Hội thoại này được gọi từ Line Style Manager và sử dụng cho sự tạo thành, sửa đổi và copy những kiểu đường.


Những mẫu:


Khuôn dạng của định nghĩa kiểu đường bao gồm một số của mẫu gồm có ba phần :

Giá trị Dash - giá trị khoảng hở - Marker (có thể có hoặc không)
Cho ví dụ, một kiểu tiêu chuẩn WiseImage, gọi là DotDotDashedLin, bao gồm ba mẫu định nghĩa  : 


Dash 
Gap 
Marker 


8 mm
2 mm 
 < none >


1 mm
 2mm 
 < none >


1 mm
 2mm
 < none >


ở đây cho biết một mẫu lặp lại bắt đầu với một nét dài 8 mm, một chỗ trống 2 mm, một chấm. điểm, một chỗ trống 2 mm, một chấm. điểm và chỗ trống khác 2 mm. Mẫu này tiếp tục cho độ dài của đường. Kiểu đường được trình bày như​ sau:


__. . __. . __. . __. . __. . __. . __


+ Dash field: Chỉ rõ độ dài của của nét


+ Gap field: Chỉ rõ độ dài của chỗ trống.


+ Marker field: chỉ rõ vạch dấu mà sẽ được đặt trong giữa chỗ trống của một mẫu hiện thời. Bạn có thể gán nhiều vạch đánh dấu cho những mẫu khác nhau của một kiểu đường.

Cho thấy rằng một hàng gọi tên sự trình bày trực quan.

4-Những kiểu phức tập


Một kiểu đường phức tập gồm có vài kiểu đơn giản. offset, chiều rộng và màu có thể được chỉ rõ cho mỗi kiểu.


Offset thiết đặt một giá trị bị dịch chuyển của một đường tương đối tới trục trung tâm của một kiểu phức tạp. Những giá trị dương có nghĩa là sự dịch chuyển qua phải, ngược lại là qua trái.


Line Width thiết đặt một giá trị chiều rộng một kiểu xác định.


Theo mặc định, màu đường tương ứng tới màu của kiểu , tuy nhiên có thể được thay đổi. 
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Tạo ra kiểu phức tạp: 


Một Kết hợp kiểu có thể được tạo ra sử dụng một tập hợp của các kiểu đơn giản  . Điều  này có thể được làm trong hội thoại Combined Style

Lựa chọn tất cả các kiểu đơn giản cần kết hợp trong hội thoại Line Style và kích nút Combine để tạo ra một kiểu phức tạp mới.


Hội thoại Combined Style với tất cả các kiểu chọn trước sẽ xuất hiện.


Có thể soạn thảo lại những tham số chiều rộng và màu cho mỗi kiểu.  Để thêm một kiểu mới vào một tập hợp sử dụng nút [image: image115.png]


 . Kích nút [image: image116.png]


  để xóa bất kỳ kiểu nào. Sử dụng những nút [image: image117.png]


 [image: image118.png]


 để thay đổi thứ tự tiết mục trong tập hợp. hộp Style Name chỉ rõ tên của một kiểu và hộp Default Unit chỉ rõ những đơn vị phép đo cho những tham số Offset và Width.


Ví dụ : Tạo thành một kiểu đường đường sắt


Mở Hội thoại Line Style.


Chọn kiểu SolidLine và DashedTriangleLine trong danh sách bởi việc lựa chọn chúng với cách nhấn Ctrl.


Kích nút Combine.


Trong hội thoại Combined Style nhập  tên" Đường sắt " và chỉ định milimét trong hộp đơn vị mặc định.


Kích nút [image: image119.png]


  hai lần thêm hai tiết mục kiểu vào danh sách. Kích vào trường Style bổ sung Kiểu mới và chọn tên Kiểu SolidLine. Bây giờ có ba thể hiện của kiểu SolidLine và một thể hiện của kiểu DashedTriangleLine trong danh sách.
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                                                       Thiết lập này đại diện một đường mỏng, đặt. Thiết đặt một giá trị chiều rộng bằng 6 mm và màu vàng cho thể hiện kiểu SolidLine đầu tiên.

            [image: image120.png]


      Tập hợp này đại diện một mỏng nhất trí kẻ.


Đặt một giá trị chiều rộng bằng 6 mm và Màu vàng màu cho thể hiện kiểu SolidLine đầu tiên.

Một hàng vàng rộng xuất hiện.


Đặt một giá trị offset bằng 3 mm cho thể hiện kiểu SolidLine thứ hai và một giá trị offset - 3 mm cho cái thứ ba

             [image: image121.png]


 Bây giờ chúng ta có một đường vàng rộng với một DashedTriangleLine đen mỏng trong giữa được giáp giới với hai đường màu đen mỏng, đặt.


Đặt một chiều rộng DashedTriangleLine bằng 6 mm.

           [image: image122.png]


 Những đường màu vàng và đường kiểu DashedTriangleLine có cùng chiều rộng đó và giá trị offset cũng vậy 

vi-kiểu text


Mỗi văn bản trong một tài liệu WiseImage có một kiểu văn bản liên quan đến nó. Một kiểu văn bản định nghĩa những đặc trưng văn bản như: Phông, chiều cao, hệ số chiều rộng, và độ xiên. Để sử dụng bất kỳ thuộc tính văn bản nào từ kiểu văn bản có liên hệ, giá trị thuộc tính này phải được thiết lập tới By Style.


Sử dụng kiểu văn bản, bạn có thể thay đổi những thuộc tính văn bản cho một số đối tượng. Chỉ cần sửa đổi bất kỳ tham số nào của kiểu văn bản, kiểu văn bản sẽ được thay đổi ngay lập tức.


Bạn có thể thay đổi cho một kiểu văn bản sau : Text, Multiline text, Dimension text, Block, bởi việc thay đổi một giá trị của thuộc tínhText Style trong Inspector.


Quản lý vVăn bản được sử dụng để quản lý những kiểu văn bản.

Sử dụng hộp combo trong góc trên trái để chuyển giữa các kiểu văn bản của tài liệu .

Những thuộc tính kiểu Văn bản


Name: Trình bày một tên kiểu văn bản sẽ được biên tập. 


Text Font:  thay đổi một kiểu phông .


Text Height: thiết đặt một chiều cao văn bản dựa vào giá trị bạn nhập hoặc chọn từ danh sách.


Text Width Factor: Thiết đặt khoảng cách ký tự. 


Text Oblique: Đặt một góc nghiêng của văn bản, 


Để khơi động lệnh: Từ thực đơn Tools , chọn Text Style.

Vii- sự làm sạch 


Hội thoại này được thiết kế để loại bỏ những đối tượng có tên không sử dụng , kể cả những định nghĩa khối, định nghĩa hình ảnh, lớp và kiểu văn bản.


Thường xuyên sửa đổi những tài liệu sẽ chứa đựng nhiều đối tượng không dùng như những định nghĩa khối mà không có những sự lồng vào khối, những định nghĩa hình ảnh mà không có những sự lồng vào hình ảnh, những lớp mà không chứa đựng những đối tượng, những kiểu văn bản cũ . 


Hội thoại này trình bày duy nhất những đối tượng đó mà có thể được loại bỏ an toàn từ tài liệu. Cho ví dụ, một định nghĩa khối không thể được xóa nếu nó được lồng vào bên trong khối khác.


Cửa sổ Unusable objects :


Những đối tượng sau sẽ không rõ ràng trong hội thoại này :


+Một định nghĩa khối không thể xóa nếu:


Nó được lồng vào bên trong định nghĩa khối khác.


Nó được chèn vào trong bản vẽ.


+Một định nghĩa hình ảnh không thể xóa Nếu


Nó được lồng vào bên trong định nghĩa khối.


Nó được chèn vào trong bản vẽ.


+Một lớp không thể xóa Nếu


Nó là lớp hiện thời.


Nó chứa đựng những đối tượng.


+Một kiểu văn bản không thể xóa nếu


Nó là kiểu hiện thời


Nó được sử dụng trong bản vẽ.


Hộp kiểm Confirm each item to be purged 


Sử dụng tùy chọn này để ngăn ngừa những loại bỏ tình cờ.


Nút Purge :

Loại bỏ một tiết mục được chọn từ tài liệu. 


Để khởi động lệnh : Từ thực đơn Tools , chọn Purge.

viii-Clipbook


WiseImage Clipbook cất giữ raster, vectơ hoặc hybrid (Đối tượng lai) .


Bất kỳ những sự chọn lọc nào đều có thể được cất giữ trong WiseImage Clipbook. Clipbook giữ dữ liệu cho đến khi bạn ra khỏi WiseImage. Bạn có thể đặt tên bất kỳ tiết mục nào cất giữ trong Clipbook và sau đó dán những tiết mục này trên không gian làm việc WiseImage.


Bạn có thể đặt tên và lưu nội dung của bất kỳ WiseImage Clipbook nào trong một file và sau đó khôi phục nó. Bởi vậy, những file Clipbook có thể được sử dụng như những thư viện của raster, vectơ hoặc đối tượng lai. Để tạo ra một cửa sổ Clipbook mới, từ thực đơn Toolss, chọn Clipbook. hoặc kích nút [image: image123.png]


 Trên thanh công cụ Edit .

Cửa sổ xuất hiện.

[image: image124.png]]
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xe "Clipbooks"
1-Di chuyển đồ họa vào trong Clipbook


Để di chuyển đồ họa từ tài liệu WiseImage tới Clipbook, cut hoặc coppy một  chọn lọc được Cut hoặc coppy, và dán dữ liệu tới Clipbook. cũng có thể  kéo và thả những tiết mục lựa chọn vào trong cửa sổ Clipbook đang mở.

Để di chuyển đồ họa vào trong một Clipbook


1.
Lựa chọn đồ họa để di chuyển.


2.
Từ Edit hoặc nhấn phải và thực đơn chọn Cut hoặc coppy.

 3.
Kích hoạt cửa sổ Clipbook.

Nhấn phải bất cứ nơi đâu trong cửa sổ Clipbook. Từ thực đơn cursor, chọn paste.

 sự chọn lọc trước đó bị sao chép hoặc cắt xuất hiện trong cửa sổ Clipbook. Nó xuất hiện nh​ư “Item N” N là số nguyên

[image: image125.png]



2-quản lý nội dung clipbook

Lưu clipbook


1.
Kích hoạt cửa sổ Clipbook sẽ được lưu trữ.


2.
Từ thanh công cụ Clipbook kích nút [image: image126.png]


 .

 hoặc : Nhấn phải bất cứ nơi đâu trong cửa sổ Clipbook. Chọn Save từ thực đơn cursor.

Để l​u trữ Clipbook với tên mới


Kích hoạt hộp Clipbook sẽ được lưu trữ.


Từ thanh công cụ Clipbook, hãy kích nút [image: image127.png]


.  hoặc :Nhấn phải bất cứ nơi đâu trong hộp Clipbook. Chọn Save As từ thực đơn cursor.

Lưu clipbook với tên mới


Kích hoạt hộp Clipbook 


Từ thanh công cụ Clipbook, hãy kích nút [image: image128.png]


. hoặc :
Nhấn phải bất cứ nơi đâu trong cái hộp Clipbook. Chọn Save As .Hộp thoại  xuất hiện.
Chọn thư mục để lưu trữ Clipbook.



Nếu cần thiết, ấn nút Option và viết những chú giải cho Clipbook này bên trong cửa sổ chú giải. Nhập một tên mới trong hoặc lựa chọn một File hiện hữu để thay thế. Kích Save
Để load nội dung Clipbook lưu trước đó 


1.
Kích hoạt cửa sổ Clipbook nơi bạn muốn load nội dung đã lưu.


2.
Từ thanh công cụ Clipbook kích nút [image: image129.png]


.

- hoặc : nhấn phải bất cứ nơi đâu trong cửa sổ Clipbook. Chọn Open từ thực đơn 

Hộp thoại Clipbook  xuất hiện.

3. Lựa chọn tên của một file để mở và kích Open

3-Quản lý những tiết mục Clipbook


Sử dụng thực đơn cursor bạn có thể đổi tên, xóa , cắt, sao chép, và dán bất kỳ tiết mục Clipbook nào.


Bạn có thể kéo những tiết mục từ Clipbook và thả chúng trên một tài liệu WiseImage hoặc trên Clipbook khác

Để điều khiển một tiết mục Clipbook: 


Lựa chọn một tiết mục với nút chuột trái, rồi nhắp phải xuất hiện thực đơn cursor.Chọn :


Cut : để xóa bỏ tiết mục được chọn và đặt nó trong bộ nhớ dữ liệu WiseImage.



Coppy:
Để đặt tiết mục được chọn trong bộ nhớ dữ liệu WiseImage nhưng không loại bỏ tiết mục từ Clipbook



Rename: để thay đổi tên của tiết mục được chọn.



Delete:  để loại bỏ tiết mục được chọn từ Clipbook.


4-Dán đồ họa từ Clipbook


Bạn có thể dán một tiết mục Clipbook tới một tài liệu WiseImage hoặc tới Clipbook khác đang mở.


Bất kỳ tiết mục nào có thể được di chuyển, tỷ lệ và quay trong một tài liệu WiseImage.


Để dán một tiết mục Clipbook:


1.
Trong cửa sổ Clipbook, hãy lựa chọn một tiết mục để dán.


2.
Cắt hoặc sao chép tiết mục được chọn tới bộ nhớ dữ liệu WiseImage sử dụng lệnh từ thực đơn cursor .


3.
Từ Edit menu WiseImage, hãy chọn paste - hoặc: đặt cursor trên tài liệu WiseImage hoặc trên cửa sổ Clipbook khác và chọn Paste từ thực đơn cursor. hoặc : Kéo tiết mục từ Clipbook đến tài liệu WiseImage hoặc tới cửa sổ Clipbook khác.

Tiết mục xuất hiện trong tài liệu WiseImage hoặc trong cửa sổ Clipbook khác.


Những tiết mục Clipbook giữ gìn cấu trúc lớp.  Nếu bạn dán những tiết mục multilayered vào trong tài liệu của bạn, thì số lớp có thể tăng thêm, nếu những tên lớp của tiết mục Clipbook khác với tài liệu.  Nếu những tên lớp của tiết mục Clipbook trùng với vài tên lớp trong tài liệu, thì những lớp  cùng tên đó được hợp nhất.

 ix-hệ thống tọa độ


Hội thoại này cho phép tạo ra, sửa đổi và chuyển hệ thống toạ độ cho tài liệu hiện thời WiseImage. Theo mặc định một tài liệu WiseImage mới mở trên hệ thống toạ độ World ( Những tham số : gốc 0.0, 0.0 / góc 0 / hướng ngược chiều kim đồng hồ,scale1:1,). Đơn vị chỉ định theo mặc định, phụ thuộc vào vùng địa lý được thiết lập trong những tùy chọn của hệ thống của bạn.. có thể chọn để làm việc trên hệ thống tọa độ work hoặc toạ độ do người ding định ra.


Tab hệ thống toạ độ cho thấy những tham số cơ bản của hệ thống tọa độ.  Nếu Hệ thống tọa độ World được lựa chọn, thì những tham số Origin, On Page, Angle, Scale, Actual và To  được vô hiệu hóa.

1-Tab Coordinate System:

a-Hộp Combo Coordinate system



Chọn hệ thống tọa độ hiện hữu ở hộp này hoặc kích nút [image: image130.png]


, tiếp theo tới trường Coordinate System, đặt một tên cho hệ thống tọa độ của bạn, và nhấn Enter.


Bạn có thể xóa bất kỳ hệ thống tọa độ người dùng sử dụng nút [image: image131.png]


 

b- Trục phương hướng (Axis direction)


Mỗi một dấu hiệu đại diện một hệ tọa độ. [image: image132.png]



c-Gốc (origin)

Định nghĩa vị trí gốc cho hệ thống tọa độ người dùng. Bạn có thể đặt một vị trí mới của gốc bởi việc sử dụng phương pháp:nhập tọa độ trong trường; hoặc kích vào nút đo [image: image133.png]


 và chỉ rõ gốc trong tài liệu. 

d-To


Sử dụng trường này bạn đơn giản hóa thiết đặt gốc, trong trường hợp bạn biết những tọa độ của một điểm nhất định, và bạn cần để tự động tính toán những tọa độ của gốc trên cơ sở của điểm này .

đ-Góc(Angle)


Định nghĩa góc quay cho hệ thống tọa độ. Bạn có thể đặt một góc quay mới của hệ thống tọa độ sử dụng các phương pháp :


Vào giá trị góc quay mong muốn trong trường. hoặc kích vào nút đo, và chỉ rõ góc trong tài liệu bởi việc vẽ một line.

e- Scale

[image: image134.png][Soale:  fCustom
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Sử dụng các trường Scale, On Page, Actual, bạn có thể đặt tỷ lệ cho hệ thống tọa độ. Bạn có thể đặt tỷ lệ sử dụng phương pháp:nhập giá trị trong trường ( ví dụ 1 : 120) hoặc chọn nó từ danh sách thả xuống hoặc kích vào nút đo, và chỉ rõ hai điểm trong tài liệu. 

Cho ví dụ, nếu giá trị của khoảng cách chính xác là 10 mm, Và bạn muốn nó tương ứng tới 50 km, Nhập 50 trong Actual. Giá trị Custom sẽ xuất hiện trong Scale

[image: image135.png]


 Chỉ rõ giá trị cho một trường tương ứng trong cửa sổ tài liệu.


[image: image136.png]


 Thiết lập giá trị cho một trường tương ứng tới mặc định.


[image: image137.png]


 Thiết lập tất cả các tham số của bảng Hệ thống tọa độ tới giá trị World coordinate system của nó.

2-Bảng Units


Bảng những đơn vị được thiết kế để sửa đổi những đơn vị (linear, angle) và sự chính xác của nó. [image: image138.png][Line wickh
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Khi hệ thống tọa độ người dùng là hiện thời, những tham số của đơn vị người dùng và sự chính xác của nó trở thành sẵn sàng cho sửa đổi.  Khi làm việc trong bất kỳ hệ thống người dùng nào, tham số đơn vị World điều khiển những đơn vị phép đo cho chiều rộng đường ( vectơ và raster), khoảng cách của hatch, chiều cao văn bản; tham số những đơn vị User để đo những khoảng cách trong tài liệu. Khi làm việc trên hệ thống World ( một mm" paper " thì bằng một mm trong tài liệu), tham số đơn vị World điều khiển tất cả.


a-Combo Coordinate system


Chọn hệ thống tọa độ hiện hữu ở hộp này hoặc kích nút [image: image139.png]


, tiếp theo tới trường Coordinate System, đặt một tên cho hệ thống tọa độ của bạn 


b-Trường World


+ Units : Thiết đặt những đơn vị để đo chiều rộng line, khoảng cách hatch, chiều cao văn bản : millimeter ( mm), inch, và đơn vị  khác.


+ Precision :Thiết đặt một số chữ số sau khi ký hiệu thập phân.  Để đặt sự chính xác , hãy chọn giá trị mong muốn từ danh sách.  Nếu bạn đặt giá trị 0, bạn sẽ thấy số của những chữ số sau ký hiệu thập phân.


c-Trường User


+ Units: Thiết đặt những đơn vị để đo những khoảng cách và những kích thước 


+ Precision: Thiết đặt một số chữ số sau ký hiệu thập phân. 


d-Trường Angle:


+ Units: thiết đặt những đơn vị để đo góc : Decimal Degree, Grad hoặc Radian.


+ Precision: Thiết đặt một số chữ số sau ký hiệu thập phân.


đ-Trường Scale


Chọn sự chính xác mong muốn từ danh sách thả xuống của hộp.

3-Tab Advanced 


Nó giúp đỡ bạn thiết đặt một hệ thống tọa độ trên cơ sở của một ít ( thậm chí rất ít) điểm điều khiển với những tọa độ được biết. Sử dụng phương pháp này bạn có thể dễ dàng snap hình ảnh của bạn tới một hệ thống tọa độ mà bạn cần cho một phiên làm việc hiện thời .


Nhấn nút [image: image140.png]


 , pick một điểm trong hình ảnh, những tọa độ của điểm này sẽ xuất hiện trong trường Source.


Nhập toạ độ thực ( đã biết) của điểm này trong hộp Destination.


Thay đổi một điểm điều khiển, bạn cần phải lựa chọn nó trong bảng và nhấn [image: image141.png]


; sau đố chỉ rõ một vị trí mới trong hình ảnh.


Để xóa một điểm nhấn nút [image: image142.png]



Các nút hội thoại:



Nút Apply: áp dụng thiết đặt hiện thời của hệ thống tọa độ tới tài liệu, nhưng hội thoại chưa đóng ( nhấn Ok cũng như thế nhưng hộp thoại đóng).

Để khởi động lệnh : Kích nút [image: image143.png]


 trên thanh công cụ Settings.

hoặc Từ thực đơn những Tools, chọn Coordinate System.
x-Cửa sổ Đo (Measure)


Cửa sổ này chứa đựng những lệnh để đo những khoảng cách, góc và những hình vuông trên màn ảnh, cũng như tính toán toàn bộ giá trị một nhóm của những đối tượng như toàn bộ độ dài diện tích, chu vi. Những kết quả trong cửa sổ đo đạc có thể được biên tập, và sau đó ghi ra file văn bản.


Những tùy chọn :


[image: image144.png]


 đo đạc khoảng cách giữa hai điểm rõ chỉ trên màn ảnh.


[image: image145.png]


 Đo một góc giữa hai line trên màn ảnh.


[image: image146.png]


 Trình bày những đặc trưng của cung: length, đường cong, khu vực, vân vân. 



Center 167.00, -310.00 mm



Radius 76.69 mm



Sector 180.0 °



Length 240.94 mm



Buldge 1.00 mm

[image: image147.png]


 Đo độ dài của một polyline, gồm có những đoạn và những cung.


[image: image148.png]


 Đo vùng và chu vi của hình gửi kèm theo bên trong một polyline.


[image: image149.png]


 Nhấn nút này với một hoặc nhiều đối tượng lựa chọn, bạn sẽ có chuỗi Multiple selection, số của những đối tượng trong sự chọn lọc, vùng và chu vi toàn bộ của chúng Nếu chỉ một đối tượng được lựa chọn, thì nút này làm việc như một trong nút số tương ứng trước đây.


[image: image150.png]


 Nếu nút này được nhấn , thì tọa độ của những điểm được thêm tới phép đo.


[image: image151.png]


 Làm sạch cửa sổ nghi thức phép đo (nội dung trước đây được loại bỏ).


[image: image152.png]


 Lưu nghi thức cho file với mở rộng *. TXT.


[image: image153.png]


 In nghi thức.

Để đo một đối tượng bằng cách chỉ rõ nó trên màn ảnh :


1. Bật hiển thị cửa sổ Measure. Lần đầu cửa sổ mở là cố định ( Về sau bạn có thể di chuyển nó như một cửa sổ và); nó chứa đựng một tập hợp những nút và cửa sổ nghi thức phép đo.


2. Mở hội thoại Measure và chọn kiểu đo lường thích hợp ( Một trong số sáu nút phải); bạn có thể sử dụng nút, mà thêm những tọa độ của những điểm vào những kết quả phép đo).


3. Di chuyển tới cửa sổ tài liệu và bởi điểm với chuột vẽ một đ​ờng viền đo lường qua một đối tượng chính xác. Nó được vẽ với " đường cao su ". Khi ạo ra một đường viền đo lường sử dụng những thao tác tiêu chuẩn WiseImage để tạo ra những thực thể (ví dụ một polyline có thể chứa đựng các đoạn cung; chúng được vẽ như những cung với việc nhấn SHIFT). Sau khi tạo thành đường viền đo lường biến mất và bạn nhìn thấy những kết quả đo lường trong cửa sổ nghi thức.

Để đo lựa chọn những đối t​ợng :


Sử dụng nút [image: image154.png]


 , bạn có thể đo một nhóm của những đối tượng được chọn. Những dữ liệu đó được trình bày trong trường Inspector tương ứng sẽ thu được trên một đối tượng được chọn. Do vậy nó hợp lý để áp dụng trên một nhóm những đối tượng.


Bạn có thể thay đổi tất cả các kiểu đối tượng WiseImage ( đường, những cung, những vòng tròn, những hình chữ nhật, những Hatch, Polylines), trừ những khối. Những hình ảnh Raster không thể đượcửư dụng để đo.

Nếu trong tập hợp chọn lọc có những đối tượng , mà không thể thay đổi, chúng được lờ đi. 

Quản lý dữ liệu đang tồn tại :


Bạn có thể soạn thảo văn bản của nghi thức. Bởi việc nhấn những nút trong bộ phận của nút trái, (mà) bạn có thể xóa, lưu giữ và in văn bản nghi thức. Cũng có thể sao chép dữ liệu từ cửa sổ đến clipboord với thực đơn nút phải hoặc từ Edit menu.

Để khởi động lệnh :

Từ thực đơn Tools, hãy chọn Measure.hoặc Kích nút [image: image155.png]


 trên thanh công cụ Miscellaneous (Hỗn hợp).

xi-hộp thoại Preferences


Hội thoại này chứa đựng những tham số, ảnh hưởng trên toàn bộ thao tác chương trình, những phần tử lệnh và giao diện của nó. Khi thoát, thay đổi chương trình được lưu giữ. Những tham số được định vị theo những mục, được trình bày như những thư mục, mỗi thư mục có thể chứa đựng những thư mục con. Sau khi được thiết đặt, những tham số có những giá trị mặc định.

Bạn có thể sửa đổi những tham số sử dụng những nút sau :


+Add:  hoạt động, nếu bạn lựa chọn một mục trong thao tác nào mà bạn có thể thực hiện thêm. Cho ví dụ, bạn có thể thêm một khuôn dạng giấy mới.


+Edit :hoạt động nếu bạn chọn một tham số với giá trị có thể biên tập.


+Delete: hoạt động, nếu bạn có thể thịưc hiện thao tác xóa. Cho ví dụ, bạn có thể xóa một khuôn dạng giấy.


+Cursor: Thay đổi sự xuất hiện và kích thước của cursor.


- Crosshair: Thiết đặt kích thước dây tóc của cursor. 


-Pickbox
Kích thước Pickbox.


-color:
màu Cursor.


Bật/tắt đồ hoạ cursors trong hội thoại Command setup


+ Grip
:Thay đổi những sự thiết đặt grip đối tượng.


- Grip size: kích thước grip.


- Grip max objects count :số tối đa của những đối tượng được chọn mà có những grip hiển thị.


-Single object grip color :Màu những grip của một đối tượng đơn được chọn.


-Multiple objects grip color: màu grip của nhiều đối tượng hoặc nhóm những đối tượng được chọn.


-Inactive objects grip color :
Màu grip của một đối tượng lựa chọn không hoạt động. 


- Node edit mode grip color : 
Màu những grip trong kiểu biên tập nút.


- Node edit mode selected grip color:
màu grip chọn lọc trong kiểu chọn lọc Nút.


+ Colors: thiết đặt màu chương trình.


- Raster Selection :Màu của một đối tượng raster được chọn.


- Preview frame: Màu khung một hình ảnh xem trước vùng trong cửa sổ xem trước.


- Background 
: Màu nền cửa sổ chương trình.


- Found raster symbol : Màu của ký hiệu raster tìm thấy khi làm việc với lệnh Tìm kiếm và Thay thế.


- Print Area : màu  khung vùng in.


- Print Grid :Màu khung ( cho biết khuôn dạng giấy )Trong hội thoại In.


- Grid Color: Màu của điểm lưới


+ Preview style: thiể đặt kiểu hiển thị của một hình ảnh đơn sắc trong cửa sổ xem trước. 


+ Scroll setting: Định nghĩa những tham số cuộn tài liệu trong cửa sổ chương trình.


- Scroll step: Một bước của sự chuyển động tài liệu khi sử dụng cuộn.


- Arrow step: bước chuyển động tài liệu (phần trăm của kích thước cửa sổ khi sử dụng những mũi tên bàn phím.)


- Mouse Wheel scale factor : hệ số tỷ lệ khi sử dụng đẩy chuột.


-Drag-and-Drop scroll area : 
Chiều rộng của viewport không nhìn thấy mà những viền sử dụng để cuộn một tầm nhìn hiện thời trong thời gian kéo xử lý.


+ Snap Setting: Định nghĩa những sự thiết đặt Snap.


- Hold Aperture Size: 
Kích thước của khung cursor bên trong kiểu snap.


- Snap Marker size :
kích thước đánh dấu snap.


- Show Tooltips : Bật hiển thị với một tên snap. 


- Vector Marker Color: Màu đánh dấu snap khi snap tới một đối tượng vectơ.


- Raster Marker Color: Màu của đánh dấu snap khi snap tới một đối tượng raster.


++Inspector:
Định nghĩa những sự thiết đặt Inspector.


-Filters Mode:  Định nghĩa kiểu thao tác của lọc thuộc tính
inspector. 


- Properities mode: Bật một kiểu sửa đổi những thuộc tính đối tượng : Trong toàn bộ tài liệu hoặc riêng rẽ cho mỗi lệnh.


- Multiple selection : 
Định nghĩa cách những thuộc tính đối tượng sẽ được trình bày trong inspector và trong thanh công cụ Preferences.


+ Papers: Chứa đựng những khuôn dạng giấy chuẩn. Cho phép sửa đổi khuôn dạng hiện hữu hoặc thêm một một mới. Những khuôn dạng chứa đựng trong mục này ứng dụng tới những lệnh Change Size, Print, New Image. kể cả mỗi khuôn dạng giấy chỉ rõ kích thước khung trong của nó sẽ được sử dụng Khi raster rubbershitting với lệnh 4-point correction. 


+Autocorrect
Thiết đặt lệnh sẽ được thực hiện Khi thực hiện Autocorrection.


+ Raster file formats
: tạo ra một danh sách những khuôn dạng raster áp dụng khi Mở và Lưu giữ;


+Printing Control:
Định nghĩa những sự thiết đặt in.


+DPI
Thiết đặt độ phân giảiraster trong DPI.


+Transparency: Gán giá trị trong suốt cho những hình ảnh đơn sắc, cho ví dụ, Khi  chèn hoặc tạo ra những hình ảnh mới. 


+Multipage Raster Files 
thiết đặt kiểu tài liệu nhiều trang


+New image from selection 
Định nghĩa những thiết đặt cho hình ảnh mới từ lệnh Chọn lọc.


+ Point : Cho phép thay đổi sự xuất hiện của những điểm trong tài liệu và kích thước của những  đánh dấu.


+ Templates usage: 
Quản lý làm việc với những khung mẫu tài liệu và raster.


- For New Documents : Thiết đặt file  khung mẫu  được sử dụng khi tạo ra một tài liệu mới 


- For Opened Rasters 
:thiết đặt file khung mẫu được sử dụng khi mở một raster 


+ Script : Định nghĩa những thiết đặt cho scrip WiseImage.


+ Display View:Điều khiển hiển thị dữ liệu trong cửa sổ chương trình.


- Halftone paiting :Thiết đật hiển thị của hình ảnh raster màu và đơn sắc. 


- Draw Raster Frame: 
Bật/tắt hiển thị khung raster.


+GIS:
Những sự thiết đặt liên quan đến GIS.


- Use world file : Viết những tọa độ raster trong file văn bản đặc biệt (world file) khi lưu giữ. Để làm world file đọc được khi mở raster, tham số này phải được bật


- Use TAF file: Viết những tọa độ raster trong file văn bản đặc biệt ( file TAF) Khi nào lưu giữ. Để làm TAF file đọc được khi mở raster, tham số này phải được bật


+ Conversion Parameters: 
Những tham số chuyển đổi của R2V Và V2R.


- Scale independent: áp dụng sử dụng hợp nhất Những những tham số chuyển đổi R2V tới hình ảnh raster với tỷ lệ lồng vào khác nhau. Những lệnh ảnh hưởng R2V, V2R, sự chọn lọc Raster, sự vạch dấu.


+ Text: 
Những tham số văn bản.


- Text Tab Size: Kích thước Tab Multitext.


+ DWG Export: Xuất khẩu tới những tùy chọn DWG file.


+ Standard directories: Thiết đặt một thư mục tại file khung mẫu công cụ và những khung mẫu OCR được cất giữ.


+ Vector correction edge: Thiết đặt sự xuất hiện mép mà được tạo ra với lệnh Group/Ungroup Edge.


Để khởi động lệnh:  Kích nút [image: image156.png]


 trên thanh công cụ Settings.

hoặc  Từ thực đơn Tools, chọn Preferences.

Chương 7: chọn lọc

i-Thiếp lập chọn lọc


Trong WiseImage bạn có thể lựa chọn những đối tượng và những vùng raster, những vectơ, hoặc toàn bộ hình ảnh.


Một khi những tiết mục này có trạng thái khác nhau và có thể thuộc nhiều lớp, bạn cần thực hiện một thủ tục hợp thành tập hợp chọn lọc để tập hợp cả raster lẫn dữ liệu vectơ và sau đó áp dụng phạm vi rộng những lệnh WiseImage tới nó.


Bạn phải hiểu thủ tục hợp thành là không có những giới hạn trên nội dung của tập hợp chọn lọc. Tập hợp chọn lọc mạnh và thủ tục biên soạn linh hoạt sử dụng kỹ thuật đoán nhận trong hơn 30 phương pháp chọn lọc, cho phép bạn tạo ra một tập hợp chọn lọc phức tạp .


Đối tượng đồ họa lựa chọn được đặt trong tập hợp chọn lọc và chiếu sáng trên về màn ảnh. Các vectơ và những đối tượng raster, hoặc toàn bộ hình ảnh lựa chọn được chiếu sáng với những grip; 

ii-Các phương pháp và nút Chọn lọc


Có hai thanh công cụ mà bạn có thể sử dụng để định nghĩa phương pháp chọn lọc: Select và More Select. Để chọn một phương pháp chọn lọc bạn phải nhấn những nút này trong sự kết hợp thích hợp
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tính từ trái sang phải : 3 kiểu chọn lọc và 7 nút chọn lọc bắt buộc; 5 nút chọn lọc bởi những kiểu đoán nhận đối tượng, trình chọn lọc hình ảnh, Select with Filter, nút polyline Selection,  3 nút  chọn lọc đích( chọn raster, vector, hybrid) , vô hiệu hóa những đối tượng Hybrid và  3 nút kiểu chọn lọc và nút chọn tất cả và bỏ chọn tất cả .
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5 nút đầu tiên: chọn lọc bởi Linefollowing; 5 nút tiếp theo: chọn lọc bởi Floodfilling.


Không có quy tắc chính xác để thiết đặt một tập hợp chọn lọc tương ứng với một thủ tục riêng biệt. Bạn có thể đạt đến kết quả đó bởi việc áp dụng những phương pháp chọn lọc khác nhau. Thông tin trong mục này cung cấp bạn với kỹ thuật chọn lọc chính, vì vậy bạn có thể điều chỉnh những sự kết hợp thích hợp nhất.


Polyline edit tool và nút Disable Hibrid Selection  được mô tả phần sau.

Ví dụ về sự chọn lựa
 


Để làm quen những sự chọn lọc trong WiseImage, cho ví dụ của một tài liệu chứa đựng hai raster và hai đối tượng vectơ : circle và line
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                Raster thứ nhất            đối tượng vector              raster thứ hai

Kích những nút sau để thiết đặt một phương pháp chọn lọc:

[image: image160.png]@



 nút chọn tự động - thiết lập kiểu chọn lọc đa năng.
      [image: image161.png]


 chọn lọc Hybrid : Thiết đặt chọn lọc đích (selection target), những loại đối tượng mà hầu như được hỗ trợ để được lựa chọn.

      [image: image162.png]


  Nút chọn lọc đơn: thiết đặt kiểu tổng hợp. Thủ tục chọn lọc chấm dứt khi sự chọn lọc đầu tiên được làm. Sự chọn lọc mới hủy bỏ sự chọn lọc trước đó.


Bạn sẵn sàng để làm một sự chọn lọc. Vẽ một hình chữ nhật rubber (cao su)  bao quanh những đối tượng vectơ lẫn những vùng nằm cả hai raster. Hình sau cho thấy kết quả.
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Tập hợp chọn lọc chứa đựng dữ liệu vectơ được chiếu sáng với những đoạn grip và mảnh raster từ cả hai hình ảnh  - chúng được chiếu sáng màu và đường nét đứt.


Bây giờ bạn có thể áp dụng những lệnh WiseImage tới tập hợp chọn lọc.


Chú giải :


1. Thủ tục chọn lọc sử dụng trong ví dụ trên được áp dụng tới tất cả các lớp có thể lựa chọn và rõ ràng.  Nếu bạn muốn giữ gìn dữ liệu trên lớp khác từ sự chọn lọc, hãy tắt tính nhìn thấy hoặc những thuộc tính có thể lựa chọn của lớp đó.


2. Ba nút [image: image164.png]
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, và [image: image166.png]


  định nghĩa một phương pháp chọn lọc tổng hợp.  Đây không phải là phương pháp chính và không phải là phương pháp chọn lọc duy nhất trong WiseImage. 

3. Hybrid selection là một sự chọn lọc bao gồm  cả vectơ lẫn dữ liệu raster. 

Để lựa chọn chỉ dữ liệu Raster trong ví dụ trên, bạn phải sử dụng nút chọn lọc Raster thay vì sự chọn lọc Hybrid khi định nghĩa một phương pháp chọn lọc tổng hợp
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Kết quả sự chọn lọc khi nhấn nút [image: image168.png]


, 
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, và [image: image170.png]




Để lựa chọn chỉ dữ liệu vectơ trong ví dụ trên, bạn phải sử dụng nút chọn Vectơ thay vì sự chọn lọc Hybrid khi định nghĩa một phương pháp chọn lọc tổng hợp.
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Kết quả chọn lọc khi nhấn nút [image: image172.png]
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, và [image: image174.png]



iii-Thủ tục tạo thiết đặt Chọn lựa 


Những thao tác WiseImage được sử dụng để xử lý dữ liệu, được định vị trên những lớp rõ ràng và không bị khóa, có thể được áp dụng tới những tập hợp chọn lọc bao gồm những loại dữ liệu sau.


1. Đối tượng vectơ .


2. Những hình ảnh Raster.


3. Một hoặc vài vùng raster lựa chọn từ nhiều hình ảnh raster.


4. Đối tượng Raster.


Tạo một tập hợp chọn lọc gồm nhiều bước. Một bước chọn lọc là một thao tác chọn lọc đơn sử dụng một trong những phương pháp chọn lọc. Để chỉ rõ phương pháp nào bạn phải chọn, làm sao một sự chọn lọc được thực hiện và làm sao những giải thuật đoán nhận sẽ làm việc bằng cách nhấn những nút thích hợp trên thanh công cụ Select More Select . Trong ví dụ trên tập hợp chọn lọc bao gồm một bước và phương pháp được chỉ định bởi việc nhấn ba nút.

1-Chọn lựa đối tượng Vectơ


Lựa chọn một đối tượng vectơ, bạn phải nhấn nút [image: image175.png]s



 và kích vào viền đối tượng. Những  grip sẽ cho thấy đối tượng đã được lựa chọn.

2-Chọn lựa toàn bộ hình ảnh

WiseImage cho biết một hình ảnh với một khung khi bạn mở nó. Khung và những  grip này cho phép bạn di chuyển, tỷ lệ và quay hình ảnh như cách xử lý một đối tượng vectơ, viền này cũng trực quan cho biết những giới hạn hình ảnh.


Trong kiểu chọn lọc Vectơ ( nút [image: image176.png]s



 ) bạn có thể lựa chọn một hình ảnh bằng cách pick viền của nó. 


Viền là một đối tượng đặc biệt được tạo ra bởi WiseImage để dễ dàng thao tác cho hình ảnh; nó được tạo ra khi mở nhưng không lưu hình ảnh trong file.


Nếu muốn chọn nhiều hình ảnh khác nhau, sử dụng hộp thọai Image Selector
3-Lựa chọn một hình ảnh raster


1.Bật kiểu chọn lọc Vectơ.


2.  Kích vào viền hình ảnh. Những grip sẽ hiển thị 


Nếu bạn lựa chọn một hình ảnh trọn vẹn trong kiểu chọn lọc Raster, thì tất cả nội dung của nó sẽ được chiếu sáng với viền màu và có nét đứt. Với nhiều thao tác cả hai phương pháp bằng nhau, tuy nhiên nó khuyến cáo cho một người mới bắt đầu sử dụng phương pháp mô tả đầu tiên. 


Việc lựa chọn một vùng trên tài liệu trong kiểu chọn Vectơ sẽ lựa chọn những đối tượng vectơ, nhưng không phải là những hình ảnh được vây quanh bởi sự chọn lọc.

4-Lựa chọn vài hình ảnh raster


Mở hội thoại chọn lọc hình ảnh, nhấn nút [image: image177.png]


.
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Di chuyển con chuột trên màn ảnh, hãy kích vào những hình ảnh sẽ được đưa vào trong tập hợp chọn lọc. bạn có thể bật tắt hộp kiểm trong hội thoại . Trường name image chứa đựng tên của hình ảnh ( Hoặc tự động nhận dạng nếu hình ảnh được tạo ra bởi WiseImage) và layer cho biết lớp nào chứa hình ảnh .

5- Chọn lựa những đối tượng Raster


 Để làm cho sự chọn lọc Raster là những công cụ họat động, kích nút [image: image179.png]


 trên thanh công cụ Select.


Có hai loại dữ liệu raster mà WiseImage có thể lựa chọn.


Trước hết, bạn có thể lựa chọn những đối tượng raster - những tập hợp của những dots raster mà trông như những đối tượng vectơ tiêu biểu như line circles, arcs, hatches, symbols và text. Công nghệ nhận thức đối tượng cho sự chọn lọc đối tượng raster thực hiện trong chương trình cho phép sự biên tập một hình ảnh raster sử dụng những phương pháp tương tự như những phương pháp được sử dụng để điều khiển những đối tượng vectơ trong những ứng dụng xử lý vectơ bản vẽ. 

Thứ hai là lựa chọn những vùng trên những hình ảnh.

6-Lựa chọn một hoặc vài vùng trên những hình ảnh raster 


1. Làm cho những hình ảnh sẽ chọn trở nên rõ ràng (thấy được).


2.
Bật kiểu chọn lọc Raster  [image: image180.png]


 , và lựa chọn một phương pháp tạo ra tập hợp chọn lọc : Bằng cách thêm  [image: image181.png]


 hoặc  [image: image182.png]


 đơn.


3.
Nếu bạn muốn lựa chọn một vùng hình chữ nhật, hãy đặt kiểu indow selection, nhấn  nút [image: image183.png]


.  Nếu bạn muốn lựa chọn một vùng đa giác, hãy đặt kiểu chọn lọc Polygon, nhấn  nút [image: image184.png]


.


4.
Lựa chọn vùng.


5.
Trong kiểu adding  [image: image185.png]


  có thể lặp lại bước 4 cho đến khi bạn chọn tất cả các vùng bạn cần. Bạn có thể thay đổi những kiểu sự chọn lọc từ Windown đến polygon và thay bất kỳ bước nào của sự chọn lọc.

7-Tạo những kiểu thiết đặt chọn lọc 


Có ba kiểu  tạo ra một tập hợp chọn lọc : Add, Remove và Single
+Single:xe "Single mode of selection"

Việc lựa chọn dữ liệu trong kiểu đơn hủy bỏ lựa chọn tất cả dữ liệu được chọn trước đó trong hình ảnh hiện thời. Khi kiểu đơn bật, sự chọn lọc thiết đặt trong tài liệu hiện thời gồm có dữ liệu lựa chọn trong thời gian gần đây nhất hoặc không có gì.


Để bật kiểu đơn kích nút [image: image186.png]


 trên thanh công cụ chọn lọc Raster. Với việc nhấn nút SHIFT  , kiểu đơn trở thành kiểu Add.



+Add:


Dữ liệu Raster lựa chọn trong kiểu này được thêm vào tập hợp chọn lọc hiện thời. Để bật kiểu thêm, kích nút  [image: image187.png]


 trên thanh công cụ chọn lọc. Trong kiểu thêm, sự hợp thành tập hợp chọn lọc có thể gồm có vài bước, mỗi bước là một thao tác chọn lọc đơn. Trên mỗi bước bạn có thể thay đổi những phương pháp chọn lọc. Với việc nhấn nút SHIFT, kiểu  thêm trở thành kiểu loại bỏ (Remove mode).



+Remove:


Sử dụng kiểu này để loại bỏ lựa chọn dữ liệu từ tập hợp chọn lọc. Để bật kiểu loại bỏ, kích nút  [image: image188.png]


 trên thanh công cụ chọn lọc Raster. Với việc nhấn SHIFT, kiểu loại bỏ) trở thành kiểu thêm (Add mode).



Thông thường trước hết bạn lựa chọn một đối tượng đơn, và thêm nhiều đối tượng nào đó vào tập hợp chọn lọc, và sau loại bỏ một ít dữ liệu được chọn trước đó từ sự chọn lọc. Dữ liệu có thể được loại bỏ từ tập hợp chọn lọc sử dụng cùng phương pháp như khi lựa chọn nó. Khi dữ liệu được loại bỏ từ tập hợp chọn lọc, nó không còn được chiếu sáng.

8-Lựa chọn / bỏ lựa chọn tất cả

 
Hai thao tác tiện lợi và linh hoạt trong sử dụng chọn lọc là: lựa chọn mọi thứ và bỏ chọn lọc tất cả. Cả hai thao tác được đại diện bởi những lệnh trong Edit menu và những nút trên thanh công cụ : [image: image189.png]


  [image: image190.png]


.


Trong kiểu chọn lọc Vectơ,  nhấn nút lựa chọn tất cả là chọn tất cả đối tượng Vectơ , Không phải là chọn những hình ảnh.


Trong kiểu chọn lọc Hybrid, nhấn lựa chọn Select All,  tất cả các đối tượng vectơ và raster được lựa chọn, nhưng viền hình ảnh thì không. Hybrid và những kiểu khác của sự chọn lọc cũng bị ảnh hưởng bỡi bật/tắt Disable Hybrid Objects
9-Chọn lọc đích 


Sau khi định nghĩa những nút, loại dữ liệu nào được hỗ trợ sẽ được thêm tới một sự chọn lọc :

[image: image191.png]


 chọn lọc đối tượng Vectơ : duy nhất Vectơ được đưa vào trong sự chọn lọc


[image: image192.png]


 chọn lọc Raster  - Chỉ những đối t​ợng Raster được đưa vào trong sự chọn lọc
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 chọn lọc Hybrid - Những đối tượng của cả hai kiểu được đưa vào trong sự chọn lọc


10-Những kiểu Chọn lọc


Bạn có thể sử dụng những kiểu chọn lọc: Auto, Window, Polygon và Image selection. 

[image: image194.png]


  Auto - WiseImage hiểu những hoạt động chuột và lựa chọn đối tượng vectơ Lệnh Edit > Select Auto



[image: image195.png]


 Cửa sổ - sự chọn lọc được làm trong vùng hình chữ nhật.
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 Hình nhiều cạnh - sự chọn lọc được làm trong vùng hình nhiều cạnh.


iv-Những kiểu chọn lọc


Những kiểu chọn lọc là những giải thuật được sử dụng trong thủ tục chọn lọc.

Những phương pháp chọn lọc đối tượng raster dựa vào những  thuật tóan phân tích những đối tượng raster. Đối tượng raster có thể được giải thích trong những cách khác nhau :


- isolated raster object  - vùng raster ( tập hợp những dots raster kề nhau);


- raster polyline segment  - một bộ phận của line raster giới hạn bởi endpoints hoặc những sự giao nhau với những đối tượng khác;


- raster entityxe "Raster entity:selection"  - một raster tương tự của thực thể vectơ : line, arc, và circle raster.


Đa số các phương pháp chọn lọc có thể quản lý tất cả các kiểu đối tượng raster. Khi sử dụng những phương pháp đó bạn cần chỉ rõ kiểu đối tượng raster sẽ được xử lý. Kiểu chọn lọc hiện thời xác định nó. Có ba kiểu chọn lọc raster:


Kiểu chọn lọc
                                             Kiểu đối tượng Raster



Floodfilling
                                             Cô lập vùng trên raster



Line Following
                                 đoạn raster polyline



Object Type Recognition                            những thực thể raster


1-Lựa chọn đối tượng Raster bằng cách pick chuột


Phương pháp Object Type Recognition hoặc Object lựa chọn những đối tượng raster bằng pick chuột, khi lựa chọn bởi việc pick bạn chỉ rõ một điểm trên hình ảnh, và chương trình lựa chọn một đối tượng raster. 


Phương pháp Object là một một phương pháp cơ bản cho tất cả các chọn lọc đối tượng khác. Hơn nữa bạn sẽ thấy tất cả các phương pháp đó có thể được đại diện như một sự kết hợp của phương pháp chọn lọc chuẩn và phương pháp Object. 
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Hình này minh họa kết quả của sự chọn lọc bởi việc pick

 với sự sử dụng nhiều kiểu chọn lọc. những đối tượng Raster lựa 

chọn được thấy như những outlines. Một trong ba trường hợp này

pick point được định nghĩa trong trung tâm của line raster nằm

ngang      

[image: image571.png]


                                                                                          .                    Pick point


2-Chọn đối tượng raster độc lập 


Pick trên raster kiểu Floodfilling lựa chọn raster độc lập. Chương trình lựa chọn tất cả raster những dots kề nhau với điểm chỉ định 


Phương pháp này cũng được xem xét như chọn lựa bắt buột (forced) từ kiểu chọn lựa đối tượng được xác định trước. Xem phương pháp chọn lưạ bắt buộc khác ở bên dưới trong chư​ơng này.


Một tập hợp dots raster kề nhau được bao vây bởi những dots nền làm cho nó tách ra khỏi những đối tượng khác trong hình ảnh là một đối tượng raster độc lập.

Trong trường hợp này toàn bộ đối tượng được lựa chọn. Phương pháp này tiện lợi khi lựa chọn  những đối tượng độc lập dạng đặc biệt : characters, symbols vân vân.


+Để lựa chọn một vùng trên raster

1. Kích nút [image: image197.png]


  trên thanh công cụ Select để sử dụng công cụ chọn raster
2. Kích [image: image198.png]


 sau đó kích chọn vùng trên màn ảnh raster.


+ lựa chọn đoạn Raster Polyline 


Việc pick trên raster của đối tượng kiểu đường gọi là một đoạn raster polyline (những tập hợp dots mà trông như line hoặc arc có chiều rộng xấp xỉ không thay đổi, với chiều dài lớn nhiều hơn chiều rộng nó). Chiều dài của một đối tượng raster là độ dài  centerline của nó. Một hình dạng line raster riêng biệt. 


 Sau khi pick, sự chọn lọc trải dài dọc theo line raster từ điểm xác định đến một nút của line raster. Một nút của line raster, hoặc một điểm giao nhau với raster khác cũng là endpoint . Như vậy, sử dụng phương pháp này, bạn có thể lựa chọn một bộ phận của một line raster đặc biệt tiếp giáp bởi hai nút của line raster 


Để phân biệt line raster với những đối tượng raster khác, chương trình chấp nhận sử dụng giá trị tối đa chiều rộng line raster. Những đối tượng có chiều rộng lớn hơn thì chưa được đoán nhận như những line raster. Một line raster có thể có những sự đứt gãy mà không cần được xem như endpoints. Bạn có thể định nghĩa giá trị tối đa lờ đi sự đứt gãy (khoảng gián đoạn- bước nhảy). (xem thêm phần sau)


Lựa chọn những thực thể Raster 


Thực thể Raster theo khuôn dạng những đối tượng Raster dựa trên cơ sở như những đối tượng vectơ  - những thực thể hình ảnh vectơ. Từ đó chúng ta sẽ sử dụng những thuật ngữ raster circle, raster arc, and raster line để hiểu gián tiếp đối tượng raster mà có một hình dạng của vòng tròn, cung, hoặc đường. Tuy nhiên, bạn cần phải chú ý rằng những thực thể raster thực tế có thể có những khuyết tật hạn chế sự nhận ra của chúng bởi chương trình như những sự gãy đứt, những cung và những vòng tròn hình bầu dục, chiều rộng thay đổi , vân vân.

 
Nếu sự chọn lọc Type Recognition được thiết lập, thì phương pháp Object có thể điều khiển cả những line raster lẫn những đối tượng raster riêng biệt mà có chiều rộng xấp xỉ và độ dài bằng nhau.


 Khi pick một line raster, chương trình xác định kiểu một thực thể raster ( đường, cung hoặc vòng tròn) và sau đó cố gắng lựa chọn đối tượng có kích thước tối đa thích hợp. Nó lờ đi những điểm giao nhau với những đối tượng khác, và chọn lọc mở rộng cho đến khi ký hiệu của đối tượng được chọn trở thành giống với thực thể đoán nhận. Khi những đối tượng raster thực tế có thể khác với những thực thể raster lý tưởng, thuật toán đoán nhận sử dụng tham số Approximation Accuracy (gần đúng). Tham số này định nghĩa mức được công nhận để  những đối t​ợng raster thực tế có thể khác một raster lý tưởng. 


Việc lựa chọn một thực thể raster duy trì những sự giao nhau của nó với những đối tượng khác. Bởi vậy, làm thay đổi và xóa dữ liệu raster được lựa chọn khi Object Type Recognition  đã mở, đối tượng raster còn lại không bị gãy đứt . Điều này cho phép bạn xử lý dữ liệu raster như xử lý những đối tượng vectơ. Cho ví dụ, việc xóa một line raster cắt chéo qua vòng tròn để lại vòng tròn nguyên vẹn , chính xác như​ khi bạn xóa một line vectơ cắt chéo qua một vòng tròn vectơ.


Trong trường hợp đối tượng raster lựa chọn không phải là một line raster, chương trình phát hiện ra ranh giới của nó và lựa chọn đối tượng. Một chiều rộng chuyên biệt đối tượng raster  cho phép cần phải lớn hơn chiều rộng tối đa của một line raster.


Xem thêm phần“ Điều chỉnh chọn lựa ”đã nêu ở các phần trước.
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 Nếu việc lựa chọn bằng cách pick với sự đoán

 nhận đối tượng đã mở, thì chương trình lựa chọn toàn 

bộ line raster như  những hình bên. Khi lựa chọn,

 những sự giao nhau của line được chọn  với những 

đối tượng raster khác thì chưa được loại bỏ.



+Để lựa chọn một thực thể raster:



1. Kích nút [image: image199.png]


 trên thanh công cụ. 


2. Kích một điểm trên hình ảnh raster.


3-Chọn lựa bắt buộc 


Có 5 nút định nghĩa những phương pháp chọn lựa bắt buột : Line, Circle, Arc, Floodfill, và Symbol..



Phương pháp Linexe "Line:recognition", Arc và Circlexe "Circle:recognition"  lựa chọn những thực thể raster của một kiểu xác định. Những phương pháp chọn lọc này yêu cầu vẽ một rubberline của một kiểu thích hợp qua một đối tượng raster lựa chọn. Chương trình lựa chọn một đối tượng raster xác định nếu nó được thừa nhận như một thực thể raster  của một kiểu xác định .


Những phương pháp này làm việc giống như phương pháp Object ( trong kiểu đoán nhận thực thể). Thay đổi và xóa những thực thể raster lựa chọn với những phương pháp này không làm gãy những đối tượng raster nơi chúng cắt chéo qua,  những sự giao nhau được duy trì. 


Sự chọn lựa bắt buột buộc cũng bị ảnh hưởng bởi kiểu Auto Extend Vectors   trong Tab Trace tab  của hội thoại Conversion Options 

Không giống như phương pháp đối tượng, Line, Arc, và Circle cho phép bạn lựa chọn một bộ phận thực thể của một raster như những thực thể bị biến dạng đáng kể. Hơn nữa, những phương pháp này chỉ lựa chọn những line raster.


Trong khi lựa chọn với phương pháp line hoặc arc,  điểm mút ( một hoặc cả hai) của rubberlines hoặc rubberarcs có thể pick bên ngoài những đối tượng raster lựa chọn  (Trên phần mở rộng của chúng). Trong trường hợp này đối tượng raster được lựa chọn trên  endpoints của nó.  Nếu điểm mút rubberline  một đối tượng raster, thì chương trình lựa chọn bộ phận của đối tượng raster bên dưới rubberline tham chiếu


Để lựa chọn một thực thể raster bên dưới rubberline tham chiếu:


-Từ thanh công cụ, chọn Raster Select , kích nút thích hợp với sự tham chiếu rubberline: [image: image200.png]A®Q



 :


line: chỉ rõ endpoints của rubberline. Chúng có thể trên một line raster hoặc trên phần mở rộng của nó.


Arc: Chỉ rõ ba điểm của rubberarc. Những endpoint có thể cũng trên cung hoặc trên phần mở rộng của nó.


Circle:  chỉ định hai điểm đối diện của một rubbercircle qua một vòng tròn raster.

rubberline tham chiếu được loại bỏ, và dữ liệu raster bên dưới được lựa chọn.

4-Chọn ký hiệu raster


Phương pháp chọn ký hiệu cho phép lựa chọn bởi việc pick những đối tượng raster xác định sẵn trong những khung mẫu. 


Thủ tục định nghĩa  ký hiệu mẫu được mô tả  trong “ Thiết lập những tùy chọn đoán nhận ký hiệu ” trong phần sau.

Để lựa chọn một ký hiệu raster 


1. Kích nút [image: image201.png]


 trên thanh công cụ Select Raster  . 


2. Chỉ một điểm trong ký hiệu raster.  

                [image: image202.png]
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Những hình trên minh họa sự chọn lọc ký hiệu raster. Sử dụng phương pháp này bạn có thể chọn những ký hiệu qui ước bên trong bản Scansơ đồ điện, thủy lực, những bản đồ, và tương tự như những hình ảnh.

5-Chọn lựa với cửa sổ và vùng đa giác


Một trong số cách để lựa chọn những đối tượng raster là bao chúng trong một cửa sổ hoặc hình đa giác. Một cửa sổ chọn lọc được định nghĩa bởi việc pick hai điểm đối diện cữa sổ chữ nhật, và một hình đa giác chọn lọc được định nghĩa bởi pick liên tục các đỉnh .


Những phương pháp này được tách thành hai nhóm. Nhóm đầu tiên bao gồm những phương pháp lựa chọn dữ liệu raster bên trong một vùng xác định loại trừ những đối tượng raster chéo qua ranh giới vùng. Nhóm thứ hai lựa chọn dữ liệu raster bên trong một vùng xác định bao gồm những đối tượng raster chéo qua ranh giới vùng.  Phơng pháp này được gọi là Crossing Window và Crossing Polygon.


 Những phương pháp này là những sự cải những phương pháp standard Window và polygon để lựa chọn tất cả dữ liệu raster bên trong một vùng xác định trên ranh giới của nó.


Công việc của ph​ơng pháp Within Window và Within Polygon có thể hiểu như một sự kết hợp hai phương pháp chọn lọc khác. Trước hết, với phương pháp chuẩn thích hợp ( cửa sổ hoặc giác) tất cả dữ liệu raster bên trong vùng được lựa chọn. Rồi tất cả những đối tượng raster chéo qua bởi ranh giới vùng được lựa chọn bởi phương pháp đối tượng 
Trên Crossing Windowxe "Crossing Window selection"

xe "Selection:Crossing Window" và Crossing Polygonxe "Selection:Crossing Polygon"

xe "Crossing Polygon selection" họat động, dữ liệu lựa chọn ở giai đoạn thứ hai ( những đối tượng chéo qua ranh giới) được thêm tới dữ liệu raster lựa chọn trên giai đoạn đầu tiên.


Kiểu chọn lọc raster hiện thời xác định một kiểu đối tượng raster lựa chọn bởi phương pháp đối tượng,  như vậy ảnh hưởng kiểu trừ  hoặc thêm dữ liệu raster.

	Kiểu
	kiểu chọn
	nút và công cụ

	Within Window
	Object Type Recognition
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 green Raster Select

	
	Floodfilling
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 red Raster Select-2

	
	Line Following
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 blue Raster Select-2

	Crossing Window
	Object Type Recognition
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 green Raster Select

	
	Floodfilling
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 red Raster Select-2

	
	Line Following
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 blue Raster Select-2

	Within Polygon
	Object Type Recognition
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 green Raster Select

	
	Floodfilling
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 red Raster Select-2

	
	Line Following
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 blue Raster Select-2

	Crossing Polygon
	Object Type Recognition
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 green Raster Select

	
	Floodfilling
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 red Raster Select-2

	
	Line Following
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 blue Raster Select-2



Chú ý rằng khi lựa chọn một raster với Crossing Window , phải kích vào hai góc đối diện của một vùng hình chữ nhật. Mỗi lần vùng được định nghĩa, chương trình lựa chọn tất cả dữ liệu raster trọn vẹn bên trong vùng và thêm vào những đối tượng raster chéo qua ranh giới vùng.

6-So sánh phương pháp chọn lọc Within Window 


Trong trong ví dụ này chúng ta sẽ lựa chọn một raster sử dụng phương pháp Within Window  với những kiểu chọn lọc raster khác nhau.


Những hình ở bên dưới cho thấy lựa chọn những đối tượng raster  outlines. Cửa sổ chọn lọc được trình bày hình chữ nhật nét đứt.


Object Type Recognition
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Line Following
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7-Lựa chọn bằng Fence


Lựa chọn với phương pháp fence bạn cần chỉ rõ một tập hợp  những điểm xác định đỉnh của một hình nhiều cạnh hở. Tất cả các đối t​ợng raster chéo qua bởi hình đa giác hở trở thành được chọn. 


Để lựa chọn những đối tượng raster bởi fence: 


1. Kích nút [image: image218.png]


, [image: image219.png]


 hoặc  [image: image220.png]


 trên Thanh công cụ Raster Select hoặc More Raster Select :


Màu xanh lục, để lựa chọn vài thực thể raster ( line, cung hoặc vòng tròn).

Màu xanh,
để lựa chọn vài đoạn raster polylines.

Màu đỏ, để lựa chọn vài đối tượng độc lập


2. Chỉ rõ các đỉnh của một hình nhiều cạnh hở, chéo qua những đối tượng chọn. Nhấn ENTER hoặc nhấn phải để hoàn thành sự chọn lọc.


Hình sau minh họa một ví dụ chọn lọc đối tượng độc lập bởi fence ( nút màu đỏ  trên thanh công cụ More Raster Select ).

              [image: image221.png]


           [image: image222.png]




Hình bên phải cho thấy hình nhiều cạnh hở đã lựa chọn một văn bản. Hình trái cho thấy những đối tượng raster chọn.


Những hình sau minh họa sự khác nhau giữa sự chọn lọc bởi fence với sự đoán nhận những đối tượng raster và chọn lọcđoạn  raster bởi fence. Hình đầu tiên cho thấy một lưới bảng. Chúng ta chéo qua hai đường thẳng đứng bởi fence:

[image: image223.png]





Fence

Trong những hình sau những đối tượng raster chọn được cho biết với những outline. Trong hình đầu tiên có hai hàng thẳng đứng, được chọn trọn vẹn sau khi sử dụng  phương pháp Object type recognition (nút màu xanh lục trên thanh công cụ Raster Select).

[image: image224.png]



Lựa chọn những đường


Trong hình thứ hai có hai đoạn của những đường này, được định vị  trong bảng bỡi hai đường ngang. Trong tr​ờng hợp thứ hai phương pháp Fence với kiểu Line Following  được áp dụng.   






đoạn Polyline 

                         [image: image225.png]



v-công cụ lọc  


Công cụ này cho phép bạn lựa chọn những đối tượng WiseImage bởi kiểu, lớp và màu. Để chạy nó chọn Edit > Select by Filter  hoặc nhấn  nút [image: image226.png]


  trên thanh công cụ Select.
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Những đối tượng, được che giấu bỡi nút  [image: image228.png]


 hoặc [image: image229.png]


 thì không được lựa chọn.


Những mục trong ba danh sách có thể được kết hợp. Bạn có thể chọn những cung màu đỏ trên lớp mặc định hoặc tất cả những đối tượng màu xanh là trên tất cả các lớp hoặc những line trên lớp Mylines, vân vân.


Những mục trong một danh sách không thể được kết hợp. Nếu bạn sử dụng những cái lọc muốn lựa chọn những đối tượng của hai kiểu,  ví dụ tất cả các cung và những vòng tròn xanh trên lớp MyCircles, phải chạy lựa chọn bằng hai lần lọc : đầu tiên lựa chọn tất cả các cung xanh , sau đó trong kiểu thêm, tạo sự chọn lọc ( nhấn [image: image230.png]


) ,  bước hai là chọn tất cả các vòng tròn trên lớp MyCircles.

vi-Điều chỉnh Chọn lọc 


Điều chỉnh chọn lọc được thực hiện trong Tab Options của hộp thoại Conversion Options. Bạn có thể điều khiển những phương pháp chọn lọc đối t​ợng raster, dựa vào Object Recognition và Line Following Sau.


Thiết đặt những tham số chọn lọc raster 


1. Kích nút những tùy chọn chuyển đổi trên thanh công cụ Raster to Vector  ([image: image231.png]


)



2. Chuyển tới tab Options.
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3. Chỉ rõ những tham số mới, rồi kích OK.

1-Những tham số chọn lọc Raster


Có ba tham số  chọn lọc Raster : Max Width, Max Break và Approximation Accuracy.


Max Width: Định nghĩa chiều rộng cực đại của những đối tượng raster mà có thể được lựa chọn với những phương pháp dựa Object Type Recognition và Line Following. Chương trình không lựa chọn những đường với những chiều rộng lớn hơn giá trị xác định. 
Max Break: Định nghĩa độ dài của đoạn gãy lớn nhất sẽ được lờ đi trong một đường raster. Nếu những đoạn gãy của đường raster nhỏ hơn giá trị xác định , khi lựa chọn những đường gãy này không được chọn, và đường sẽ được chọn như một đối tượng raster thống nhất (không phải các đoạn gãy) .

Approximation Accuracy: Khi lựa chọn raster, sử dụng những phương pháp dựa trên cơ sở Object Type Recognition, Approximation Accuracy định nghĩa độ sai lệch được công nhận của những ký hiệu đối tượng raster từ những vectơ nguyên mẫu của nó.  Nếu những line raster nguyên bản bị biến dạng, ví dụ, những vòng tròn raster thành hình bầu dục, thì bạn có thể cải thiện sự chọn lọc chính xác bởi việc di chuyển thanh trượt Approximation Accuracy sang trái ( Low).  Nếu hình ảnh raster nguyên bản có chất lượng tốt, hãy di chuyển sang phải ( Hight).


Sự chọn lọc bắt  buộc cũng bị ảnh hưởng bởi kiểu tùy chọn nút toggle Auto Extend Vectors trong Tab trace của hội thoại Conversion Options 


Bạn có thể đo giá trị Max Width và Max Break  trên một hình ảnh raster.

2-Đo chiều rộng Max trên một hình ảnh


1.Kích nút ở tại Max Width. 

2.Chỉ rõ hai điểm trong hình ảnh raster để đường nối hai điểm này chéo qua phần dày nhất raster .

3-Để đo Max Break  trên một hình ảnh


1.Kích nút ở tại Max Break.


2.Chỉ rõ hai điểm trong raster để đường nối những điểm này chéo qua phần gãylớn nhất của line raster .

Chương 8: biên tập raster


WiseImage hỗ trợ một phạm vi rộng những thao tác thay đổi, biến đổi, biên tập và sửa đổi những hình ảnh.


Những thao tác này có thể tách dữ liệu trên raster ra những nhóm để hiệu chỉnh,  và biên tập.


Phần này mô tả những phương tiện sửa chữa hình ảnh giúp đỡ bạn chuẩn bị hình ảnh cho vectơ, trace và những thủ tục phức tạp hơn 

i-công cụ làm sạch  

1-Crop


sử dụng Crop có thể giảm bớt kích thước hình ảnh. Bạn có thể định nghĩa vùng này bởi việc chỉ rõ một hình chữ nhật trên hình ảnh hoặc bởi việc chỉ rõ một ranh giới cắt xén. Bạn có thể crop một hình ảnh áp dụng một thủ tục tự động tìm thấy hình ảnh lề “rỗng” và crop chúng. 

Thao tác này có thể được áp dụng tới vài hình ảnh raster một lúc.


a- Crop tự động: 


1.Lựa chọn những hình ảnh như trên


2.Chạy thao tác sử dụng một trong những phương pháp sau :

Crop bởi khung:


Nếu hình ảnh có một khung, thì lệnh này tự động thay đổi kích thước tài liệu tới kích thước khung, bỏ qua vết đốm không ý nghĩa và thậm chí đôi khi những đối tượng và những văn bản nhỏ.


Chú ý rằng một khi autocropping bởi khung thì hòan tòan tự động, khung nghiêng và/hoặc những vết đốm quá nhiều trên hình ảnh có thể làm hỏng những kết quả. Nó là một ý tưởng tốt để áp dụng Image > Deskew và / hoặc Filters > Speckle Remover tới hình ảnh trước khi autocropping bởi khung.


Để autocrop hình ảnh bởi khung:


1.Lựa chọn hình ảnh hoặc những hình ảnh sẽ được crop.  Nếu không lựa chọn bất kỳ hình ảnh nào, thì lệnh xử lý tất cả những hình ảnh như trên

2.Chọn Image > Crop > AutoCrop by Frame hoặc ấn [image: image233.png]


 trên  thanh công cụ 


Nếu không có khung, lệnh này làm việc tương tự Crop > Auto.

b-crop bỡi clip:


1.
Lựa chọn những hình ảnh để crop ( thấy được và định vị trên những lớp không bị khóa).  Nếu bạn không lựa chọn bất kỳ hình ảnh nào, thì lệnh này xử lý tất cả những hình ảnh thấy được và định vị trên những lớp không khóa, mà có một ranh giới crop.


2.
Chạy thao tác sử dụng một trong những phương pháp sau :


Chọn Crop > by Clipping từ thực đơn Image hoặc kích nút [image: image234.png]


 trên thanh công cụ Image.


c- Crop bỡi khung



1. Lựa chọn image.  Nếu bạn  không lựa chọn bất kỳ hình ảnh nào, thì lệnh này xử lý tất cả những hình ảnh định vị trên những lớp không có khóa. 


2. Chọn Image > Crop > AutoCrop by Frame hoặc nhấn nút [image: image235.png]


 trên thanh công cụ image. 


d- Crop bỡi hình chữ nhật


1.Lựa chọn những hình ảnh để crop.  Nếu không lựa chọn bất kỳ hình ảnh nào, thì lệnh xử lý tất cả các hình ảnh thấy được trên những lớp không khóa 


2.Chỉ rõ hai góc của vùng hình chữ nhật bằng trỏ chuột.


3.Chạy thao tác sử dụng một trong những phương pháp sau :

Chọn Crop > by Rectangle từ thực đơn image hoặc kích nút [image: image236.png]


 trên  thanh công cụ

2-Thay đổi kích thước và resample


a-Thay đổi kích thước

Thao tác này được sử dụng để thay đổi kích thước một hình ảnh để điều chỉnh kích th​ớc của nó tới những giá trị xác định. Nó có thể cần thiết sau khi deskew hoặc crop hình ảnh, và khi bạn đang có một hình ảnh không đúng tiêu chuẩn kích thước sau khi Scan.  Nếu kích thước hình ảnh mới nhỏ hơn nguyên bản, thì hình ảnh bị crop, nếu lớn hơn, thì những lề được thêm vào hình ảnh. Tất cả các sự thay đổi có thể được quan sát trong cửa sổ xem trước.


Thao tác có thể chỉ được

 áp dụng tới một hình ảnh tại 

một thời điểm. Như vậy nếu 

bạn có nhiều hình ảnh trong 

tài liệu , thì cần phải lựa chọn

 một ảnh để xử lý. 

Để thay đổi kích thước một hình

 ảnh, lựa chọn một hình ảnh và 

khởi động thao tác bởi việc chọn

 lệnh Change Size  từ thực đơn

 image.Hộp thoại xuất hiện :


1.Chọn đơn vị trong Units.


2.Chỉ rõ kích thước hình

ảnh bằng một trong các cách sau : 


- Để chọn một loại giấy

có kích thước gần nhất , nó có

thể lớn hơn hoặc bằng với kích 

thước hình ảnh , nhấn nút

 Find Closest .



-Lựa chọn một trong

 những khuôn dạng chuẩn từ 

danh sách của hộp Standard

 Paper Size . Lựa chọn sự 

định hướng : Landscape hoặc 

Portrait.


Bạn có thể tùy biến danh sách Standard Paper Size trong thư mục Papers của hộp thoại Preferences .


-Thiết lập chiều rộng và chiều cao của hình ảnh trong hộp Image Size .


Nếu bạn có một hình ảnh màu hoặc grayscale, thì màu của những lề thêm vào được chỉ rõ bởi tham Fill Color trong thư mục colors của hộp thoại Preferences .


*Để biết chi tiết hơn về hộp thoại Preference,s xem “ điều chỉnh ứng dụng” các phần sau


3.Bạn có thể canh lề hình ảnh sử dụng một trong những nút trong hộp Alignment/Margins .
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4.Bạn có thể xác định những lề hình ảnh bởi một trong số cách sau :


-Có thể thay đổi kích thước bằng cách tăng hoặc giảm giá trị lề; Để làm điều này, cần phải bỏ chọn hộp kiểm the Fixed Size và sử dụng thích hợp các hộp trong Alignmentxe "Alignment"/Marginsxe "Margins"  , tăng thêm hoặc giảm bớt những kích thước lề trong những ph​ơng hướng mong muốn bởi việc nhập giá trị dương  hoặc âm trong hộp.


-Bạn có thể canh lề cố định kích thước  bởi việc thay đổi những giá trị lề của nó :

Thiết đặt checkbox Fixed Size . Nó làm cho kích thước của hình ảnh là không thay đổi. khi đó thay đổi những giá trị của lề mong muốn bởi việc nhập những giá trị trong hộp thích hợp .


b- Resample



Sử dụng Resampling để thay đổi kích thước một hình ảnh bởi việc sửa đổi độ phân giải hoặc kích thước của nó trong những pixcels. 

Một hình ảnh có thể resampl với ba cách : thay đổi hình ảnh trong những pixcel, thay đổi kích thước hình ảnh thực tế với kích thước cố định trong những pixcels, thay đổi kích thước thực tế mà không cố định kích thước trong những pixcels.


 Nếu bạn sửa đổi độ phân giải hình ảnh mà không thay đổi kích thước thích hợp của nó, hãy chú ý rằng một kích thước file hình ảnh có số lượng pixcels tương ứng trên diện tích tương ứng độ phân giải của nó. Cho ví dụ, một file hình ảnh với 200 điểm trên một Inch là gấp bốn lần kích thước của file mà chứa đựng hình ảnh với cùng kích thước đó với độ phân giải 100.


Thao tác có thể chỉ được áp dụng tới một hình ảnh tại một thời điểm. 


Để resample một hình ảnh:


Lựa chọn một hình ảnh và bắt đầu

 thao tác bởi việc chọn lệnh Resample từ thực

 đơn Image. Hộp thoại xuất hiện :



1. Chọn Fixed size in pixels nếu 

bạn muốn lưu kích thước image nguyên bản,

hoặc :không chọn để sửa đổi kích thước hình 

ảnh bởi việc thêm hoặc xóa những điểm hình

 ảnh.


2.Chọn đơn vị từ danh sách 


3.Nhập chiều rộng hoặc chiều cao cho

ảnh mới (nếu bạn chọn pixcels như những đơn

 vị đo và tùy chọn Fixed Size in Pixels đã 

bật, thì bạn không thể nhập những giá trị này

 vào trong Width và Height).  Nếu bạn vào

 bất kỳ giá trị nào trong một hộp, thì giá trị trong cái hộp khác được thay đổi tự động để lưu tỉ lệ hình ảnh. hoặc : nhập một hệ số tỷ lệ phần trăm đối với kích thước hình ảnh hiện thời trong Scale
 Nếu tùy chọn Fixed Size in Pixels đã bật, thì sự thiết đặt của một kích thước thực tế mới ảnh hưởng giá trị độ phân giải. Kích thước hình ảnh pixcels không thay đổi.  Nếu Fixed Size in Pixels tắt, thì sự thiết đặt của một kích thước thực tế mới ảnh hưởng kích thước trong pixcels. DDooj phân giải hình ảnh không thay đổi.


4.Bạn có thể thay đổi độ phân giải hình ảnh bởi việc nhập một giá trị mong muốn ( DPI) trong Resolution.


Nếu tùy chọn Fixed Size in Pixels đã bật, thì kích thước thực tế được thay đổi và kích thước những điểm còn lại vẫn như cũ.


Nếu Fixed Size in Pixels  tắt, kích thước thực tế không đổi và kích thước trong những điểm được thay đổi. 

5.Kích OK.

3-xóa vết lốm đốm


Speckle Remover di chuyển những đối tượng raster ( cô lập những nhóm điểm) mà nhỏ hơn những cái có giá trị xác định. Bộ lọc này có thể tự động xác định kích thước vết đốm trong hình ảnh.


Bộ lọc có thể được sử dụng sau những thủ tục như binarization và Layer để loại bỏ những đối tượng kích thước nhỏ hơn trong những lớp của những hình ảnh đơn sắc.
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            Trước khi loại bỏ vét đốm
                                           Sau làm lốm đốm loại bỏ



Để loại bỏ vết lốm đốm raster:


1. Định nghĩa tập hợp chọn lọc bạn muốn xử lý và chọn Speckle Remover từ thực đơn Filters hoặc nhấn  nút [image: image240.png]


  trên thanh công cụ Filters .
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2.Chỉ rõ kích thước cực đại của những đối tượng raster sẽ được loại bỏ trong đơn vị hiện thời ( hộp trái) hoặc trong dots ( hộp phải). hoặc :


Thiết đặt tùy chọn Auto Estimating để bộ lọc tự động ước lượng kích cỡ vết đốm raster trước khi cách lọc.


Nút [image: image242.png]


 để đo kích thước đối tượng raster trên màn ảnh , hãy kích vào điểm bên trong đối tượng.
 hoặc:


Kích nút [image: image243.png]


 và pick hai điểm trên màn ảnh. Chương trình sẽ ước lượng kích thước vết lốm đốm bằng khoảng cách giữa những điểm này.



3.Chọn Apply

4-Tách hình ảnh


a-Tách hình ảnh bỡi kích thước đối tượng


Khi thủ tục này chạy, chương trình tìm kiếm trong mỗi hình ảnh được chọn cho những đối tượng ( cô lập những nhóm của những dot hình ảnh) với kích thước trong một phạm vi xác định  và di chuyển những vùng tìm thấy cho một hình ảnh raster mới. Hình ảnh được tạo ra với kết quả thao tác này có cùng tham số ( kích thước, điểm chèn, độ phân giải, tỷ lệ) trong hình ảnh nguyên bản nhưng nó được đặt lên một lớp được chỉ rõ bởi người dùng. Hình ảnh này chỉ chứa đựng những đối tượng của giá trị chỉ rõ .


Thao tác này cho phép phân ra những đối tượng raster có giá trị khác nhau vào trong những lớp raster khác nhau. Nó có thể được sử dụng thay thế bộ lọc vết đốm . Không có sự mất mát những đối tượng hình ảnh, chúng chỉ di chuyển tới một lớp raster riêng biệt, và bạn có thể luôn luôn điều khiển thao tác thực hiện.  Nếu bạn không cần những đối tượng và loại bỏ chúng khỏi hình ảnh nguyên bản, thì bạn có thể xóa bỏ toàn bộ lớp raster đang tồn tại. Nếu bất kỳ những đối tượng quan trọng nào được chuyển tới lớp này, thì bạn có thể lựa chọn chúng và chuyển chúng tới hình ảnh nguyên bản, và loại bỏ một lớp raster không cần thiết.


Để phân ra những đối tượng raster bởi kích thước: 

1. Định nghĩa tập hợp chọn lọc bạn muốn xử lý và chọn Separation by Size từ thực đơn Image hoặc nhấn nút [image: image244.png]


 trên thanh công cụ Tools.
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2.Chỉ rõ kích thước đối tượng cực đại và cực tiểu trong Min và Max tương ứng.


 Để đo một đối tượng raster trên hình ảnh, hãy kích nút [image: image246.png]


 và trỏ vào đối tượng. Giá trị chính xác được trình bày trong cái hộp tương ứng.


3.Nhập tên lớp trong Output layer, nơi tạo ra hình ảnh giả thiết sẽ được đặt.


4.Chỉ rõ màu của lớp. Kích mẫu màu trong Output Layer và lựa chọn màu từ hộp thoại. Kích Apply


b- Tách hình ảnh bỡi những đối tượng tuyến tính riêng biệt


1. Khởi động lệnh từ thực đơn Image > Separate Linear Objects hoặc Kích nút thích hợp thanh công cụ image.


2. Chỉ rõ sự chiều rộng cực đại và khỏang cách chỗ trống. 


3. Vào một tên lớp, Lớp này là nơi đặt hình ảnh tạo ra.


4. Chỉ rõ màu lớp raster. 


5. Kích Apply


Thao tác này cho phép phân ra những đối tượng raster của nhiều giá trị vào trong những lớp raster khác nhau. Nó có thể được sử dụng thay vì ửư dụng bộ lọc lốm đốm. Không có đối tượng hình ảnh nào bị mất, chúng chỉ di chuyển tới một lớp raster riêng biệt, và bạn có thể luôn luôn điều khiển sự thực hiện thao tác. Nếu bạn không cần những đối tượng, phải loại bỏ từ hình ảnh nguyên bản, thì bạn có thể xóa bỏ toàn bộ lớp raster đang tồn tại.  Nếu bất kỳ những đối tượng quan trọng nào được chuyển tới lớp này, thì bạn có thể lựa chọn chúng và chuyển chúngửtở lại tới hình ảnh nguyên bản, và loại bỏ một lớp raster không cần thiết.


Hình ảnh được tạo ra có cùng tham số ( kích thước, điểm lồng vào, độ phân giải, và tỷ lệ) với hình ảnh nguyên bản nhưng nó được đặt lên một lớp chỉ định.


c- Tách hình ảnh bỡi những vùng text


1. Khởi động lệnh từ thực đơn Image >Separate Text Areas. hoặc thanh công cụ.


2. Chỉ rõ chiều cao và chiều rộng cực đại văn bản.


3. Thiết lập những đặc tính phương hướng ‘Text Orientation’, ‘Overlapped Text’, và ‘Single Letters’ để cải thiện chất lượng đoán nhận Văn bản. Để đo một đối tượng raster trên  hình ảnh , kích nút đo chỉ vào đối tượng.


 3. Vào một tên lớp


4. Chỉ rõ một màu của lớp 


5. Kích Apply


d-Tách hình ảnh bỡi Hatch


1. Khởi động lệnh từ thực đơn Image > Separate Hatches hoặc thanh công cụ.


2. Chỉ rõ chiều rộng cực đại và khỏang trống.


3. Chỉ rõ Hatch Angle để cải thiện chất lượng đoán nhận 


4. Vào một tên lớp 


5. Chỉ rõ một màu 

6. Kích Apply

5- Deskew (chỉnh nghiêng)


Thao tác này cho phép sửa chữa độ nghiêng hình ảnh do scan. Khi deskew, kích thước hình ảnh mới tự động mở rộng phù hợp với hình ảnh deskew.

*
Nếu bạn có một hình ảnh màu hoặc grayscale, màu của những vùng hình ảnh “ rỗng ” được bổ sung chỉ rõ bởi tham số Fill Color trong thư mục colors của hộp thoại Preferences.


Có ba cách deskew một hình ảnh. Bạn có thể định nghĩa một đường hiệu chỉnh bởi việc chỉ rõ hai điểm trong hình ảnh. Hình ảnh có thể chỉnh bởi việc nhập một góc nghiêng trong hộp thích hợp. Đồng thời , bạn có thể áp dụng thủ tục tự động sự tính toán góc nghiêng. 

Thao tác này có thể được áp dụng tới vài hình ảnh một lúc. 

a-Chỉnh những hình ảnh raster bằng tay


1.
Lựa chọn những hình ảnh như trên


2.
Chạy thao tác bởi việc chọn Deskew > Manual từ thực đơn Image.
Hộp thoại hiển thị


3.
Nhập giá trị góc nghiêng trong Angle hoặc kích [image: image247.png]


 và chỉ rõ những điểm bắt đầu và kết thúc để định nghĩa Góc quay 


4.
Kích OK.


b-Chỉnh những hình ảnh raster tự động


1.
Lựa chọn những hình ảnh 


2.
Chạy thao tác bởi việc chọn Deskew > Auto.


Nếu WiseImage có thể ước lượng góc quay, những hình ảnh raster sẽ được chỉnh. Nếu không, hãy sử dụng thủ tục bằng tay.

6- Làm trơn


Cái lọc này làm trơn nét ngoài đối tượng raster, làm đầy những giọt nhỏ bên trong nền, và từng phần loại bỏ những vết lốm đốm raster.

              [image: image248.png]
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         Đoạn hình ảnh Nguyên bản
           Sau khi làm trơn


Cái lọc này xử lý những hình ảnh trong hai bước. Trên bước đầu tiên thao tác ở giữa hình ảnh greyscale được thực hiện.  Bước thứ hai, bộ lọc bật những điểm với giá trị độ chói ít hơn  ngưỡng giá trị màu đen.  Nếu giá trị ngưỡng cửa tăng thêm, thì nó gây ra đối tượng để làm đặc, và nếu giá trị ngưỡng  giảm bớt, nó làm cho đối tượng bị loãng.


Để làm trơn những đối tượng raster:


1. Định nghĩa tập hợp chọn lọc bạn muốn xử lý và chọn Smoothing từ thực đơn Filters hoặc nhấn  nút [image: image250.png]


  trên thanh công cụ  lọc.
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2. Chỉ rõ mức Medianning - lấy trung bình ( phần trăm. )


3.Chỉ rõ ngưỡng (Thresholdxe "Threshold" ) - mức từ 0 đến 255. Giá trị này xác định mức cắt xén của đường ngoài. Khi giá trị này tăng thêm, hiệu ứng làm nhẵn tăng thêm nhưng những đường raster sẽ rộng hơn.

Sử dụng cửa sổ xem trước để điều chỉnh giá trị tối ưu.


4.Kích OK.

7- Sự đảo ngược



Đảo ngược màu của một hình ảnh đơn sắc cho mỗi dots. Những dots nền trở thành là những dots hình ảnh; những dots hình ảnh trở thành là những dots nền. 


Bộ lọc này áp dụng toàn bộ hình ảnh.


Để đảo ngược một hình ảnh, 
Chọn Inversion từ thực đơn Filters  hoặc nhấn [image: image252.png]



8-Hiệu chỉnh 4 điểm


xe "Mirroring:images"

xe "Image:mirroring" Sự sửa chữa bốn điểm là một cách đơn giản để loại trừ những sự biến dạng trong những hình ảnh (chủ yếu những bản vẽ kỹ thuật). Thủ tục này có thể sử dụng để sửa chữa những hình ảnh có khung chữ nhật bị biến dạng thành hình thang hoặc hình bình hành,


Thao tác này có thể được áp dụng tới vài hình ảnh một lúc. Để thực hiện thủ tục này bạn cần phải chỉ rõ kích thước khung mong muốn (Chiều cao và chiều rộng của nó). Để thực hiện sự sửa chữa bốn điểm:


1.
Lựa chọn những hình ảnh để sửa chữa


2.
Chạy thao tác sử dụng một trong những ph​ơng pháp sau :

Chọn 4-point correction  từ thực đơn Image hoặc kích nút [image: image253.png]


  trên thanh công cụ image Hộp thoại hiển thị : 
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3.
Nhấn nút [image: image255.png]


 (nút tìm kiếm khung).  Nếu WiseImage tìm thấy khung bản vẽ, bạn sẽ nhìn thấy một hình polygon màu. Khung được hiển thị trong cửa sổ tài liệu. Nếu không bạn cần phải chỉ rõ bằng thủ công. 


4.
Để chỉ định những góc khung bằng tay bạn cần phải nhấn nút [image: image256.png]


 và kích những góc khung trên hình ảnh. Bạn có thể chỉ rõ điểm trong một thứ tự tùy ý bởi vì chương trình luôn luôn phân loại những điểm này sao cho chúng hình thành khung mà không có những sự giao nhau. Quan sát rubberline để điều khiển, nhấn BACKSPACE để đi tới góc khung trước đó nếu cần thiết.


5.
Nhập kích thước khung mong muốn trong Width và Height.


6.
Lựa chọn Portrait hoặc Landscape.


7.
Kích OK.


Nút [image: image257.png]


 , hộp danh sách Paper size và hộp kiểm Use Internal Page Frame điều khiển kích thước giấy tự động. Với những điều khiển này bạn có thể điều chỉnh hình ảnh tới kích thước giấy tiêu chuẩn.


Paper size chứa đựng định dạng giấy chuẩn.


Use Internal Page Frame  cho phép sử dụng thước khung bản vẽ tương ứng kích mà được cất giữ cho định dạng đặc biệt (internal page frame là tập hợp trong hội thoại Tools > Preferences > Papers > Modify, trong mục Internal Frame). 
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Nếu hộp kiểm Internal Frame chưa được chọn trong hội thoại này, thì hộp kiểm Use Internal Page Frame  trong hội thoại 4-point correction  không sẵn sàng.


Nếu Internal Frame được chọn, thì những sự thiết đặt trong những mục Portrait và Landscape  tự động được phản chiếu trong trường Landscape và Hight của hội thoại 4-point correction.

9-Nắn ảnh(Calibration)

Calibration ( Cũng được hiểu như " Rubbersheet " trong autoCad Map) được thiết kế để loại bỏ sự biến dạng tự do ( cả tuyến tính lẫn không tuyến tính) trong những hình ảnh raster đơn sắc, grayscale, và màu: những tài liệu đồ họa scan , những bản vẽ đo đạc, những bản đồ trong định dạng raster, vân vân.


Bản chính tài liệu phải bao gồm những điểm với những tọa độ đã biết. Trong quá trình scan những điểm này có vị trí bị lệch trong hình ảnh hoặc do sự biến dạng nguyên liệu nguyên bản (co dãn giấy). Bởi việc áp dụng phương pháp này để những tọa độ hiện thời của những điểm sai lệch trùng với những giá trị đúng của nó.


Calibration có thể áp dụng để thiết đặt chọn lọc gồm những mảnh hình ảnh và cũng để clip vùng trên hình ảnh. 

Nếu bạn đã lựa chọn vài hình ảnh, thì lệnh sẽ được áp dụng tới hình ảnh rõ ràng và định vị trên những lớp không khóa.

Nếu bạn không lựa chọn bất kỳ hình ảnh nào, thì lệnh này xử lý tất cả những hình ảnh rõ ràng định vị trên những lớp không khóa. Bạn cần áp dụng thủ tục Calibration trước khi chạy những thủ tục layer và cector. 

a-Những điều kiện:


Những thủ tục Calibration thay đổi hòan tòan một raster image theo một cách thiết đặt điểm đã cho của hình ảnh di chuyển tới thiết đặt khác của những điểm với những tọa độ định nghĩa. Số điểm và vị trí của nó thì tùy ý.

 
Calibration được định nghĩa bởi tập hợp của những cặp điểm định vị (calibration pairs) và phương pháp sử dụng(calibration method used.)

b-Những cặp Calibration


Để thực hiện Calibration, bạn phải chỉ rõ vectơ của những điểm di chuyển . Nghĩa là phải chỉ rõ một tập hợp của những cặp điểm. Mỗi cặp đại diện hai vị trí điểm : vị trí hiện thời trên hình ảnh , và vị trí đến của nó ( điểm thực tế).

c-Phương pháp Calibration


Một phương pháp Calibration là một hàm biến đổi tham số sử dụng cho Calibration. Chương trình đưa ra một số phương pháp định kích cỡ : affine, bilinear, polynomial, surface splines Vân vân.


Với vài thiết lập của những cặp Calibration và ph​ương pháp Calibration được chọn nào đó, chương trình không thể làm một sự biến đổi như kiểu đã cho với tất cả những điểm di chuyển về đúng vị trí thực tế. Điều này sản sinh những khoảng cách lệch giữa những điểm thu được và những điểm thực tế thích hợp của nó. Khi bạn chọn một phương pháp Calibration, bạn có thể sử dụng phương pháp sao cho lỗi giá trị cho tất cả các cặp điểm là thấp nhất.

d-Kiểu những cặp điểm Calibration


Mỗi cặp có một  kiểu sau:


-Grid:  Nếu một cặp là một bộ phận của lưới Calibration, sử dụng trong sự tính toán những tham số Calibration và ước lượng sự chính xác Calibration. 

-Controlxe "Control calibration points":  nếu một cặp được sử dụng trong sự tính toán những tham số và ước lượng sự chính xác Calibration.


-Check: nếu một cặp được sử dụng chỉ để đánh giá sự chính xác Calibration và không ảnh hưởng những tham số .


-Unsed:  nếu  một cặp chưa được sử dụng trong sự tính toán của những tham số Calibration và đánh giá sự chính xác Calibration.

e-Những bước chính của Calibration


-Mở hộp thoại Calibration .


-Tạo ra một tập hợp của những cặp Calibration 

-Chỉ rõ vị trí những điểm chính xác


-Chọn một phương pháp Calibration thích hợp


-Chạy Calibration 

Ghi chú : nó có thể hữu ích để định nghĩa tọa độ hệ thống : gốc và tỷ lệ hệ thống tọa độ trước khi Calibration 

Để biết chi tiết hơn về việc định nghĩa hệ thống tọa độ, xem “ Kết hợp hệ thống của một tài liệu WiseImage “ .

*Hộp thoại Calibration :


Để mở hộp thoại Calibration : Từ thực đơn Image,  chọn Calibrate hoặc kích nút [image: image259.png]


 trên  thanh công cụ Image .
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Các nút trong hộp thoại

·  Define Grid :Tạo ra một tập hợp của cặp calibration đặt trong những nút lưới hình chữ nhật.

·  Add Pair:Tạo ra một cặp calibration sử dụng hộp thoại.

[image: image261.png]


 Modify Pair:Cho phép thay đổi những vị trí của những điểm thực tế và nhập một cặp lựa chọn.

[image: image262.png]


 Reset Pair: Vị trí điểm cân nhắc tới vị trí điểm thực tế cho một cặp calibration lựa chọn.

[image: image263.png]


 Delete Pair : Loại bỏ tất cả các cặp được chọn từ danh sách điểm thích hợp từ bản vẽ.

[image: image264.png]


 View Previous: Pan bản vẽ để hiển thị thứ tự cặp calibration .

[image: image265.png]


 Zoom To : Zooms bản vẽ để trình bày những cặp cali​bration lựa chọn.

[image: image266.png]


 View Next : Pan bản vẽ để trình bày sự cặp đôi tiếp theo.

[image: image267.png]


 Estimate: Đánh giá sự chính xác cali​bration .

Calibration method


Cho thấy phương pháp mà sẽ được sử dụng .

-Mean error: Trình bày độ lệch trung bình bình phương cho tất cả các cặp định kích cỡ.


-Max error: Trình bày độ lệch cực đại cho tất cả các cặp .


- Min error: Trình bày độ lệch tối thiểu cho tất cả các cặp 
Danh sách các cặp calibration


Trình bày thông tin về tất cả các cặp trong định dạng sau:

	Point Name
	Trình bày tên các cặp .  Để lựa chọn một cặp , kích tên của nó.

	Type
	Trình bày  kiểu cặp định kích cỡ : Control, Grid, Check, hoặc Unused.

	Xreal
	hiển thị tọa độ  X điểm thực tế .

	Yreal
	hiển thị tọa độ  Y điểm thực tế .

	Xmeas
	hiển thị tọa độ X của điểm cân nhắc.

	Ymeas
	hiển thị tọa độ Y của điểm cân nhắc

	Xadj
	Hiển thị  tọa độ X của điểm ước lượng.

	Yadj
	Hiển thị  tọa độ Y của điểm ước lượng

	Xerr
	Hiển thị  hình chiếu X của khoảng cách giữa điểm thực tế và được ước lượng .

	Yerr
	Hiển thị  hình chiếu Y của khoảng cách giữa điểm thực tế và được ước lượng 


a-Tạo ra một tập hợp của những cặp Calibration


Tạo ra những cặp là thêm những định nghĩa của nó vào danh sách của hộp thoại Calibration. 

1.Chỉ rõ những tọa độ điểm lý thuyết được biết ( những điểm thực tế). Có hai cách: Định nghĩa một calibration grid hoặc thêm chúng lần lượt. Cả hai phương pháp có thể được sử dụng đồng thời. Trong lúc tạo , mỗi cặp có đồng thời tọa độ điểm thực tế và tọa độ hiện thời (tọa độ sai cần hiệu chỉnh).


2.Chỉ định những điểm hiện thời thích hợp cho tất cả điểm thực tế bởi việc pick chúng trên hình ảnh hoặc nhập  tọa độ điểm từ bàn phím. 
b-Định nghĩa lưới Calibration


Lưới Calibration có ích khi bạn nắn những hình ảnh có lưới raster với những nút đã biết những tọa độ. Việc định nghĩa lưới tạo ra một tập hợp của những cặp đặt trong những nút của một lưới hình chữ nhật.  Những cặp này có kiểu Grid .


Vị trí của những nút lưới được chỉ rõ bởi gốc, góc, kích thước ô, và số của ô trong những phương  nằm ngang và thẳng đứng.


Có thể chỉ là một lưới định nghĩa trên hình ảnh. Định nghĩa lại một lưới loại bỏ tất cả các cặp điểm của lưới hiện hữu từ hình ảnh.

Để định nghĩa một lưới :


1.
Mở hộp thoại Calibration.


2.
Kích nút [image: image268.png]


 trong hộp thoại Hộp thoại L​ới Định kích cỡ xuất hiện :
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3.Chỉ rõ gốc của lưới.


Nhập những tọa độ  trong Origin, hoặc nhấn nút bên cạnh và kích vị trí gốc trên hình ảnh.


Gốc lưới được giả thiết góc trái dưới, và lưới được phát sinh dọc theo phương dương của trục X và Y.  Để đặt hướng góc và lưới khác, nhập giá trị âm trong hộp Size  và Cell.


4.
Chỉ rõ kích thước  X và Y của ô lưới.

 
Nếu cần thiết, bạn có thể thêm những cột lưới trong phương ngược lại của X hoặc Y bởi việc chỉ rõ một giá trị âm cho kích thước X hoặc Y.


5.
Chỉ rõ số ô lưới dọc theo trục X và Y sử dụng X Cell  và Y Cell  tương ứng.


6.
Để ngăn ngừa những lỗi, chọn nút Preview để nhìn lưới định nghĩa. Sửa chữa những lỗi nếu có.


7.
Chọn Ok để tạo ra lưới và trở lại hộp thoại.


8.
Bạn có thể xây dựng một lưới hình chữ nhật nghiêng bằng cách định nghĩa góc. nếu không, lưới sẽ trực giao với trục X và trục Y.

c-Thêm cặp đôi điểm nắn ảnh từng bước một


Phương pháp này tạo ra những cặp điểm từng bước. Những cặp tạo ra có thể có kiểu Control, Check hoặc Unused . Thủ tục được thiết kế để bạn có thể tạo ra những cặp bởi việc cho biết những tọa độ điểm thực tế. Bạn có thể định nghĩa những tọa độ điểm cần nắn  sau.


1.
Mở hộp thoại Calibration .


2.
Từ thực đơn cursor, chọn Add  hoặc kích nút [image: image270.png]


 trong hộp thoại .

Hộp thoại sau xuất hiện :
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3.
Nhập những tọa độ điểm thực tế trong Real..


4.
Nhập tên cho cặp trong Label. Nếu không sẽ gắn ên mặc định “ PointNN ”.


5.
Nhập những tọa độ điểm cần nắn trong Measured hoặc pick [image: image272.png]


 và chỉ điểm trong màn ảnh . Nếu không những tọa độ của chúng sẽ bằng những giá trị thực tế và có thể được sửa đổi sau đó. 


6.
Nếu cần thiết, thay đổi kiểu cặp điểm trong hộp kiểm Use as  hoặc định nghĩa cặp như  Unused.


7.
Nhấn ENTER hoặc chọn Add để tạo và tiếp tục quá trình.


8.
Chọn Closse  để trở lại hộp thoại.

d-Lựa chọn những cặp điểm 


Để xem, sửa đổi, hoặc xóa một cặp điểm, trước hết lựa chọn nó từ danh sách trong hộp thoại Calibration. 
Để lựa chọn một cặp từ danh sách, kích vào tên của một cặp. Để lựa chọn vài cặp, kích vào tên của một cặp sử dụng phím CTRL và SHIFT để lựa chọn , hoặc kích và kéo trong danh sách tới bản vẽ chọn hình chữ nhật xung quanh những tên của những cặp bạn muốn chọn.

e-Việc định nghĩa điểm nắn trên màn ảnh


Để thay đổi vị trí của một điểm nắn trên  màn ảnh:


1.
Lựa chọn cặp điểm muốn sửa đổi từ danh sách của hội thoại hoặc trong màn ảnh. WiseImage chiếu sáng điểm được chọn với grip.


2.
Zoom tới cặp điểm bởi nút [image: image273.png]


 trên thanh công cụ hoặc lệnh Zoom từ thực đơn cursor.

WiseImage Pan hình ảnh để cho thấy điểm được chọn trong trung tâm cửa sổ hình ảnh.


3.
Thay đổi vị trí điểm hiện thời .

Đặt  cursor trên grip và kích. Di chuyển cursor và kích để  chỉ định vị trí mới của nó.


4.
Làm điểm tiếp theo hoặc điểm kề trước .


Nhấn N hoặc phím Tab hoặc nút [image: image274.png]


 trên thanh công cụ trong hộp thoại Calibration để chuyển tới cặp tiếp theo. hoặc :


Nhấn Phím P hoặc nút [image: image275.png]


 trên thanh công cụ trong hộp thoại để chuyển tới cặp trước đó.


5.
Lặp lại từng bước 3- 4 cho tất cả các cặp bạn cần.

g-Sửa đổi những cặp điểm với Hội thoại


Bạn có thể thay đổi bất kỳ điểm nắn nào sử dụng hộp thoại .


1.
Lựa chọn một cặp từ danh sách trong hộp thoại Calibration.


2.
Zoom tới điểm bởi nút [image: image276.png]


 hoặc lệnh từ thực đơn cursor.


3.
Từ thực đơn cursor, chọn Modify  hoặc kích nút [image: image277.png]


 trong hộp thoại .

Hộp thoại sau xuất hiện :
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4.
Nhập tọa độ thực tế và hiện thời. Bạn có thể pick những tọa độ điểm chính xác trong màn ảnh bởi nút [image: image279.png]


. 

5.
Lựa chọn kiểu cặp điểm trong Use as. Loại bỏ hộp kiểm từ Use as,, và định nghĩa cặp điểm cẽ không được sử dụng cho nắn ảnh. 

6.
Nhập tên cho cặp trong Label..


7.
Kích OK.

h-Xóa những cặp điểm


Bạn có thể xóa những cặp điểm chọn từ danh sách trên hội thoại. Chú ý rằng bạn không thể undo hoạt động này.


1.Lựa chọn những cặp từ danh sách trong hộp thoại .


2.Từ thực đơn cursor, hãy chọn Delete hoặc kích nút [image: image280.png]


 trong hộp thoại 

i-thiết lập lại những cặp Điểm


Thao tác này thiết đặt lại những tọa độ nắn của những cặp điểm được chọn tới những cái thực tế. Chú ý rằng bạn không thể undo động này. 


1.Lựa chọn những cặp từ danh sách trong hộp thoại .


2.Từ thực đơn cursor, hãy chọn Reset hoặc kích nút [image: image281.png]


 trong hộp thoại 

*Chọn phương pháp nắn


chọn một phương pháp nắn dựa vào sự méo hình và số lượng , vị trí của những cặp điểm.


Nếu bạn không có thông tin về sự méo hình, thì bạn có thể chọn một phương pháp định kích cỡ tự động. Trong trường hợp này chương trình tự động chọn phương pháp tối ưu cho tập hợp của những cặp điểm


Bảng sau mô tả sự biến dạng và những phương pháp có thể sử dụng để hiệu chỉnh 

	Phương pháp
	Sự biến dạng

	Linear conformalxe "Linear conformal method"
	Cho phép biến đổi tuyến tính: di chuyển, quay, và tỷ lệ tương xứng 

	Affinexe "Affine method"
	Cho phép biến đổi tuyến tính: di chuyển, quay, và tỷ lệ không cân đối . (Những hình ê-líp Raster có thể thay đổi thành đường tròn)

	Bilinearxe "Bilinear method"
	Cho những sự biến dạng hình bình hành hoặc hình thang trên bản đồ hoặc những bản vẽ cơ khí.

	Grid adaptive bi​linearxe "Grid adaptive bi​linear method"
	dùng những sự biến dạng lưới raster nhỏ nếu lưới lồi.

 Có thể chỉ được sử dụng nếu lưới định kích cỡ được định nghĩa.

	Polynomialxe "Polynomial method"
	Sự biến dạng phi tuyến gây ra bởi mọi sự mở rộng ba chiều của tài liệu đồ họa nguyên bản hoặc bởi một kiểu hình ảnh ví dụ, những bức ảnh chụp  bề mặt của Trái đất

	Surface Splinesxe "Surface Splines method"
	Cho những sự biến dạng của tất cả các loại, chính xác hơn, và làm việc trên một tập hợp riêng biệt của những cặp điểm.



Với mỗi phương pháp, có một số tối thiểu của những cặp điểm cho phép sử dụng mô hình này. Nếu số những cặp vượt hơn một giá trị nhất định, tất cả các mô hình, trừ Surface Splines, kết quả độ lệch là non-zero


Bảng sau mô tả những sự hạn chế trên sự nắn ảnh cho mỗi phương pháp 

	Tên phương pháp
	số cặp điểm yêu cầu
	số của những cặp calibra​tion sản sinh lỗi non- zêrôxe "Errors:of calibration"

	Linear
conforma
	2
	3

	Affine
	3
	4

	Bilinear
	4
	5

	Grid adaptive
bi​linear
	lưới định kích cỡ phải được định nghĩa.
	Những điểm không lưới được định nghĩa

	Polynomial
2 de​gree
	6
	7

	Polynomial
3 de​gree
	10
	11

	Polynomial
4 de​gree
	15
	16

	Polynomial
5 de​gree
	21
	22

	Polynomial
6 de​gree
	28
	29

	Surface
Splines
	3
	không thích hợp


Để chọn một phương pháp, lựa chọn từ danh sách Calibration method của hộp thoại Calibration

*Đánh giá sự chính xác 


Đánh giá sự chính xác cho phép bạn tìm thấy sự dịch chuyển của mỗi điểm raster , mà không phải chạy thủ tục calibration .


Với mỗi cặp điểm, việc đánh giá tạo ra một điểm nữa gọi estimated. Nó cho thấy vị trí một điểm nắn sau khi chạy phương pháp cali​bration đã chọn. Những đánh dấu của những điểm như vậy có màu vàng. ( những đánh dấu của những điểm thực tế thì màu xanh, những đánh dấu của những điểm chính xác thì màu đỏ. Bạn có thể thay đổi những màu mặc định này trong hộp thoại Preferences ). Chương trình tính toán và trình bày những khoảng cách giữa điểm nắn và điểm thực tế của nó . Những khoảng cách này định nghĩa những độ lệch nắn ảnh cho mỗi cặp.


WiseImage tính toán những tham số của phương pháp được chọn sao cho sau khi  biến đổi mỗi điểm nắn được đặt càng gần điểm thực tế của nó càng tốt. WiseImage chỉ sử dụng những cặp Control và Grid  cho những sự tính toán này. 

Để đánh giá sự di chuyển của một điểm hình ảnh nhất định  sau khi nắn ảnh, bạn cần  tạo ra một cặp điểm thực tế và điểm nắn mà có những tọa độ điểm hình ảnh mong muốn , và gán kiểu Check cho cặp này. Cặp sẽ không được xem xét khi định nghĩa những tham số biến đổi, nhưng chương trình sẽ tìm thấy điểm ước lượng cho cặp điểm và tính toán độ lệch tương đối tới vị trí điểm thực tế của nó.


Để đánh giá sự chính xác: 


1.Tạo ra cặp điểm nắn ảnh .



2.Chỉ rõ những vị trí của điểm nắn.



3.Nếu cần tạo cặp kiểm tra quyết định chọn trên trên sự chuyển động của điểm.


4.Lựa chọn phương pháp từ danh sách phương pháp. 


Trên cơ sở sự lựa chọn khuyến cáo trong " Chọn phương pháp nắn ảnh ”. Chú ý rằng WiseImage chỉ cho phép sử dụng những mô hình nào phù hợp với tập hợp xác định của những cặp điểm. Bạn không thể chạy chương trình  nếu những yêu cầu này chưa được đáp ứng.


5.Nhấn  nút [image: image282.png]


 trong hộp thoại.


Mean error cho biết lỗi trung bình của phương pháp được chọn. 

Ví dụ:


Ví dụ này cho thấy sự nắn ảnh của một hình ảnh màu từ file UTRECHT.TIF của thư mục  SAMPLES của chương trình.

Tải Hình ảnh

Chọn Open  từ thực đơn file  hoặc kích nút Open trong thanh công cụ Chính. 
Chọn file UTRECHT.TIF.


Chú ý rằng mẫu hình ảnh này có lưới raster tạo thành 4 ô. Lưới này có kích thước ô bằng 32x32 mm, và bên trong bản chính lưới bị bóp méo. 


Sử dụng thủ tục nắn ảnh để loại bỏ sự biến dạng



Từ thực đơn Image, chọn Calibration hoặc, kích nút [image: image283.png]


.


Tạo ra một tập hợp những cặp điểm sử dụng lưới nắn: 


1.ấn [image: image284.png]


 trong thanh công cụ Calibration . Hộp thoại xuất hiện. 

2. Zoom hình ảnh góc trái dưới.


3.Bạn có thể nhạp những tọa độ chính xác nút lưới bằng toạ độ Gốc Nếu Bạn định nghĩa UCS  hoặc nhấn nút  [image: image285.png]


 và kích một điểm ở tại góc nút lưới, như trong hình ở bên d​ới.

[image: image286.png]



                                         Kích ở đây


4.Chỉ rõ kích thước Xvà Y của ô l​ới.


Nhập 32 trong X Size và Y Size  .


5.Chỉ rõ số ô lưới dọc theo trục hoành và trục tung: nhập2 tới X Cell và Y Cell  tương ứng. 

6.Chọn Ok để tạo ra một lưới chuẩn và trở lại hộp thoại.


Một lưới màu đỏ trình bày.


Định nghĩa những điểm chính xác:


1.
Lựa chọn cặp đầu tiên ( 01,01) từ danh sách trong hộp thoại. WiseImage chiếu sáng điểm được chọn với grip.


2.
Zoom tới cặp điểm được bởi nút [image: image287.png]


 trên  thanh công cụ cửa sổ, hoặc nhắp pahỉ và chọn zoom to. Bạn có thể cũng sử dụng nút chuẩn [image: image288.png]


 để nhìn điểm chính xác hơn. 

3.
Thay đổi vị trí hiện thời của điểm: 


Đặt cursor qua sự grip và kích. Di chuyển cursor và kích để chỉ rõ vị trí mới của nó.


4.
Đi tới cặp tiếp theo bởi việc nhấn N hoặc khóa Tab hoặc nhấn nút [image: image289.png]


 trong hộp thoại 


5.
Lặp lại những b​ớc 3 và 4 cho tất cả các cặp  chỉ rõ vị trí điểm chính xác.

Chọn lọc phương pháp biến đổi


Từ bảng “chọn phương pháp nắn”ở phần trước , phương pháp Grid adaptive bilinear là tiện lợi nhất để sửa chữa những sự biến dạng lưới.


Từ danh sách Calibration Method , lựa chọn Grid adaptive bilinear  hoặc : chọn : automatically từ danh sách đó.

Đánh giá sự chính xác biến đổi 


Kích nút [image: image290.png]


 trong thanh công cụ Calibration .


Chương trình sẽ tìm thấy tọa độ những điểm Tính toán - Những điểm nắn của tất cả các cặp điểm sẽ được di chuyển tới, và vị trí của nó sẽ hiển thị với màu vàng đánh dấu chéo trên  hình ảnh. Đồng thời , chương trình tính toán những khoảng cách giữa điểm tính toán và thực tế của những cặp điểm để đánh giá những lỗi biến đổi cực tiểu, trung bình và  tối đa. Những giá trị của những lỗi này được trình bày trong những hộp : Mean error, Min error và Max Error tương ứng.


Trong trường hợp này tất cả ba giá trị  đều là zêrô. Nghĩa là tất cả các nút l​ới raster sẽ có những vị trí mong muốn sau khi nắn.

Bắt đầu thủ tục nắn ảnh


Kích nút Apply trong thanh công cụ .

10-Auto Correction (hiệu chỉnh tự động)


Thao tác này xử lý một hình ảnh, sử dụng một preliminarily (sự sắp xếp ban đầu) chỉ rõ tập hợp của những thao tác chuẩn.


Tập hợp của những thao tác ứng dụng được xác định trong mục Auto correct của hộp thoại Preferences.


Khi thực hiện sự hiệu chỉnh tự động, những thao tác xác định được áp dụng thứ tự tong bước chúng được thu xếp trong mục Auto correct

Nếu bất kỳ thao tác xác định nào không thể thực hiện được, thì nó được lờ đi và thao tác tiếp theo sẽ bắt đầu.

Để thực hiện autocorrection:


1.
Chỉ rõ một tập hợp của những thao tác trong mục Autocorrect của hộp thoại Preferences 
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2.
Lựa chọn những hình ảnh .  Nếu không lựa chọn bất kỳ hình ảnh nào, thì lệnh này xử lý tất cả những hình ảnh they được và định vị trên những lớp không khóa.


3.
Chạy thao tác, sử dụng một trong những phương pháp sau :

chọn Auto correct từ thực đơn Image hoặc kích nút [image: image292.png]


  trên thanh công cụ Image.

11- Làm dày/mỏng raster


a-Làm mỏng

Là phương pháp làm cho những đoạn raster mỏng hơn bởi xác định một số pixecls  trong phương hướng ngang, đứng, và chéo.  

Để làm mỏng một hình ảnh : 


1. Định nghĩa tập hợp chọn lọc muốn xử lý và chọn Thinning từ thực đơn Filters hoặc nhấn nút [image: image293.png]


 trên thanh công cụ .



2. Chỉ rõ những số mong muốn để làm mỏng hoặc lựa chọn hộp kiểm Thinimage up to skeleton để chuyển đổi tất cả các đối tượng thành những đường mảnh  một pixcels


3.Chọn Apply.


b-Làm dày (đặc)

làm cho raster những đối tượng dày hơn bởi  xác định số pixcels. Bạn có thể chọn kết hợp  làm đặc phương hướng.


Hình dưới cho thấy hiệu ứng cách lọc nếu tất cả các phương hướng đều được chọn. ảnh trái là raster nguyên bản , và bên phải cho thấy  kết quả của việc làm đặc .

[image: image294.png]


      [image: image295.png]


 

cách lọc làm đặc trong tất cả các phương hướng


Hình ở bên dưới cho thấy hiệu ứng cách lọc làm đặc chỉ chọn làm đặc hướng Vertical . Bức tranh trái cho thấy rhình ảnh raster nguyên bản, và bức tranh phải cho thấy kết quả làm đặc 

[image: image296.wmf]
           Làm đặc trong phương hướng thẳng đứng 


Để làm đặc một đối tượng:
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12- Làm đầy những đọan gãy


Loại trừ những đọan đứt gãy trong những đường raster. Thao tác này có thể được thực hiện chỉ với những raster đơn sắc. Để thực hiện lệnh bạn cần thiết lập chiều rộng đường tối đa và đọan hở. Bạn có thể có những giá trị này bởi việc đo trực tiếp từ raster. Để đo những giá trị sử dụng những nút thích hợp. Thanh trượt cho phép bạn xử lý bằng tay và bạn phải nhìn những kết quả để xác định rằng thích hợp nhất.


1. Mở hình ảnh raster đơn sắc.


2. Chạy lệnh.


3. Đo chiều rộng của một line. Định nghĩa những kích thước chỗ trống bạn muốn loại trừ. (Đo đọan lớn nhất của chúng.)


4. Nếu bạn thỏa mãn với những kết quả trong cửa sổ xem trước, tiến tới bước 5 ở bên dưới. Nếu chưa được thỏa mãn với những kết quả, bạn có thể lặp lại phép đo những tham số đòi hỏi. Bạn có thể di chuyển thanh trượt chính xác tới hình ảnh. 


5. Sau bạn tìm ra vị trí tối ưu nhấn nút Apply.


6. Nếu bạn muốn lưu sự thiết đặt đểsử dụng sau này, nhấn nút Template và định nghĩa một file để lưu

13-Đường viền


chuyển đổi những vùng hình ảnh đầy thành một đường viền ngoài (outline) mảnh với một pixcels. bộ lọc 4-coupling tạo ra đường viền 4 ghép nối; 8-coupling tạo ra đường viền 8 ghép nối tương ứng. Trong 4-coupling những vùng kề nhau có thể chỉ bị ghép với những cạnh của nó; 8 ghép nối góc kề nhau phân tích, vì vậy những hình ảnh trông mỏng hơn. 
Hình cho thấy kết quả của cách lọc:

[image: image298.png]
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Để chuyển đổi raster  thành những outlines:

 
Lựa chọn bộ phận raster và chọn Filters >contour > kích 4-coupling ([image: image302.png]


) hoặc 8-coupling  ([image: image303.png]


)
ii-vẽ raster

1- Flood Erase


Xóa bỏ những vùng raster độc lập trên hình ảnh đơn sắc.  Lệnh có thể áp dụng tới vài hình ảnh một lúc. Để khởi động lệnh :


Từ thực đơn Draw> Raster> Flood Erase. hoặc kích nút [image: image304.png]


 trên thanh công cụ Draw.

2- Flood Fill


Làm đầy những vùng raster trong đường viền trên hình ảnh đơn sắc với màu mặt trước của đối tượng raster.

 Lệnh có thể đ​ợc áp dụng tới vài hình ảnh một lúc


1. Khởi động lệnh từ thực đơn Draw >Raster >Flood Fill. hoặc [image: image305.png]»



 trên thanh công cụ. 


2. Di chuyển cursor tới vùng làm đầy, và kích.


3. Để floodfill một đường viền, kích một điểm bên trong đường viền raster đóng .

3- Pencil


Vẽ một đường xác định raster có chiều rộng và màu.


1. Khởi động lệnh từ thực đơn Edit > Pixel Draw. hoặc [image: image306.png]


 thanh công cụ Draw.


2. Nhập chiều rộng bút trong cửa sổ Inspector.

3. Kéo cursor để vẽ.

4-Biên tập text raster


Lệnh này trực tiếp sử dụng để vào một văn bản trong hình ảnh raster và tự động làm sạch một vùng cho văn bản. Bạn có thể soạn thảo những văn bản trong hình ảnh của tất cả các kiểu màu black-white, 8-bit, grayscale, 24-bit).  Nó hợp lý để thiết đặt màu văn bản cho hình ảnh màu.
Sự khác nhau chính là trong thi hành lệnh này, vùng nhập tự động bị làm sạch. Nếu bạn muốn vào một văn bản trong hình ảnh raster mà không làm sạch vùng này, hãy sử dụng lệnh Text với kiểu RDRAW đã bật


Để vào một văn bản trực tiếp trên hình ảnh raster bật kiểu RDRAW với nút ở tại đáy (của) cửa sổ WiseImage. 


1. Khởi động lệnh từ thực đơn Draw > Raster > Edit Raster Text. hoặc thanh công cụ.


2. Vào văn bản từ bàn phím hoặc từ Clip.


3. Chỉ rõ một vùng hình chữ nhật trên hình ảnh raster 

Sau khi bạn đã vào văn bản và chỉ rõ kích thước vị trí của vùng, lệnh được hoàn thành. Vùng xác định sẽ bị sạch trên hình ảnh raster ( Màu của vùng này là màu nền) và văn bản sẽ là raster trên chỗ này. Trong thời gian vào văn bản và chỉ rõ vùng, bạn có thể thay đổi góc quay văn bản, kích thước của nó, phông, và lớp để đặt văn bản này ( Nếu kiểu RDRAW tắt) sử dụng Inspector


Màu để làm đầy vùng trên  hình ảnh được định nghĩa bởi màu chỉ rõ trong thuộc tính màu Nền.


Làm sao để vào một văn bản mà không có rasterizing?


RDRAW phải tắt. Trong trường hợp này những kết quả thực hiện lệnh tạo ra một đối tượng kiểu text ( chuỗi Văn bản).

5-Màu tô đầy


Cho phép cho floodfilling những vùng cùng màu đó trên hình ảnh raster màu. Có hai kiểu: Trước hết lệnh tự động định nghĩa một màu trung bình cho một vùng và làm đầy vùng với màu này, tiếp theo bạn có thể chỉ rõ màu lấp đầy. thao tác floodfilling màu kiểm soát bởi những sự thiết đặt của thanh trượt trong thanh công cụ Color Accuracy 
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. Thao tác này có thể được điều chỉnh để làm sạch vùng floodfilled loại trừ những vết lốm đốm và những vùng màu.


1. Khởi động lệnh từ thực đơn thanh công cụ.


2. Đặt Autodetect color tới TRUE trong thanh công cụ Inspector.
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3. Kích vào điểm của màu lấp đầy. Kích thước vùng được định nghĩa bởi vị trí của thanh trượt. 


để làm đầy vùng với màu được chọn:


1. Đặt màu Autodetect color  tới FALSE và chọn Fill color.


2. Kích vào điểm bên trong vùng để tô đầy

iii-đối xứng


1.Lựa chọn những hình ảnh như trên.  


2.Chạy thao tác Mirror > By X Axis (ph​ơng hướng nằm ngang) hoặc By Y Axis (thẳng đứng) từ thực đơn Image.

iv-Quay


Để quay một hình ảnh  90, 180, 270 độ:


1.Lựa chọn những hình ảnh để quay như trên.  


2.Chạy thao tác bởi việc chọn Rotate > 90-ccw, 180 hoặc 90 – cw  từ thực đơn image.


Để quay một hình ảnh bởi một góc tùy ý


1.Lựa chọn những hình ảnh để quay.  


2.Chạy thao tác bởi việc chọn Rotate – Custom Angle từ thực đơn Image.

Hộp thoại trình bày .


3.Nhập góc quay mong muốn trong Angle hoặc kích nút [image: image309.png]


và chỉ rõ điểm bắt đầu và kết thúc để định nghĩa một góc quay. Giá trị chính xác sẽ tự động được vào hộp Angle.


4.Kích OK.

v-lọc

1-lọc đơn sắc


a-Di chuyển vết đốm


Speckle Remover di chuyển những đối tượng raster ( cô lập những nhóm điểm) mà nhỏ hơn những cái có giá trị xác định. Bộ lọc này có thể tự động xác định kích thước vết đốm trong hình ảnh.


Bộ lọc có thể được sử dụng sau những thủ tục như binarization và Layer để loại bỏ những đối tượng kích thước nhỏ hơn trong những lớp của những hình ảnh đơn sắc.

[image: image310.png]


                            
[image: image311.png]





            Trước khi loại bỏ vét đốm
                                           Sau làm lốm đốm loại bỏ



Để loại bỏ vết lốm đốm raster:


1. Định nghĩa tập hợp chọn lọc bạn muốn xử lý và chọn Speckle Remover từ thực đơn Filters hoặc nhấn  nút [image: image312.png]


  trên thanh công cụ Filters .
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2.Chỉ rõ kích thước cực đại của những đối tượng raster sẽ được loại bỏ trong đơn vị hiện thời ( hộp trái) hoặc trong dots ( hộp phải). hoặc :


Thiết đặt tùy chọn Auto Estimating để bộ lọc tự động ước lượng kích cỡ vết đốm raster trước khi cách lọc.


Nút [image: image314.png]


 để đo kích thước đối tượng raster trên màn ảnh , hãy kích vào điểm bên trong đối tượng.
 hoặc:


Kích nút [image: image315.png]


 và pick hai điểm trên màn ảnh. Chương trình sẽ ước lượng kích thước vết lốm đốm bằng khoảng cách giữa những điểm này.



3.Chọn Apply

b-Di chuyển lỗ hổng


Cái lọc này loại bỏ những lỗ trong những đối t​ợng raster. Chỉ những lỗ với kích thước nhỏ hơn hơn giá trị xác định mới được loại bỏ. Cái lọc có thể tự động đánh giá kích thước lỗ trên  những đối tượng hình ảnh.


Cái lọc có thể sử dụng sau những thủ tục như binarization và lớp để đầy những lỗ trong raster hình ảnh.



   [image: image316.png]


                          [image: image317.png]





        Hình ảnh Nguyên bản
                                     Sau khi loại bỏ lỗ 


Để loại bỏ những lỗ:


1. Định nghĩa tập hợp chọn lọc bạn muốn xử lý và chọn Hole Remover từ thực đơn Filters hoặc nhấn nút  [image: image318.png]


  trên thanh công cụ .
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2.Chỉ rõ những kích thước cực đại của lỗ raster sẽ được loại bỏ trong những đơn vị hiện thời (hộp trái) hoặc trong những dots ( hộp phải). hoặc :


Thiết lập tự động, chọn hộp kiểm Auto Estimating 
[image: image320.png]


 Để đo kích thước lỗ raster trên màn ảnh , kích vào điểm bên trong đối tượng.


 hoặc: Kích nút [image: image321.png]


 và pick hai điểm trên màn ảnh. 


3.Chọn Apply.


Speckle
2-lọc màu


a-Mặt nạ Unsharp 


Tìm kiếm những ranh giới chuyển tiếp màu trong hình ảnh và cải thiện sự sắc nét của chúng. Làm việc trên những hình ảnh greyscale và màu.


Những tùy chọn :


Sensitivity: Chỉ rõ phần trăm hiệu ứng lọc.


Radius: Đặt giá trị bán kính xác định chiều sâu của những điểm sẽ được ảnh h​ởng ở  mép.

Lệnh có thể đ​ợc áp dụng tới vài hình ảnh một lúc.

Để áp dụng mặt nạ Unsharp lọc :


1. Khởi động lệnh từ thực đơn Filter > Unsharp Mask. hoặc [image: image322.png]


 thanh công cụ Filter.


2. Vào một giá trị Sensitivity hoặc sử dụng thanh trượt thích hợp để chỉ rõ hiệu ứng phần trăm mong muốn của lọc ( 0 tới 100). Giá trị cao hơn gây ra một hiệu ứng mạnh mẽ hơn.


 Vào một giá trị Bán kính.  Một giá trị bán kính xác định chiều sâu của ứng dụng lọc. Giá trị lớn hơn, có nhiều điểm hơn bao vây ranh giới chuyển tiếp màu sẽ được xử lý. giá trị bán kính thấp tăng thêm sự sắc trên những mép.  Để điều chỉnh tối ưu những tham số , hãy đặt trong cửa sổ xem trước một tầm nhìn trên một vùng tiêu biểu nhỏ để thử.


3. Kích Apply.


Lọc này có thể sử dụng để sửa chữa những hình ảnh mờ sau phép nội suy, cho ví dụ, sau những thao tác như tỷ lệ sự cải biến độ phân giải, hoặắinn ảnh.


b- Trung tuyến 


Giảm bớt “nhiễu” hình ảnh, xem lại tất cả các điểm bên trong bán kính xác định và đưa vào trung tâm điểm  Làm việc trên những hình ảnh greyscale và màu.


1. Khởi động lệnh từ thực đơn Filter > Median hoặc [image: image323.png]


 thanh công cụ Filter.


2. Chỉ rõ giá trị bán kính từ 1 đến 5. 


3. Chọn Apply. impression


c- Làm mờ 


Sản sinh hình ảnh hiệu ứng làm mờ, Làm việc trên những hình ảnh greyscale và màu.


1. Khởi động lệnh từ thực đơn Filter > Blur. hoặc [image: image324.png]


 thanh công cụ.


2. Nhập giá trị từ 0.1 đến 10.0 trong Radius để chỉ rõ độ làm mờ hình ảnh. Lớn hơn Bán kính, hiệu ứng mạnh mẽ hơn.


3. Kích Applyy


d- Thích ứng làm mờ 


Công cụ này thiết kế như làm mờ (ở phần trên) những vùng màu không đồng dạng bên trong những ranh giới chuyển tiếp màu trong hình ảnh. Nó làm việc trên grayscale và  màu. Lệnh có thể áp dụng tới vài hình ảnh một lúc.


1. Khởi động lệnh.


2. Nhập những giá trị từ 0.1 đến 10.0 trong Radius 

3. Kích Apply

e- Sự phân đọan (chỉ có trong phiên bản Wiseimage Geo)


Lệnh này tìm thấy và đánh dấu những viền của hình ảnh raster. Sự khác nhau lớn hơn sự phân đoạn viềnẩnõ ràng hơn. Việc tăng thêm tham số bán kính gây ra cho nhiều chỗ hơn sẽ được xem xét như những viền vùng..

[image: image325.png]



1. Mở hình ảnh raster màu. 

2. Chạy lệnh và bật nó với thanh trượt cho đến khi bạn được thỏa mãn với một kết quả xem trước. Kích nút Ok.

Filters> Segmentation. Hoặc [image: image326.png]


 trên thanh công cụ Filters

vi-xử lý màu

1-Thay đổi khỏang cách màu

a-Chuyển đổi tới Gray scale


Chuyển đổi tất cả các kiểu hình ảnh raster màu tới kiểu grayscale. Nếu lệnh khởi động không có hình ảnh nào được chọn, thì tất cả các hình ảnh chứa đựng trong tài liệu sẽ được chuyển đổi.


Khi chuyển đổi những hình ảnh TrueColor tới

 grayscale, thông tin màu bị mất khi chuyển đổi một 

hình ảnh đơn sắc trong kiểu Grayscale, những sự 

thay đổi không  rõ ràng .


1. Hình ảnh trong kiểu TrueColor (24 bít trên pixecl).


2. Hình ảnh sau khi áp dụng chuyển đổi tới Grayscale.


3. Độ chói và tương phản với Brightness/Contrast..


Để chuyển đổi một raster trong kiểu grayscale :


1. Lựa chọn một hình ảnh raster để chuyển đổi.


2. Khởi động lệnh từ thực đơn: Image > Convert to> Convert to GrayScale..hoặc kích nút [image: image327.png]B



 bạn có thể sử dụng lệnh này để chuyển đổi ảnh đen trắng tới kiểu grayscale để xử lý nó với bộ lọc màu , ví dụ làm mờ . Sau khi chuyển đổi hình ảnh True Color tới grayscale bạn có thể áp dụng Brigtness/Contrast để sửa chữa độ chói và độ tương phản.

b-Chuyển đổi tới chỉ số màu


Lệnh này chuyển đổi những hình ảnh của tất cả các kiểu tới kiểu 8 bít ( được chỉ số hóa). Quá trình chuyển đổi có thể thực hiện trong kiểu tự động hoặc bằng tay


Nó ứng dụng để sửa đổi bảng mẫu hình ảnh trong kiểu 8 bít 

( đ​ợc chỉ số hóa).Khi làm việc với hình ảnh chỉ số hóa, bạn có thể

 kết hợp các màu, thay đổi màu, xóa màu trong bảng mẫu.


Khi nào làm việc trong kiểu 8 bít ( được chỉ số hóa), mỗi 

điểm hình ảnh có thể đại diện một trong những màu từ bảng mẫu


Bảng mẫu có thể từ 2 đến 256 màu.


Tại sao bạn cần giảm bớt màu ?


Thao tác chuyển đổi hình ảnh 24 bít (true-color) tới kiểu 8

bít ( được chỉ số hóa) kết quả làm giảm bớt màu. Thao tác này được sử dụng rộng rãi , khi những sơ đồ màu, những kế hoạch và những bản đồ quét trong kiểu true-color, không thật sự chứa đựng số màu cần lư​u trữ trong kiểu true-color


Trong vài trường hợp, quét những bản đồ màu trong kiểu 8 bít ( Nếu phần mềm scanner thực hiện điều này chính xác); và sau đó sửa đổi bảng mẫu sử dụng lệnh Convert to 8-bit , nếu cần.


Bạn có thể áp dụng sự giảm màu trong những trường hợp sau ( Tất nhiên, chúng ta chỉ cung cấp những ví dụ; lệnh này có thể cũng ứng dụng cho mục đích khác) : 


-Trước khi thi hành lệnh tách màu  Color Separations, mà tạo ra một raster đơn sắc riêng biệt cho mỗi phạm vi màu;


-Trước khi vẽ một hình ảnh đồ họa, nếu máy in màu của bạn có những màu đầu ra có hạn; 
-Để giảm bớt kích thước file khi tạo ra lưu trữ .

Bạn có thể giải quyết một trong những vấn đề mà xuất hiện khi sử dụng nguồn Scan màu với lện Convert to 8 bit. 


Ví dụ : bản đồ màu của bạn chứa đựng một con đường màu nâu, đi qua vài vùng màu khác nhau. Màu trên con đư​ờng này có những vùng khác nhau trên , sẽ ảnh hưởng kết quả thi hành những lệnh tách màu . Để giữ gìn màu nguyên bản của con đư​ờng này, hãy chuyển đổi hình ảnh của bạn tới kiểu 8 bít ( được chỉ số hóa,) việc hòa trộn và thay đổi màu trong bảng mẫu, được mô tả ở hình dưới.

[image: image328.png]



                            Kiểu RGB ( 24 bít)

      kiểu chỉ số hóa ( 8 bít) thật sự giữ chỉ 15 màu


Làm sao để chuyển đổi ảnh RGB tới kiểu chỉ số hóa tự động?


1. Lựa chọn những hình ảnh để xử lý.


2. Chạy lệnh   Image >Convert>Convert to 8 bit indexed.


Để thu được những hình ảnh với số màu cần thiết, nhập chúng trong trường Color Counter  và kích nút.Reset palette  [image: image329.png]


  hoặc nếu bạn muốn chuyển đổi một hình ảnh tới kiểu 8 bít ( được chỉ số hóa) với sự giảm màu tự động, hãy kích vào nút Set auto palette [image: image330.png]


.


3.Xem kết quả hình ảnh raster trong cửa sổ xem trước, và sau đó kích OK để áp dụng những sự thay đổi tới toàn bộ hình ảnh raster.


Làm sao để giảm bớt những màu bảng mẫu tự động?


1. Lựa chọn hình ảnh raster 8 bít ( được chỉ số hóa).


2. Kích vào nút Set auto palette [image: image331.png]


. 


WiseImage tự động tính toán bảng mẫu tối ưu cho hình ảnh. Số giảm của những màu bảng mẫu được trình bày trong trường Color Counter. 


Làm sao để làm việc với bảng mẫu ( hòa trộn, xóa hoặc thay đổi những màu)?


+Hòa trộn và thay đổi màu  


1. Lựa chọn những màu để hòa trộn trong bảng bảng mẫu bởi việc kích vào chúng với nhấn phím SHIFT.


2. Kích vào nút Merge.


Tất cả các màu được chọn hòa trộn trong trong bảng mẫu, 


+Xóa những màu


1. Lựa chọn màu để xóa trong bảng mẫu bởi việc kích vào chúng với nhấn phím SHIFF.


2. Nhấn  nút xóa. Những điểm màu đã bị xóa lấy màu bảng mẫu gần nhất.


Làm sao để lưu bảng mẫu để sử dụng lại?


Sử dụng nút Template để lưu bảng mẫu cho một file riêng biệt .

c-Chuyển đổi tới True Color (24 bit) 


Chuyển đổi những hình ảnh 6-color, 256-color, grayscale, và đơn sắc tới kiểu RGB. Thao tác này có thể sử dụng để chuyển đổi những hình ảnh mức xám tới mẫu thích hợp để xử lý bởi những công cụ lọc màu.


Để khởi động lệnh :

 Từ thực đơn image>Convert to 24 bit
2-Thay đổi số màu


a-công cụ phân loại màu Classifier


Lệnh này sử dụng để chuyển đổi những hình ảnh –RGB  vào trong chỉ số hóa màu trên cơ sở bảng mẫu, có thể được tính toán tự động hoặc tạo ra bởi người dùng. Bạn có thể cũng soạn thảo bất kỳ bảng mẫu hiện hữu nào.


Trong khi tạo ra và soạn thảo bảng mẫu bạn có thể quan sát những kết quả trong cửa sổ xem trước.


+Làm việc với bảng mẫu:


-Chọn lọc màu:


Pick một ô màu để Lựa chọn. Nếu bạn muốn lựa chọn vài màu, bạn cần phải giữ phím SHIFF trong lúc pick;. Lựa chọn nhiều màu trong bảng mẫu bởi việc chỉ rõ một vùng đa giác trên hình ảnh , bạn cần phải sử dụng nút [image: image332.png]


.  Nếu bạn muốn lựa chọn một nhóm màu tương tự, hãy nhấn phải trên một màu cần thiết và lựa chọn một mức giống nhau 


*Những tùy chọn : 


-nút bảng mẫu thiết đặt tự động [image: image333.png]


: nhấn nút này bảng mẫu sẽ được tính toán tự động.


-Nút thiết lập lại bảng mẫu [image: image334.png]


 : thay đổi số màu trong bảng mẫu tới giá trị đầu tiêểntong hộp Color number


-Nút chọn màu từ hình ảnh [image: image335.png]




-Nút lựa chọn nhiều màu từ hình ảnh [image: image336.png]


 :sử dụng nút này bạn có thể lựa chọn những màu trong bảng mẫu bởi việc chỉ rõ một vùng đa giác trên hình ảnh raster. Nhấn đúp hoàn thành việc vẽ một vùng.


-Nút chọn màu từ hội thoại  [image: image337.png]




-Nút này cho phép bạn thay đổi một màu lựa chọn trong bảng mẫu tới mọi màu khác trong RGB - Space.  Nếu vài màu được lựa chọn chúng sẽ hòa trộn tới một.


-Nút hòa trộn màu [image: image338.png]


 :hòa trộn những màu lựa chọn trong bảng mẫu. Màu kết quả sẽ được gán giá trị màu trung bình. 


-Nút xóa màu [image: image339.png]


  Cho phép bạn xóa một hoặc nhiều màu lựa chọn trong bảng mẫu.


-Nút LUT load [image: image340.png]


 : Mở bảng mẫu từ một  file LUT.


-Nút LUT Lư​u trữ [image: image341.png]


:  Lưu bảng mẫu hiện thời cho một  file LUT.


-Hộp Highlight color : Trình bày màu điểm sáng và cho phép bạn thay đổi màu này.


-Hộp kiểm View selection:  Khi checkbox này bật, những màu lựa chọn trong bảng mẫu được chiếu sáng trong cửa sổ chính. Trước đấy một màu điểm sáng đại diện giá trị màu trung bình tính toán trên cơ sở tất cả các màu lựa chọn trong bảng mẫu. Thay đổi màu điểm sáng này, bạn cần phải kích vào vùng bên trái từ checkbox này.


-Nút Ok : chuyển đổi raster vào trong chỉ số hóa màu sử dụng bảng mẫu hiện thời.


-Nút Template:  lưu bảng mẫu cho một TPL - file. 


*Thực đơn ngữ cảnh khi kích vào một màu trong bảng mẫu


Thực đơn ngữ cảnh cho phép bạn lựa chọn trong bảng mẫu tất cả các màu tương tự như màu được chọn. Mức giống nhau phụ thuộc vào tùy chọn mà bạn chọn.


- Select index:

Lựa chọn màu hiện thời.


- Select low area:

Lựa chọn những màu t​ơng tự trong thấp vùng giống nhau.


- Select medium area:
Lựa chọn những màu tương tự trong vùng trung bình giống nhau 


- Select large area:
Lựa chọn những màu tương tự trong vùng lớn giống nhau.


Làm sao để chuyển đổi một hình ảnh raster vào trong chỉ số hóa màu tự động?


Từ thực đơn Image> Convert to..., > Convert to Indexed colors. Bạn có thể điều khiển sự chuyển đổi trên) cơ sở tính toán tự động bảng mẫu. Với điều này bạn cần phải sử dụng lệnh Color Classifier  thay vì lệnh Convert to Indexed colors. Bảng mẫu được tính toán tự động bởi việc nhấn nút thích hợp.  


b-Sự Giảm màu 


Giảm màu trong hình ảnh, gán màu của những phạm vi chỉ định của người dùng cho hình ảnh. Như vậy, một số màu thu được trong hình ảnh sẽ bằng số của những phạm vi chỉ rõ . Việc thiết đặt lệnh này tương tự như sự tách màu.


Để thiết đặt và thực hiện sự giảm màu :


1. Khởi động lệnh từ thực đơn Image > Color Reduction hoặc [image: image342.png]


 thanh công cụ image.


2. Tạo ra phạm vi thiết đặt, sử dụng nút tạo ra phạm vi. Nếu bạn muốn sửa đổi định nghĩa phạm vi hoặc xóa một phạm vi tạo ra do sơ suất, sử dụng delete và modify trong Categories.


3.  Nếu bạn chưa thỏa mãn với kết quả , hãy sử dụng phương pháp sau: biên tập phạm vi màu cơ sở hoặc thêm một màu mới, sử dụng nút Colors. Chú ý rằng bạn cần phải chỉ rõ một số đầy đủ của những màu cơ sở mô tả mỗi phạm vi. 


4. Khi bạn thỏa mãn, ấn nút apply.

3- Binarization


Tạo ra một hình ảnh đơn sắc từ một hình ảnh raster màu.


Những tùy chọn :


-Những Tab hộp thoại : ở đó hai Tab trong hội thoại Binarization : Range và threshold.


Range:Tab này được sử dụng cho binarization với ph​ơng pháp Range by Grey, Range by RGB, Hoặc Range by HSV. 


Những tùy chọn sau, áp dụng cho cả tab Threshold lẫn Ranges.


- Ranges: danh sách này cho thấy những màu trung tâm của những phạm vi mà bạn định nghĩa.  Để lựa chọn một phạm vi , hãy kích nó trong danh sách.


-By : Phụ thuộc vào bảng lựa chọn, danh sách này cho phép bạn lựa chọn một phương pháp binarization. Cho ví dụ, nếu bảng Range được lựa chọn, bạn có thể chọn Range by Grey, Range by RGB,hoặc Range by HSV.


- Channel: sự Sử dụng danh sách này để lựa chọn kiểu của kênh thông tin màu. Biểu đồ kênh được chọn hiển thị trong cửa sổ Histogram. Bộ xử lý màu sử dụng những kênh để trình bày thông tin về một hình ảnh màu. Những kênh tự động được tính toán khi một hình ảnh được xử lý. Số của những kênh cho phép phụ thuộc vào kiểu hình ảnh. Mỗi hình ảnh màu có năm kênh, một kênh Đỏ để cất giữ thông tin Đỏ, một kênh Xanh lục để cất giữ thông tin Xanh lục, một kênh Xanh để cất giữ thông tin Xanh, một kênh Màu sắc để cất giữ thông tin Màu sắc, và một kênh Xám để cất giữ thông tin về những thành phần Xám của màu. Một Một duy nhất những sử dụng hình ảnh greyscale làm xám đi kênh.


-Cửa sổ Biểu đồ (Histogram window): cửa sổ này trình bày biểu đồ hình ảnh màu hiện thời. Phụ thuộc vào phương pháp chuyển đổi, biểu đồ cho phép bạn điều chỉnh phạm vi hoặc giá trị mức threshold


- Layer : Định nghĩa một Lớp raster mới để mang kết quả của binarization vào.


- Noise Reduction : điều khiển thanh trượt nàốtc ảnh hưởng tới những chi tiết nhỏ của hình ảnh.  


- Colors : hộp này cho thấy những màu trung tâm của phạm vi mà bạn lựa chọn trong danh sách Ranges. Định dạng màu được hiển thị phụ thuộc vào phương pháp chuyển đổi hiện thời. Cho ví dụ, nếu bạn chọn Range by HSV, những màu được trình bày trong khuôn dạng sau : Giá trị H, giá trị S, giá trị V. 


-Công cụ Eyedropper : Để cho bạn chỉ định một phạm vi mới bởi việc lấy mẫu một màu từ một hình ảnh. Lấy mẫu một màu bởi việc kích nó trong cửa sổ ứng dụng của hình ảnh. Chương trình tạo ra một phạm vi mới sử dụng mẫu màu như màu trung tâm phạm vi.


-Công cụ Smart Eyedropper: Để cho bạn chỉ định một phạm vi mới bởi việc lấy mẫu một màu trung bình từ một hình ảnh. Lấy mẫu một màu bởi việc kích nó trong cửa sổ ứng dụng hình ảnh. Chương trình tính toán màu giữa  từ 9 pixel mà bạn pick và tạo ra một phạm vi mới sử dụng màu này như màu phạm vi trung tâm.


-Công cụ Area Eyedropper: Để cho bạn chỉ định một phạm vi mới bởi việc lựa chọn một vùng tự do trên hình ảnh. Nhấn nút này và kích đỉnh hình đa giác hoặc kéo chuột để vẽ ranh giới vùng trên hình ảnh. Nhấn đúp để hoàn thành sự chọn lọc. Chương trình tính toán một màu giữa từ vùng được chọn và tạo ra một phạm vi mới sử dụng màu này như màu phạm vi trung tâm.


- Delete : loại bỏ màu được chọn từ danh sách phạm vi 


-Apply : Chạy binarization.


- Template :  Cho phép bạn lưu giữ và khôi phục tất cả các tham số cho tất cả các phương pháp binarization.


+Tab Threshold : bảng này sử dụng cho binarization với ph​ơng pháp Threshold by Grey hoặc Threshold by RGB .


- Threshold : Trình bày giá trị ngưỡng hiện thời . Kéo thanh trượt thích hợp để thay đổi ngưỡng.


Để khởi động lệnh : Từ menu Image >Binarization.
hoặc kích nút [image: image343.png]


 trên thanh công cụ image.

4-Adaptive Binarization


Image > Adaptive Binarization...


Lệnh này đ​ợc thiết kế hiệu chỉnh  những hình ảnh raster có những đường màu trắng trên nền giấy xanh và nét vẽ có màu nâu đỏ trong kiểu Grayscale. Với lệnh này bạn có thể cải thiện những kết quả binarization.


Công cụ Adaptive Binarization kết hợp binarization làm sạch hình ảnh. Chương trình phân tích mức của vết loan do quá trình scan, xử lý vùng và làm hết sức để rút dữ liệu hữu ích. Lệnh thích hợp chỉ tới những hình ảnh grayscale. Công cụ này chỉ có ba điều khiển :


1. Radius : Thiết đặt bán kính mà trong đó chương trình phân tích mức của vết loan sẽ bị làm sạch.


2.Binarize: binarization sử dụng giá trị ngưỡng (Threshold). Phương pháp được sử dụng Threshold by gray được mô tả trong mục trước .


3. Smooth :  Làm nhẵn . Không có quy tắc chung để có kết quả tốt nhất trên hình ảnh riêng biệt.  khuyến cáo nê sử dụng kết hợp những điều khiển này.

5-Sự tách màu 


Phân ra những điểm hình ảnh vào trong một tập hợp của định nghĩa những phạm vi, khi đó những chỗ điểm của mỗi phạm vi sẽ lên trên một lớp đơn sắc riêng biệt.


Những tùy chọn :


Bạn chỉ rõ những thuộc tính phạm vi và những màu cơ bản trong những phạm vi và những màu của hội thoại Color Separation. Categories là một danh sách những phạm vi xác định từ đó bạn có thể lựa chọn một phạm vi, kích tên của nó, và những nút cho phép tạo ra, Sửa đổi, và Xóa những định nghĩa phạm vi. Colors trình bày một danh sách màu cơ sở của một phạm vi lựa chọn từ danh sách; có những nút cho phép cho thêm và xóa màu của một phạm vi được chọn. Chỉ định phạm vi ban đầu sử dụng nút Create category.


*Để thêm một phạm trù mới:


1. Kích Create category trong Categories [image: image344.png]


.


2. Chỉ rõ đối tượng trong hình ảnh, những dot nào cần phải thuộc bên trong phạm vi tạo ra. Hội thoại tên và màu lớp sẽ được trình bày. Bạn có thể chỉ rõ một phạm vi có tính chất tượng trưng màu và Tên. Theo mặc định hộp chỉ rõ màu tương xứng với màu điểm xác định và tên phạm trù  là LayerN, N là một số tự động phát sinh.  Nếu bạn muốn sửa đổi những tham số mặc định này, hãy nhập tên phạm trù để đặt tên và lựa chọn một màu từ bảng mẫu.


3. Kích OK.


Trong danh sách phạm vi, một phần tử mới xuất hiện, đó là định nghĩa phạm vi, và Trong danh sách màu, màu cơ bản đầu tiên ra phạm trù xuất hiện. Màu này trùng với màu chỉ trên điểm hình ảnh. Nếu bạn chỉ sai điểm khi chỉ rõ một phạm vi, xóa định nghĩa của nó hoặc sửa đổi màu và tên.


Để xóa một định nghĩa phạm vi


1. Lựa chọn một phạm vi từ danh sách.


2. Kích [image: image345.png]


.

Để sửa đổi màu và tên một phạm vi


1. Lựa chọn một phạm vi từ danh sách.


2. Kích nút [image: image346.png]


. Tên và màu lớp sẽ được trình bày.


3. Vào một tên mới trong Name và / hoặc lựa chọn một màu có tính chất tượng trưng từ bảng mẫu.


4. Kích OK.


Chú ý rằng thiết đặt phạm vi của những màu cơ bản chưa được thay đổi khi định nghĩa của nó được sửa đổi.


Để thêm một phạm vi màu cơ bản


1. Lựa chọn phạm vi đòi hỏi từ danh sách. thiết đặt hiện thời của những phạm vi màu cơ bản được chọn sẽ xuất hiện trong color.


 2. Kích nút [image: image347.png]


 và chỉ rõ một điểm trên hình ảnh. màu điểm sẽ được thêm tới danh sách


Để xóa một phạm vi màu cơ bản


1. Lựa chọn phạm vi từ danh sách. 


2. Kích [image: image348.png]


.


Thanh trượt giảm vết loan cho phép những điểm phân phối lại bởi những phạm vi bằng cách sửa đổi sự tách ra cho những đối tượng nhỏ. Tham số này sửa đổi độ trung bình màu khi tính toán điểm màu.


Để khởi động lệnh :


Từ thực đơn Image, hãy chọn Color Separation..
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 trên thanh công cụ hình ảnh.

6-Độ chói và tương phản


Điều chỉnh độ chói, tương phản, màu sắc, và sự bão hòa của hình ảnh màu.


-Brightness :Giá trị độ chói.


- Contrast: giá trị tương phản.


- Hue: Giá trị màu sắc.


- Saturation : Trị bão hòa.


- Reset : thiết đặt tất cả các giá trị tới zêrô.


Những tham số màu sắc và sự bão không hiệu lực khi điều khiển một hình ảnh trong kiểu grayscale. 


Để  thay đổi độ chói, tương phản, màu sắc, và sự Bão hòa.


1. Khởi động lệnh từ thực đơn hoặc thanh công cụ.


2. Vào một giá trị cho độ chói. Sử dụng cửa sổ xem trước để xem những hiệu ứng trước khi áp dụng chúng.


3. Vào một giá trị tương phản mới.


4. Vào một giá trị màu sắc mới.


5. Vào một trị bão hòa mới.


6. Kích OK.

Ghi chú :Sử dụng tham số độ chói để chiếu sáng hoặc làm tối một hình ảnh, và tham số tương phản để thay đổi sự cân bằng của những vùng ánh sáng và bóng tối trên hình ảnh.


Để khởi động lệnh : Từ thực đơn Image, chọn Brightness/Contrast.
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  trên thanh công cụ hình ảnh.

7-hiệu chỉnh bằng biểu đồ


+Hiệu chỉnh Gamma 


Đây là công cụ để tăng cường chất lượng toàn bộ hình ảnh . áp dụng giải thuật này thay đổi phân phối độ chói của những dot. 


Mỗi hình ảnh có dot sáng nhất ("white" dot) và tối nhất ("black" dot).  Giá trị Tia gam-ma định nghĩa dốc của nửa đường cong giữa màu đen và màu trắng. Sử dụng công cụ này bạn có thể làm cho những dot nằm trong phạm vi xác định của độ chói sáng hơn hoặc tối hơn. Bạn có thể cũng tác động độ chói của những màu Đỏ, Xanh hoặc Xanh lục.


Để thay đổi mặt cắt màu:


Kích [image: image351.png]


 trên thanh công cụ Color  hoặc chọn Gamma Correction từ thực đơn Color.


Hộp thoại hiển thị, chỉ rõ điểm Màu trắng và Màu đen sử dụng những công cụ eyedropper. 


Chọn Master hoặc chỉ rõ một màu trong danh sách Channel . Tạo ra đường cong Tia gam-ma tự động hoặc điều chỉnh nó bằng tay  


Kích Apply


*Chỉ rõ những dot trắng và đen:


Sử dụng những nút [image: image352.png]
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 để pick giá trị dot đen hoặc trắng tương ứng trực tiếp từ hình ảnh. Mục Color point của hội thoại cho phép bạn điều chỉnh những giá trị màu chính xác.


Nếu bạn thiết lập trong mục này giá trị khác ( 0,0,0) cho Màu đen và / hoặc ( 255,255,255) cho Màu trắng, những dot bên ngoài phạm vi xác định sẽ không bị ảnh hưởng với thủ tục hiệu chỉnh Tia gam-ma.


Nút Autoset [image: image354.png]


 tính toán những giá trị của dot trắng và đen tự động cho mỗi kênh màu. Biểu đồ trong cửa sổ hội thoại phản ảnh phân phối độ chói màu. Bạn có thể thay đổi đường cong cho mỗi kênh riêng rẽ.


Kích [image: image355.png]


 để thiết lập lại đường cong tia gam-ma.


*thay đổi đường cong tia gam-ma :


Có ba phương pháp để thay đổi hình dạng của những đường cong tia gam-ma và đường cong chủ cho kênh riêng lẻ.  Những phương pháp này được liên hệ qua lại.


1.Chọn hoặc bỏ chọn hộp kiểm S-Curve . Đây là mẫu đường cong tia gam-ma luôn luôn đối xứng xung quanh điểm trung tâm của phạm vi phân phối. Điều này ngụ ý rằng thêm độ chói vào những vùng tối là tự động làm tối những vùng sáng tới cùng phạm vi đó và kết quả nhìn cân bằng hơn trong độ chói .  Nếu S-Curve không chọn bạn có thể tạo ra đường cong tia gam-ma, thì  thay đổi toàn bộ cân bằng độ chói trong hình ảnh 


2.Nhập giá trị trong hộp Gamma . Điều này làm thay đổi dốc của những đường cong.


3.Kéo những đường cong hoặc những đường cong chủ cho kênh riêng lẻ trong cửa sổ biểu đồ.


Khi Master được lựa chọn trong danh sách Channel, tất cả các đường cong đều được hiển thị  



Khi bạn đặt con trỏ chuột qua đường cong bạn nhìn thấy một dot dày có thể kéo thay đổi đường cong. Trong khi giữ con trỏ chuột qua đường cong, bạn có thể nhìn thấy phân phối thực tế của độ chói những màu trên hình ảnh.


Để thay đổi những hình dạng của những đường cong kênh Đỏ, Xanh hoặc  Xanh lục , hãy lựa chọn tên màu tương ứng từ danh sách Channel .



Trên vài hình ảnh, bạn có thể " Chia ra từng phần " đường cong tới thành phần Đỏ, Xanh hoặc xanh lá cây bởi việc nhấn nút Autoset [image: image356.png]



Để khởi động lệnh : Từ thực đơn Image,chọn Gamma Correction.


+Equalize ( Sửa chữa bởi biểu đồ) 


Điều chỉnh chính xác độ chói, màu sắc, và độ tương phản của một hình ảnh bằng tay và tự động.


Những tùy chọn :


-Channel: Cho phép lựa chọn biểu đồ cho mỗi thành phần màu : Đỏ, Xanh lục, Xanh. Kênh chủ được làm phân phối độ chói điểm.


-Histogram: Trình bày số trung bình của những điểm, tương xứng với mỗi giá trị độ chói.


-Level markers  ( trong phần dưới cửa sổ biểu đồ ): Đặt những giá trị ngưỡng 


-Left marker - Giá trị trái.


-Middle marker -Giá trị giữa .


-Right marker-Giá trị phải


-Levels: Thiết đặt những giá trị ngưỡng số.


-Reset: Thiết lập lại những giá trị mặc định của ngưỡng và tia gam-ma.


-Auto: Cho phép tự động ước lượng những mức ngưỡng  và tia gam-ma  .
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 Cho phép pick những màu, định nghĩa ngưỡng và tia gam-ma từ hình ảnh. Giải thuật yêu cầu chỉ rõ hai mức độ chói và tia gam-ma  hình ảnh định nghĩa vị trí  tương đối giá trị độ chói giữa tới giá trị ngưỡng hiện thời. 


Lệnh có thể được áp dụng tới vài hình ảnh một lúc


Để sửa chữa một hình ảnh bởi biểu đồ :


1. Khởi động lệnh từ thực đơn Image >Equalize. hoặc [image: image358.png]


 thanh công cụ Image.


2. Lựa chọn một biểu đồ tương xứng với thành phần màu sẽ được sửa chữa.


3. Chỉ rõ giá trị độ chói tối nhất và những điểm sáng nhất, và cho tia gam-ma hình ảnh. Sử dụng Levels hoặc eyedroppers. Sử dụng thanh trượt để điều chỉnh chính xác. Cửa sổ xem trước trình bày một bộ phận của hình ảnh. Sử dụng những công cụ điều khiển xem trước, bạn có thể điều chỉnh những tham số sửa chữa tối ưu. 


4. Kích Apply


Lệnh có thể được sử dụng nhiều thời gian trên cùng hình ảnh đó cho đến khi hiệu ứng được đạt yêu cầu.

viii-Clip


Clip là thao tác định nghĩa phân miền trên hình ảnh. Nếu bạn lưu trữ một hình ảnh với vùng clip trong file CWS và mở nó,chỉ duy nhất một phần clip được tải, như vậy giảm bớt thời gian tải và bộ nhớ máy tính.  Những thao tác như lọc và tracing có thể được áp dụng chỉ bên trong ranh giới clip . Bạn cũng có thể sử dụng vùng clip để cắt ( crop) .


Thực đơn con image> image clip chứa đựng những lệnh sau : 

[image: image359.png]


 Hủy vùng clip
[image: image360.png]


 Thiết lập vùng clip chữ nhật

[image: image361.png]


 Thiết lập vùng clip đa giác

chương 9 :chuyển đổi (raster to vectorr)

i-trace


Chương này mô tả những phương tiện và những công cụ vạch dấu - một thủ tục tương tác mà cho phép bạn tạo ra những vectơ từ một hình ảnh raster, và để làm nhẵn hoặc xóa những đối tượng của một hình ảnh raster đơn sắc.


Trace dựa vào công nghệ đoán nhận cục bộ thuộc hình học của những thực thểraster. Sử dụng công nghệ này, chương trình xác định những đường raster như một line, arc hoặc circle, và phát sinh những đối tượng vectơ thích hợp. Bạn pick những đối tượng raster trên hình ảnh, và chương trình tạo ra những đối tượng vectơ  xấp xỉ những đối tượng được chọn .


Ph​ơng pháp này cho phép bạn thêm sức mạnh và tính linh hoạt vào quá trình chuyển đổi tự động. Khi trace bạn có thể phân loại chiều rộng line của những đối tượng raster, thay đổi chỉ những cái cần thiết và chuyển những kết quả đến những lớp.


Trace có thể làm việc trên những hình ảnh màu hoặc gray-scale, và  đơn sắc. Bạn Có thể Vectơ những đường , những cung, những vòng tròn, và những đường cong tùy ý ( polylines).


Khi xử lý những hình ảnh, trace có thể sử dụng để chuyển đổi những đối tượng raster tới vectơ , và làm trơn, xóa chúng. Phụ thuộc vào kiểu xác định trace, đối tượng raster là bị xóa sạch, hoặc để lại nguyên vẹn trên hình ảnh. Như vậy, có thể thay đổi một đường raster tới đối tượng vectơ hoặc chỉ tạo ra một sự sao chép vectơ của một đường raster. Bạn có thể đặt kiểu trace nào không tạo ra những đối tượng vectơ vì vậy phải xóa chúng. Và có kiểu khác tự động thay thế một line raster bởi số hóa đối tượng raster .


Trên những hình ảnh đơn sắc, bạn có thể trace những đường, cung, vòng tròn, hacth, ký hiệu, và những đường cong tự do ( raster polylines) và những đối tượng vùng như polylines đóng. Trên những hình ảnh màu và grayscale bạn có thể trace tất cả các kiểu đối tượng trừ những hacth và symbol.

1-trace tự động


Phương pháp này được sử dụng để trace những thực thể raster của bốn kiểu : line, arc, outline và circle.


Khi trace trong kiểu tự động bạn chỉ rõ một điểm trên một đường raster, và chương trình tự động lựa chọn kiểu đối tượng vectơ ( đường, cung hoặc vòng tròn) thích hợp và xác định đối tượng. Nếu đối tượng cho biết không tương đồng, và chiều rộng của nó vượt hơn giá trị chỉ rõ trong Max Width, chương trình tạo ra polyline đóng với outline của đối tượng.


Những thực thể raster là những đối tượng raster có cùng mẫu (hình dạng) đó như những đối tượng vectơ cơ sở ( những đường, những cung, và vòng tròn). Chúng ta sẽ sử dụng những thuật ngữ raster circle, raster arc và raster line  để gán cho những đối tượng raster có hình dạng của một vòng tròn, cung và đường. Những thực thểraster có thể cũng được định nghĩa tương tự như những đối t​ợng vectơ, ví dụ, trong thời gian việc trong một bản vẽ vectơ, chúng ta thu được kết quả raster tương ứng của những vectơ. Chú ý rằng những thực thể raster, thực tế có thể có những khuyết tật , gây khó khăn cho sự nhận dạng bởi chương trình, cho ví dụ, những sự gãy, hình bầu dục của những vòng tròn và những cung, đường với những độ lệch, vân vân. 

Khi trace một line raster bởi việc pick, chương trình xác định kiểu một thực thể raster (đường, cung hoặc vòng tròn) và cố gắng vạch theo đối tượng tới phạm vi có thể lớn nhất. Những sự giao nhau của một thực thể với những đối tượng khác được lờ đi, và tập hợp những điểm đại diện đối tượng được mở rộng miễn là mẫu (dạng) của những đối tượng raster so khớp với thực thể được thừa nhận. Khi những đối tượng raster thực tế khác những thực thể raster lý tưởng, giải thuật đoán nhận sử dụng tham số chính xác xấp xỉ để thiết đặt mức được công nhận của sự lệch giữa những đối tượng raster thực tế với một mẫu (dạng) lý tưởng. 


Khi  trace một thực thể raster , những sự giao nhau của nó với những đối tượng khác được duy trì . Nếu dữ liệu raster lựa chọn trong thời gian trace đã bị xóa, những đối tượng raster còn lại vẫn không bị đứt gãy. Điều này cho phép để thay thế những đối tượng raster với vectơ mà không thay đổi mẫu (dạng) của những đối tượng raster khác, và xóa đối tượng raster như là vectơ. Cho ví dụ, nếu một line raster cắt ngang một vòng tròn đã bị xóa, thì vòng tròn còn lại vẫn nguyên vẹn hình ảnh trong khi bạn đã xóa một line vectơ  “giả” qua một vòng tròn vectơ.


Để trace một đối tượng với sự đoán nhận kiểu tự động:


Chọn Trace Auto từ thực đơn Trace hoặc kích nút [image: image362.png]


 trên thanh công cụ Raster to Vector.


Kích vào một đối tượng raster bắt đầu trace.


Bạn cần phải pick một điểm trên phần ít bị méo nhất và đoạn dài nhất của đối tượng raster, xa những vị trí giao nhau của nó với những đối tượng khác.


Nếu chương trình đoán nhận một thực thể raster, thì đối tượng sẽ được trace sử dụng kiểu đối tượng thích hợp nhất. Nếu sự đoán nhận thất bại, chương trình phát tiếng bíp.


Nếu đối tượng xác định không phải là một đường, cung hoặc vòng tròn raster, Một vectơ outline xấp xỉ sẽ được tạo ra. 

2-trace bắt buộc(thủ công)


Cho phép thay thế những đối tượng raster với vectơ, một trong những số xác định được kiểu. Bạn lựa chọn một trong ba kiểu đối tượng sẽ được sử dụng như những đối tượng tham khảo cho sự vạch dấu ( đường, cung hoặc vòng tròn), và chỉ rõ những điểm trên một đối tượng raster để vẽ một thực thể vectơ ở trên thực thể raster. Sự vạch dấu của Hacth và Symbol có thể cũng được thực hiện như sự vạch dấu bắt buộc. Chương trình cố gắng vạch theo đối tượng xác định với một hình vectơ của kiểu được chọn (đường, cung, vòng tròn...). Nếu được, đối tượng raster được vạch dấu. Không giống phương pháp tự động, phương pháp này cho phép trace một bộ phận của một thực thể raster cũng như những thực thể với sự biến dạng quá lớn.

 Nếu trong thời gian trace bắt buộc, những thực thể raster đã bị xóa ( Trace kiểu chuyển đổi thành vectơ và xóa bỏ raster), thì những đối tượng raster cắt ngang bởi chúng vẫn không bị gãy đứt. Những tham số Approximation, Max width và Max break ảnh hưởng những phương pháp này.  Nếu chiều rộng đối tượng lớn hơn giá trị tham số chiều rộng Max hoặc mẫu (dạng) của nó không giống một đối tượng của kiểu xác định, thì sự vạch dấu chưa được thực hiện.


Khi trace bởi những phương pháp line và Arc, những vị trí cuối ( cả hai điểm hoặc một trong hai điểm mút) của những line và cung tham chiếu có thể được chỉ ở ngoài (bên ngoài, trên phần mở rộng của nó) đối tượng để được vạch dấu. Trong trường hợp này một đối tượng raster được vạch tới những điểm mút của nó. Nếu bạn muốn WiseImage thừa nhận phần mở rộng của đường tới những giới hạn tự nhiên của nó, bật checkbox Auto Extend vectors trong Tab Trace của thực đơn Conversion options ( Xem phần sau). 

+Trace một line


1. Chọn Trace Line từ thực đơn Trace hoặc kích nút [image: image363.png]


 trên thanh công cụ Raster to Vector.

 
2.Chỉ rõ hai điểm, vẽ một đường “phủ “ trên đối tượng raster sẽ được đánh dấu. Nếu chương trình không thể đoán nhận một đối tượng ở dưới line vectơ, nó phát tiếng bíp.


+Trace một cung


1. Chọn Trace Arc từ thực đơn trace hoặc kích nút [image: image364.png]


 trên thanh công cụ .


2.Chỉ rõ điểm đầu, giữa và cuối của cung qua đối tượng raster sẽ được trace.


3. Để trace cung khác, hãy lặp lại bước 1, 2.


+Trace  một vòng tròn


1. Chọn Trace Circle từ thực đơn hoặc kích nút [image: image365.png]


 trên thanh công cụ .



2.Chỉ rõ hai điểm - những điểm mút đường kính của một vòng tròn raster sẽ được trace


3. Để trace vòng tròn tiếp theo, lặp lại bước 1 ,2.

3-trace outline


Lệnh này tạo ra một polyline tạo ra đường viền của đối tượng hoặc vùng phụ thuộc vào một điểm xác định .


Khi làm việc với lệnh này tất cả các kiểu trace đều có sẵn   


Lệnh này làm việc trên những hình ảnh trong tất cả kiểu màu ( đơn sắc, được chỉ số hóa, RGB); nó cho phép đánh dấu bất kỳ những đối tượng và những vùng raster nào.


Nếu lệnh chạy trên những hình ảnh màu ( grayscale, 8-bit, 24-bit), bạn thu được đường viền của một hoặc vài vùng màu kín. Tham số Color Accuracy ảnh hưởng sự tán sắc màu.


Với lệnh Trace Auto [image: image366.png]


, bạn có thể cũng vạch dấu những đối tượng đặc và thu được những đường viền của nó, tuy nhiên  kết quả bị ảnh hưởng đáng kể bởi kiểu và kích thước đối tượng, mặc dù đã thiết đặt tham số Max Width bằng 0


Để sử dụng lệnh Trace Outline:


1) Chọn lệnh từ thực đơn


2) Chỉ rõ một điểm bên trong đối tượng trên hình ảnh raster


Những tham số sau ảnh hưởng sự thực hiện lệnh :


-Export single contour( những tùy chọn chuyển đổi): lờ đi  những đường viền gửi kèm, , một đường viền đơn được tạo ra.



-Linefollowing orthogonalization: Bật trực giao của những đoạn polyline do sự thực hiện lệnh. 



-Auto extend vectors: nếu tham số này bật khi trace đường viền mở rộng . Chú ý tham số Max Width cần phải được chỉ rõ chính xác.


-Color Accuracy :Điều khiển sự chính xác thực hiện lệnh trên những hình ảnh raster màu.


Để khởi động lệnh : Từ thực đơn Convert , chọn Outline.

hoặc  kích nút [image: image367.png]


 trên thanh công cụ Raster to Vector
4-trace symbol


Phương pháp vạch dấu ký hiệu cho phép trace bởi việc pick raster tương tự những đối tượng định nghĩa mẫu có sẵn. Sự đoán nhận ký hiệu chỉ có thể được sử dụng trên những hình ảnh đơn sắc.


Thủ tục đoán nhận ký hiệu được mô tả trong mục “ Huấn luyện sự Đoán nhận những ký hiệu ”.


Để trace một ký hiệu raster:


1.Chọn Symbol từ thực đơn Trace hoặc kích nút [image: image368.png]


 trên thanh công cụ .


2.Chỉ một điểm trên ký hiệu raster.

5-Trace Hatch


Kiểu trace này cho phép vạch theo một Hatch raster gồm có những đường thẳng raster song song, giới hạn bởi đường viền đóng .


Với trace Hatch bạn cần vẽ một polyline chéo qua tất cả các đường raster của Hacth. Chơng trình tìm thấy ranh giới của  vùng và tạo ra Hacth.


Sự đoán nhận Hacth có thể chỉ được sử dụng trên những hình ảnh đơn sắc.


Để thực hiện: 


1. Chọn Trace Hatch từ thực đơn Trace hoặc kích nút [image: image369.png]


 trên thanh công cụ .



2.Chỉ rõ các đỉnh của polyline chéo qua tất cả những đường raster của Hatch .


3.Nhấn đúp để thực hiện.

[image: image370.png]


   [image: image371.png]



6-Tracing polylinesxe "Polyline:tracing"

xe "Tracing:polylines" 


Phương pháp này cho phép vạch những đường tùy ý giống như polyline. Khi thực hiện vạch theo bạn chỉ rõ một điểm trên line raster , và chương trình tìm line tự động vạch theo line raster xác định tới nút gần nhất hoặc điểm giao nhau, và tạo ra một vectơ poly line gồm có các  đoạn thẳng. Nút của một line raster là mọi điểm mút của nó, hoặc một điểm mà line raster cắt chéo qua đối tượng raster khác. Trong một động tác vạch đơn giữa hai lần kích chuột kích ( được gọi bước trace) Bạn trace một tập hợp của các đoạn polyline. Một bước trace có thể chứa một số  đoạn riêng biệt, phụ thuộc vào những sự thiết trace và mức độ phức tạp của đường.


Sau mỗi bước trace bạn cần phải chọn hướng để trace tiếp theo, hoặc hoàn thành lệnh. Nếu khi trace polyline cắt qua chính nó, sự vạch dấu sẽ tự động hoàn thành. Bạn có thể chọn hướng bởi việc chỉ rõ một điểm trên bộ phận của line raster kề bên tiếp theo. Bạn cho phép những tùy chọn để làm lại bước trace trước đấy (Trừ bước đầu tiên), và đoạn polyline cuối cùng trong một bước.


Bạn có thể bật kiểu autodetection (tự động dò trìm) của việc trace phương hướng mở rộng ( xem Tab trace trong hội thoại Conversion Options ). Trong kiểu này chương trình đề nghị một hướng có thể, hiển thị một trace đặc biệt trên phần mở rộng. Bạn có thể lựa chọn hướng khác trong bất kỳ thời gian nào ( Theo mặc định kiểu chờ là Off ), hoặc dựa vào trace mở rộng tự động. Nếu bạn không chọn bất kỳ hướng nào, sau thời gian chờ, chương trình sẽ tự động tiếp tục trace trong phương hướng chọn.


Khi trace raster polylines bạn có thể sử dụng kiểu trực giao. Nó cho phép bạn sắp thẳng hàng các đoạn thẳng thu được bởi góc cơ sở.


Thông tin chi về kiểu trực giao polyline được cung cấp trong mục“ Tab trace ” 

Trace polylines Raster cũng bị ảnh hưởng bởi những tham số  Max Width, Max Break  và Approximation Accuracy 

Thông tin chi tiết hơn về những tham số này được cung cấp trong mục “ Tab Option ", 

Khi trace polylines bạn có thể sử dụng vài tùy chọn có trong thực đơn cursor trong lúc làm việc  như sau.

	Option
	Description

	Cancel
	Hủy bỏ phiên hiện thời ; tất cả polyline tạo ra đã bị xóa. Sau khi kết thúc việc trace bạn có thể huỷ kết quả, áp dụng lệnh Undo từ Edit menu.

Bạn có thể cũng hủy bỏ bằng nhấn  ESC.

	Start in Directionxe "Direction of linefollowing tracing"

xe "Tracing:direction"
	Có thể được sử dụng sau khi kích hoạt phương pháp vạch theo đường. Nếu được chọn, hiệu lực để xử lý trước hết kích hai điểm trên raster line được trace để định nghĩa phương hướng của polyline tạo ra

	End
	Chấm dứt sự vạch dấu; Để trace tiếp theo cần phải kích hoạt  phương pháp lần nữa.

	Back Step
	Hủy bỏ bước trace gần đây nhất .

	Back Segmentxe "Backsegment"
	Hủy bỏ đoạn polyline gần đây nhất 

	Force Segmentxe "Line:linefollowing tracing "
	Cho phép thêm một đoạn tuyến tính thẳng vào polyline mà không có sự trace

	Change Directionxe "Center, linefollowing tracing "
	Đảo ngược phương hướng trace. 

	Pan to Center xe "Redraw Center "
	Zooms hình ảnh để cho thấy đỉnh polyline bổ sung lần cuối đặt đúng tâmtrong màn ảnh 


Bây giờ chúng ta sẽ mô tả chi tiết thủ tục trace polyline mà không có autodetection (tự động dò tìm) 


Để trace một polyline:


1.Chọn Line follow từ thực đơn Trace hoặc nút [image: image372.png]


 trên thanh công cụ.


Nếu bạn muốn quan sát sự trace xử lý, pick tương phản Color trong cửa sổ Inspector cho một polyline tạo ra và chắc chắn rằng checkbox AutoDetect Direction trong Tab Trace của hội thoại Conversion Options là off.


2.Chỉ vào bất kỳ điểm nào trên line raster.


WiseImage đánh dấu phần vừa pick đến những điển mút hoặc những điểm nút giao.


Chương trình tự động xác định phương hướng vạch dấu. Đường cao su (rubber line)được kéo từ chuột cursor cho biết vị trí hiện thời trace.

[image: image373.png]
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3. Để trace bộ phận của line raster tiếp theo trong phương hướng hiện thời, hãy chỉ một điểm trên nó. WiseImage trace một line raster tới nút gần nhất. hoặc để thay đổi hướng vạch dấu, hãy lựa chọn Change Direction  từ thực đơn cursor 


Để tạo ra một đoạn polyline tuyến tính bằng tay( không trace theo line raster), hãy lựa chọn tùy chọn Force Segment. Rồi pick một điểm. đoạn line sẽ liên kết điểm cuối cùng trace với điểm đó.

Tùy chọn này cho phép loại bỏ những sự đứt gãy của một line raster

[image: image375.png]
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 Đoạn tuyến tính


4.Lặp lại bư​ớc 3 cho đến khi bạn hoàn thành đánh dấu một line raster.

 Nếu bạn không được thỏa mãn, thì sử dụng những tùy chọn Back Step và Back Segment để hủy bỏ những bước đã thực hiện trước đây. 


WiseImage tự động dừng sự vạch dấu một polyline, nếu trước đó tạo ra đọan polyline chéo qua mọi đoạn polyline khác, hoặc nếu đỉnh của đoạn gần đây nhất được định vị gần đỉnh đầu tiên của cùng polyline, trong trường hợp này một polyline đóng được tạo ra, và sự vạch dấu được hoàn thành.


5.Để dừng việc đánh dấu nhấn ENTER.


Khi vạch dấu polylines với phương hướng tự dò tìm, chương trình thử xác định phương hướng trace, vẽ một vạch dấu gợi ý trên line raster mở rộng ( chữ thập màu hiện thời).


Nếu bạn nhấn Space, thì sự vạch dấu tự động tiếp tục theo hướng chương trình đã chọn. Bạn có thể cũng lựa chọn hướng khác bởi việc chỉ rõ một điểm trên bộ phận của raster. 

 
Nếu chương trình không xác định một phương hướng tự động, thì bạn sẽ được nhắc để chỉ một hướng, và tiếp tục thao tác trong kiểu dò tìm tự động.


Khi trace polylines, có thể chia ra nhiều cửa sổ tài liệu thành hai hoặc bốn, đặt những giá trị zoom khác nhau trong mỗi cửa sổ; bạn có thể nhìn trong cửa sổ cả toàn bộ bức tranh lẫn chi tiết. Những lệnh tạo cửa sổ được mô tả các phần trước.


Bạn có thể tập hợp lại vài hình ảnh sử dụng lệnh Group từ thực đơn edit. Giải thuật linefollowing trong trường hợp này ” Nhảy ”  Từ điểm cuối của line trên một hình ảnh đến điểm tiếp tục trên một ảnh khác, tạo ra một polyline đơn dựa vào vài nguồn raster. Điều này chỉ có thể thực hiện được nếu những hình ảnh trong nhóm có cùng giá trị DPI .


 Nếu hình ảnh được clip, thì linefollowing dừng ở tại ranh giới clip. 

Nếu những hình ảnh đơn sắc gối chồng lên nhau , thì sự vạch dấu bắt đầu và tiếp tục trên hình ảnh mà được kích trước tiên. Polyline được trace trên hình ảnh đó lờ đi những sự giao nhau với những đối tượng raster trên những hình ảnh khác. Nếu những hình ảnh gối lên nhau là lập thành nhóm bỡi lệnh Group, sự vạch dấu được thực hiện giống như những hình ảnh được hòa trộn. Polyline được trace xem xét tất cả các sự giao nhau nhìn thấy.

7-các kiểu trace:


Kiểu vạch dấu định nghĩa một thao tác làm trên đối tượng raster nguyên bản và sản sinh đối tượng vectơ.


Sự vạch dấu có thể sử dụng tạo ra những đối tượng vectơ ( Tạo ra vectơ và giữ raster), xóa những đối tượng raster trong khi tạo ra vectơ ( Tạo ra vectơ và xóa bỏ raster) , xóa những đối tượng raster ( xóa bỏ raster mà không tạo ra vectơ), và để làm nhẵn  ( làm mịn Raster không tạo ra vectơ). Kiểu được chọn hoạt động cho đến khi bạn lựa chọn kiểu khác.

a-Tạo ra Vectơ và giữ lại Raster 


Kiểu này được sử dụng theo mặc định.


Kích nút [image: image377.png]


 trên thanh công cụ hoặc từ thực đơn Trace lựa chọn Vector (keep raster).. 

b-Tạo ra Vectơ và xóa bỏ Raster 


Kích nút [image: image378.png]


 trên thanh công cụ Vectơ hoặc từ thực đơn Trace lựa chọn Vector (erase raster).

c-Xóa bỏ Raster mà không tạo ra Vectơ 


Những sự loại bỏ kiểu này đánh dấu những bộ phận của một line raster và không tạo ra những vectơ. Những sự giao nhau hoặc bộ phận của những đối tượng raster khác ở dưới vạch dấu dữ liệu được để giữ lại.


Kích nút [image: image379.png]


 trên thanh công cụ hoặc từ thực đơn Trace lựa chọn Erase raster.


d-Làm nhẵn Raster


Kiểu này loại bỏ những bộ phận của một line raster , tạo ra một vectơ, và sau đó tự động thành những raster. kiểu này cho phép bạn sửa chữa những line raster.


Kích nút [image: image380.png]


 trên thanh công cụ hoặc từ thực đơn Trace lựa chọn Smooth raster.


8-Sự điều chỉnh trace


Bạn có thể điều khiển thủ tục điều chỉnh trace sử dụng hộp thoại Conversion Options
Sự điều chỉnh được thực hiện trong Tab Option và Trace. Sự vạch dấu cũng bị ảnh hưởng bởi những tham số của Tab Separate và Symbols , được mô tả trong mục " Thiết lập những tùy chọn đoán nhận ký hiệu ” 


1.Chọn Conversion Options từ thực đơn Convert hoặc kích nút [image: image381.png]


 trên thanh công cụ 


2.Chọn Tab Option.
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3.Chỉ rõ những tham số mới bởi việc vào những giá trị hoặc sử dụng thước đo trên hình ảnh, và kích OK.

9-Mô tả những tham số trace

Tab Options

	Tham số
	Mô tả

	Min Length
	định nghĩa kích thước tối thiểu của đối tượng raster mà có thể được đoán nhận.

	Max Width
	định nghĩa chiều rộng cực đại của những line raster 

 Nếu chiều rộng của một line raster lớn hơn Max width, thì đánh dấu với một đường viền đối tượng.

	Max Breakxe "Break:ignoring"
	Thiết đặt độ dài cực đại bỏ qua trong những line raster. 

 Nếu một line raster bị gãy thành nhiều phần và bạn muốn trace trọn vẹn đường này, hãy đặt giá trị của sự gãy cực đại lớn hơn khoảng hở cực đại giữa trong raster. Chương trình sẽ lờ đi những sự gãy và tạo ra một đối tượng vectơ. 

	Text Height
	Xem sự mô tả tham số này trên trang sau

	Arrow Size
	Chiều rộng và độ dài của đối tượng phải được đoán nhận như đầu mũi tên ở lúc cuối của đối tượng đường. Để chỉ rõ những kích thước của arrowhead, vào những giá trị tách ra bởi dấu phẩy hoặc nhấn nút đo và vẽ ranh giới hình chữ nhật xung quanh mũi tên.

	Approximation Accuracy
	xác định sự chính xác của việc “xấp xỉ” đối tượng raster nguyên bản với một vectơ . Nếu hình ảnh nguyên bản bị bóp méo, chẳng hạn những vòng tròn có dạng như những hình ê-líp, bạn cần phải giảm bớt giá trị tham số Approximation Accuracy. Tuy nhiên, điều này dẫn tới những sự không chính xác trong sự đoán nhận, ví dụ, chương trình có thể hiểu một cung ngắn thành một line.  Khi chất lượng của một hình ảnh raster cao, bạn có thể tăng giá trị  tham số này. Đôi lúc trước khi trace chất lượng hình ảnh raster có thể được cải thiện bởi ứng dụng làm nhẵn

	Orthogonalizationxe "Orthogonalization"
	Nếu tùy chọn này bật, thì những sự vạch dấu trong kiểu auto và line sẽ sắp thẳng hàng tạo ra những đoạn hoặc thẳng đứng hoặc song song với phương cơ sở nếu độ lệch của đối tượng từ những phương này không quan trọng. độ lệch công nhận được xác định tự động bởi giá trị tham số Approximation Accuracy.

	Base anglexe "Base angle"

xe "Angle"
	Vào một góc chỉ rõ phương  cơ sở của hướng trực giao. hoặc kích nút đo và chỉ rõ hai điểm trên hình ảnh. 


b- Tab Trace


Bảng này đại diện những tham số điều khiển thủ tục vạch dấu của polylines, mô tả trong các phần trên 
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	Tham số
	Mô tả

	Line Follow Orthogonalizationxe "Orthogonalization" 
	Nếu tùy chọn này bật, thì line sai khi vạch dấu tự động sắp thẳng hàng từng đoạn tạo ra polylines thẳng đứng. Những đoạn trở thành hoặc thẳng góc hoặc song song tới góc cơ sở, nếu chúng không nghiêng nhiều so phương h​ớng này. Góc cơ sở được thiết lập trong hộp Base angle của tab Option. Nếu checkbox Auto đã bật, thì chương trình tự động định nghĩa góc cơ sở bởi phương kéo dài của đoạn polylines. Approximation Accurac thiết đặt trong Tab Option điều khiển góc cực đại của những đoạn so với góc cơ sở mà rơỏca khỏi đường trực giao . Bạn có thể sử dụng tùy chọn này khi trace raster gồm có đường thẳng góc, cho ví dụ, vạch dấu bản vẽ xây dựng.


	Auto estimate base angle
	Đặt kiểu để chương trình tự động định nghĩa phương cơ sở của đoạn polyline trực giao. Góc cơ sở cho mỗi đánh dấu polyline được định nghĩa riêng rẽ.

	Base Angle
	Vào một góc chỉ rõ phương cơ sở của trực giao. hoặc kích nút đo và chỉ rõ hai điểm trên hình ảnh. Auto estimate base angle  có quyền ưu tiên cao hơn tùy chọn này



	Auto Detect Directionxe "Auto Detect Direction"

xe "Tracing:direction"
	Thiết đặt cơ chế của việc định nghĩa phương hướng của phương hướng trace bởi chương trình. Sau khi thực hiện đến điểm nút, nó cố gắng tìm thấy phần line raster sau, là một mở rộng của trace đối tượng.

	Pausexe "Pause when tracing"
	Thiết đặt một thời gian tính bằng giây, trong thời gian đó bạn cần phải chọn một đoạn để mở rộng phạm vi vạch dấu khi kiểu Auto Detect Direction của việc đánh dấu mở rộng đã bật. Trừ phi người dùng chỉ rõ bằng tay, chương trình sẽ tiếp tục trace trong phương chọn tự động.


	Place vertexxe "Vertices" on nodes
	Nếu checkbox này đã bật, chương trình chèn đỉnh polyline ở tại những sự giao nhau của một vectơ polyline phát sinh với những đối tượng raster ( những nút).



	Auto Extend vectors
	Đặc tính này đơn giản hóa sự chọn lọc và sự vạch dấu bắt buộc của những cung và những đường. Trong khi đoán nhận một line bạn có thể kích hai điểm riêng biệt trên nó; và WiseImage tự động mở rộng line kết quả tới endpoints của nó. Trong khi đoán nhận một cung bạn có thể kích ba điểm riêng biệt trên  nó; và WiseImage tự động mở rộng cung kết quả tới endpoints của nó.


	Export single contour
	Nếu checkmark đã bật, thì sự vạch dấu tạo ra đường viền ở phía ngoài của đối tượng. Nếu checkmark tắt, thì sự vạch dấu kẻ đường viền và một đường bên trong, nếu ở đó có những “lỗ ” trong đối tượng raster.



10-điều khiển thuộc tính đối tượng tạo ra



Sử dụng Tab Separate của hộp thoại Conversion Options  bạn có thể điều khiển những thuộc tính của những đối tượng vectơ tạo ra : xác định chiều rộng đối tượng vectơ thu được, vị trí đối tượng vectơ, tương ứng với line raster từ phạm vi chiều rộng xác định trên  những lớp mới và / hoặc gán màu những đối tượng tạo ra .
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Use table: Nếu checkbox này chọn, chương trình đặt những đối tượng trên lớp, thì chiều rộng của line được thiết đặt bởi những giá trị bảng.

New interval xe "Interval" \t "See. Width interval" [image: image385.png]


  [image: image386.png]


  Cho phép tạo ra và xóa những khoảng của chiều rộng trong bảng. 

Width table  Cho phép biên tập những khoảng của chiều rộng những đối tượng, để gán màu và lớp của đường tới một khoảng.

Để làm cho bảng chiều rộng chính xác, bạn cần định nghĩa những ranh giới khoảng chiều rộng để đối tượng thu được sau vectơ có chiều rộng bằng chiều đó .


Bảng chiều rộng có thể chứa đựng số lượng những khoảng chiều rộng tùy ý. Mỗi khoảng được định nghĩa bởi hai giá trị - ranh giới chiều rộng cao và thấp của những đối tượng được chấp nhận vào trong khoảng xác định. Những thuộc tính sau là tập hợp tới mỗi khoảng : chiều rộng,  màu và lớp. chiều rộng Line Raster thực tế thay đổi xung quanh giá trị thật. Cho ví dụ, nếu bạn Vectơ những line raster với chiều rộng 0.25 mm, bạn có thể thu được những đối tượng với những chiều rộng từ 0.18 đến 0.33 mm 


Với ví dụ trên, bạn cần tạo ra phạm vi từ 0 đến 0.33 và từ 0.33 lên tới chiều rộng Max.  bạn có thể thiết đặt chiều rộng, màu và lớp để tạo ra những khoảng và kiểm tra ở thao tác vectơ hoặc những công cụ trace (Với checkbox Use table được chọn).


Tất cả các khoảng được thiết đặt trong một phạm vi chiều rộng từ zêrô đến giá trị của tham số Max Width chỉ rõ trong tab Options của hộp thoại Conversion Options . 

Để tạo ra một khoảng mới trong bảng chiều rộng, nhập một giá trị ranh giới trên của khoảng chiều rộng trong New interval, nhấn nút .
[image: image387.png]




Bạn có thể cũng tạo ra một khoảng bởi việc kích vào vị trí thích hợp trong thước đo 
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Một mũi tên xuất hiện trên thước đo cho biết ranh giới trên của khoảng tạo ra. Khoảng hiện thời được tách hai khoảng. Những thuộc tính của một khoảng mới được kế thừa từ một khoảng hiện hữu.
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Bạn có thể sửa đổi ranh giới của tất cả các khoảng trừ khoảng cao nhất và thấp nhất. 


Để thay đổi ranh giới khoảng, kích vào bảng chiều rộng trên hàng tương xứng với khoảng yêu cầu, kích vào hộp những cột Start hoặc End trong hàng đanh chọn và thay đổi giá trị của ranh giới khoảng cao hoặc thấp hơn. 
 hoặc :


Kéo ký hiệu mũi tên tương ứng trên thước đo chiều rộng.


Bạn có thể xóa tất cả các khoảng trừ khoảng mặc định.

Để xóa một khoảng : Lựa chọn một khoảng trong thước đo chiều rộng hoặc từ danh sách, và kích   nút xóa .[image: image390.png]


  hoặc chỉ vào khoảng ranh giới trái (thấp hơn) trên thước đo chiều rộng và kéo nó tới ranh giới của khoảng gần nhất - Khoảng kề bên sẽ được hòa trộn, và khoảng tạo ra sẽ có một ranh giới dưới mới.  Nếu bạn kéo nó vượt qua bên phải khoảng ranh giới , thì khoảng sẽ bị xóa.

11-Sửa đổi những thuộc tính khoảng


Những thuộc tính sau là thiết đặt tới mỗi khoảng : ranh giới chiều rộng nguồn, chiều rộng của đường tạo ra, màu và lớp, được gán cho những đối tượng với những chiều rộng bên trong khoảng này.
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a-Để giữ cho những chiều rộng không thay đổi


Giá trị của Chiều rộng sẽ được gán cho tất cả các đối t​ợng vectơ với chiều rộng trong khoảng xác định nếu checkbox chiều rộng đã chọn.


Nếu bạn không muốn những đường bên trong khoảng làm tròn tới những chiều rộng đặt sẵn, xác định trong hộp Width , hãy bỏ chọn hộp kiểm trong một hàng tương ứng của thuộc tính  phạm vi .

b-Gán chiều rộng cho một khoảng


Kích vào một hàng thích hợp, kích vào cột chiều rộng và vào giá trị chiều rộng.

c-Để gán lớp cho một khoảng


Bạn có thể gán bất kỳ tên lớp nào cho một khoảng hoặc lựa chọn giá trị Current. Tất cả các đối tượng vectơ  có chiều rộng trong khoảng xác định , sẽ được tạo ra trên lớp xác định.  Nếu không có lớp với tên xác định, thì một lớp mới sẽ được tạo ra trong thời gian trace ( Vectơ).  Nếu bạn chọn Current, thì những đối tượng sẽ được tạo ra trên lớp hiện thời.


Kích vào hàng tương xứng với khoảng đòi hỏi; kích cột Layer trong danh sách. Lựa chọn lớp hiện hữu từ danh sách hoặc vào một tên của một lớp mới, mà sẽ đ​ợc tạo ra trong thời gian vectơ.

d-Gán màu cho một khoảng


Kích vào hàng tương xứng với khoảng đòi hỏi; kích cột color trong danh sách. Lựa chọn màu từ danh sách hoặc chỉ rõ trong hộp thoại bởi việc kích Other. Bạn có thể gán bất kỳ màu nào cho một khoảng, kể cả những giá trị Current, By Layer và By Block. Tất cả các đối tượng vectơ với những chiều rộng trong khoảng xác định sẽ có màu xác định. Nếu bạn chọn Current những đối tượng của khoảng xác định sẽ được tạo ra với màu hiện thời.

12-Lưu trữ những sự thiết đặt cho bảng chiều rộng 


Những sự thiết đặt bảng chiều rộng có thể được lưu trữ trong file khung mẫu trên đĩa để sử dụng ( cùng với thiết đặt khác của hội thoại Conversion Options ).


1.Kích vào nút Template; chọn Save .


2.Hộp thoại sẽ mở.


3.Chỉ rõ tên file, kích OK. Theo mặc định file sẽ được l​u trữ tới thư mục Recognition parameters của thư mục gốc WiseImage.


Để tải những sự thiết đặt bảng chiều rộng


1.Kích vào nút Template và chọn Load .


2.hộp thoại file khung mẫu mở sẽ .


3.Chọn file , kích OK.

ii-automatic

1-Raster to vectorr


Thực hiện vectơ với những tham số thiết lập trong R2V Conversion Options ở những hình ảnh raster bitonal hoặc R2V Color Conversion Options ở  hình ảnh raster màu và grayscale.

Lệnh có thể được áp dụng tới vài hình ảnh một lúc.


Để vectơ Raster :

Khởi động lệnh từ thực đơn Convert >Raster to Vector hoặc [image: image392.png]


 thanh công cụ Convert - Lệnh chạy ngay lập tức.

2-Giải thuật đoán nhận điểm


Giải thuật này đoán nhận những điểm trên những hình ảnh

 raster. Đối tượng điểm có thể được đoán nhận chỉ với vectơ tự động

  ( Lệnh Raster2Vector).  Khi giải thuật này bật, vết lốm đốm có

 thể cũng được đoán nhận như những điểm.



Điểm raster được đoán nhận trong những trường hợp sau : 


1. Nếu kích thước của nó không nhỏ hơn 2 pixcel ( đối tượng

kích thước nhỏ hơn được xem xét như vết lốm đốm và lờ đi), nhưng

 không lớn hơn giá trị Max Width; 

2. Những cạnh của hình chữ nhật mà đường biên đối tượng xấp

 xỉ như nhau 
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3-Đoán nhận text 


Sử dụng những đặc tính tiêu chuẩn WiseImage OCR, bạn có thể đoán nhận những đặc tính của bảng chữ cái tiếng Anh, những chữ số, những dấu chấm câu và những ký hiệu đặc biệt . Những khung mẫu đặc tính này được cất giữ trong những file đặc biệt của những thư viện khung mẫu đặc tính. Những file này mặc định trong thư mục OCR của thư mục gốc WiseImage Pro.


Mô đun WiseImage OCR có thể được huấn luyện đoán nhận bất kỳ đặc tính nào. Với mục đích này bạn có thể thêm những khung mẫu đặc tính mới vào một trong những thư viện sẵn có hoặc tạo ra thư viện của chính mình.


Trong thời gian huấn luyện, WiseImage tạo ra những khung mẫu của những đặc tính văn bản và đặt chúng trong thư viện đang mở của những khung mẫu đặc tính. Bạn có thể thay thế bất kỳ khung mẫu nào trong thư viện hiện hữu . Vài khung mẫu có thể tương ứng tới một đặc tính văn bản.


Để tạo ra hoặc thay đổi một thư viện khung mẫu đặc tính hiện hữu:


1. Chọn Train OCR từ thực đơn Convert hoặc nhấn nút [image: image394.png]


 trên thanh công cụ công cụ raster to vector
Hộp thoại sau xuất hiện : 
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2.  Nếu bạn muốn tạo ra một thư viện mới , hãy nhấn nút [image: image396.png]


.  Nếu bạn muốn thêm những khung mẫu mới vào thư viện hiện hữu, nhấn nút [image: image397.png]


 , lựa chọn từ hộp thoại thư viện mong muốn và nhấn  Ok.



3.Tạo ra mới, thay thế hoặc xóa những khung mẫu đặc tính.


4. L​u trữ thư viện trong file hiện c , hoặc trong một một file mới, sử dụng nút [image: image398.png]


.  Kích OK.



Sự tạo thành, sự thay thế và xóa những khung mẫu thư viện được làm với sự giúp đỡ của những nút trong thanh công cụ hộp thoại và đặc tính nhập vào trong hộp.
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 Những công cụ chọn ký tự raster

[image: image400.png]
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  công cụ thêm và xóa


Trước khi bắt đầu huấn luyện mở hộp thoại Train OCR và tải thư viện hiện hữu hoặc mở một một cái mới

3-Thiết lập số hóa trong hộp thoại Conversion Options 
Bạn bắt đầu Vectơ sử dụng hội thoại Conversion Options .Những tham số chính của vectơ được thiết lập trong Tab Recognition và tab Options.  Nếu quá trình tìm kiếm và đoán nhận  text, sym bol, những giải thuật được sử dụng, thì bạn cần phải thiết lập những tham số trong tab text và tab symbol  mô tả trong chương này.


Bạn có thể ướcx lượng chiều rộng của những đối tượng đang tồn tại sau khi vectơ với giá trị xác định , và đặt chúng trên nhiều lớp và gán nhiều màu cho chúng. Những thao tác này được làm trên tab Separate. 
Để thiết lập vectơ Những tham số:


1.Mở hộp thoại Conversion Options sử dụng một trong những phương pháp sau :


chọn mụcConversion Options  từ thực đơn Convert hoặc kích nút trên [image: image402.png]


 trên thanh công cụ Raster to Vector 

2.Chỉ rõ những tham số đòi hỏi, duyệt qua những Tab hội thoại nếu cần thiết, rồi kích OK.
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a-Tab Recognition


Trong bảng này bạn có thể lựa chọn một tập hợp của những giải thuật sẽ được sử dụng cho vectơ hình ảnh raster. 

Để vectơ những hình ảnh raster với những kiểu khác nhau, bạn cần sử dụng nhiều thiết đặt của những thực thể hình học. Cho ví dụ, để vectơ những bản đồ hoặc những sơ đồ thì nên sử dụng polylines, để vectơ bản vẽ kiến trúc, xây dựng, bạn cần phải sử dụng những giải thuật mà tạo ra những line, circles, arc - trong trường hợp này một hình vectơ đang tồn tại sẽ tương ứng chính xác tới bản vẽ nguyên bản.

Để làm cho sự đoán nhận những hình ảnh của những cấu trúc khác nhau được linh hoạt, WiseImage hỗ trợ thiết lập những giải thuậtvectơ , đoán nhận những sự tương tự raster của những thực thể vectơ và phát sinh những đối tượng vectơ gần giống. Bạn có thể sử dụng nhiều giải thuật hơn trong một thao tác.
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Quá trình Vectơ trực tiếp bị ảnh hưởng bởi sự thiết đặt  những tham số hình học của sự đoán nhận được định vị trong tab Options của hộp thoại này.

+Point 


Giải thuật này được dự định để đoán nhận điểm cao độ trên những bản vẽ trắc địa và những hình ảnh tương tự. Chương trình sẽ đoán nhận một điểm raster với một kích thước không nhỏ hơn 2 x2 pixcels ( những đối tượng với kích thước nhỏ hơn được xem xét như những vết đốm raster và lờ đi), và phạm vi cực đại thẳng đứng và nằm ngang không lớn hơn giá trị Max value. 

Đối tượng điểm có thể chỉ được đoán nhận trong kiểu tự động.


Không bật kiểu này khi đoán nhận những hình ảnh chất lượng nghèo chứa đựng nhiều vết lốm đốm, vì mỗi vết lốm đốm được đoán nhận như điểm.

+Liness

Bật giải thuật sự đoán nhận line. kết quả thao tác giải thuật những thực thể line được tạo ra.
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Có những tham số bổ sung sau :


-Arrows:  Nếu tùy chọn này bật, thì WiseImage Pro tìm kiếm những raster tương tự của  kích thước line( các line với một hoặc hai mũi tên trong những điểm kết mút) và nếu những mũi tên được tìm thấy, thì WiseImage Pro cất giữ chúng như thuộc tính Marker Start  hoặc End  của line.
 


-Line Types: Nếu tùy chọn này bật, thì WiseImage Pro đoán nhận những đường thẳng  dash-dotted (nét đứt , dấu chấm) , tạo ra những line vectơ với kiểu tương ứng.



Giải thuật này bị ảnh hưởng bởi những tùy chọn của tab Options :


-Nó đoán nhận những đối tượng raster với độ dài lớn hơn giá trị của tham số Min length và với chiều rộng nhỏ hơn hơn giá trị của tham số Max width . 

-Những tham số Max break  thiết đặt độ dài cực đại bỏ qua (lờ đi) đoạn gãy line raster. 

-Tham số Approximation thiết đặt sự chính xác của những line raster tương ứng những đối t​ợng vectơ.  Nếu chất lượng raster kém, thì bạn cần giảm bớt giá trị tham số để giải thuật có thể đoán nhận những đối tượng raster với những sự biến dạng đáng kể của mẫu (dạng).


Nếu tùy chọn Orthogonalization bật, đoán nhận được những đoạn sắp thẳng hàng cả hai trươngi hợp song song và thẳng đứng với phương  chỉ rõ trong trường Base angle . Những đoạn có góc lệch nhỏ so với phương cơ sở được sắp thẳng hàng. Giá trị lệch được công nhận, được xác định bỡi tham số Approximating. Tham số này có giá trị thấp, những độ lệch lớn hơn có thể được chấp nhận.

+Đường tròn và cung tròn


Thiết đặt giải thuật đoán nhận những vòng tròn và cung raster  .
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Có những tham số bổ sung sau :


-Arrows:  Nếu tùy chọn này bật, thì WiseImage Pro tìm kiếm những raster tương tự của những kích thước cung ( những cung với một hoặc hai mũi tên ở tại endpoints) và nếu những mũi tên được tìm thấy, tạo ra cung với những mũi tên.

-Line Types: nếu tùy chọn này bật, thì WiseImage Pro đoán nhận những line nét đứt, chấm, tạo ra những đối tượng vectơ  kiểu tương ứng.


Giải thuật này bị ảnh hưởng bởi những tùy chọn sau (của) bảng những tùy chọn :


-Nó đoán nhận những vòng tròn và những cung raster với độ dài lớn hơn giá trị tham số Min length và với chiều rộng nhỏ hơn hơn giá trị tham số Max width.


-Những tham số Max break  thiết đặt độ dài cực đại bỏ qua (lờ đi) đoạn gãy line raster. 
-Tham số Approximation thiết đặt sự chính xác của những line raster tương ứng những đối t​ợng vectơ.  Nếu chất lượng raster kém, thì bạn cần giảm bớt giá trị tham số để giải thuật có thể đoán nhận những đối tượng raster với những sự biến dạng đáng kể của mẫu (dạng).

+Polylinesxe "Polyline:recognition"

Giải thuật này ước lượng tại trung tâm line của những đối tượng raster bởi polylines . Giải thuật tạo ra polylines chỉ có các đoạn tuyến tính. Bạn có thể sử dụng riêng lẻ giải thuật này ( hoặc với giải thuật Outliness) để vectơ những bản đồ và những hình ảnh khác gồm có những đường tùy ý ( những đường cong được vẽ bằng tay).


Có những tham số bổ sung sau :


-Line Types: Nếu tùy chọn này đã bật, thì WiseImage Pro đoán nhận những đường nét đứt, dấu chấm, tạo ra polyline tương ứng .


-Create verticesxe "Vertices" on intersections :  Nếu tùy chọn này bật, thì giải thuật tạo ra đỉnh trên những vị trí  polylines giao nhau.


Giải thuật này bị ảnh hưởng bởi những tùy chọn sau của tab Option :


-Max length định nghĩa độ dài đoạn được thừa nhận được thêm tới polyline. Nếu đoạn dài hơn  thì không được thêm tới polyline. ví dụ, để trace những bản đồ có những đường cong tiêu chuẩn được chéo qua  những đường tọa độ; giải thuật tự động dừng ở những sự giao nhau với đường thẳng dài của lưới


-Giải thuật xấp xỉ những đường raster với chiều rộng nhỏ hơn hơn giá trị của tham số Max width 


-Những tham số Max break thiết đặt độ dài cực đại  bỏ qua những đoạn gãy raster. 

-Tham số Approximation thiết đặt sự chính xác của việc vạch theo đoạn raster bởi vectơ polyline.

+Outlinesxe "Outlines:recognition"

Giải thuật này sử dụng để tạo ra những đường viền đối tượng bằng các polylines. Nó tạo ra polylines đóng 
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 . 


Đoạn raster nguyên bản                vectơ kết quả.



Giải thuật này bị ảnh hưởng bởi những tùy chọn sau của bảng những tùy chọn :


-Giải thuật ước lượng những line raster với chiều rộng lớn hơn giá trị tham số Min width . Để thu được những outline của tất cả các đối tượng raster, bạn cần phải thiết lập giải thuật này và đặt tham số Max Width tới 0.


-Tham số Approximation thiết lập độ chính xác khi vạch theo raster

+Hatch


Thiết đặt giải thuật đoán nhận Hatch. WiseImage Pro đoán nhận Hatch raster đơn giản và tạo ra những khối, gồm có những line. Hatch raster đơn giản là một tập hợp của những line raster song song. Giải thuật tìm kiếm Hatch chỉ khi giải thuật Lines đã bật.

Những tham số bổ sung là những góc của những line raster hình thành Hatch

+Vùng Text


Tiết đặt giải thuật đoán nhận văn bản. WiseImage Pro phân biệt những vùng trên hình ảnh với những văn bản raster và áp dụng để phục hồi những văn bản 


Thiết lập những văn bản raster tìm kiếm những tùy chọn và mô đun OCR được làm trong Tab Text của  hộp thoại , sự thiết đặt thủ tục được mô tả kỹ hơn trong chương này.
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Giải thuật sử dụng những giá trị của danh sách Height Table  của tab Option như chiều cao cực đại của những ký tự văn bản raster 

+Symbolsxe "Symbols (shapes):recognition"

Thiết đặt giải thuật đoán nhận ký hiệu raster với những mẫu xác định. Sự thiết đặt được làm trong Tab Symbols  của  hộp thoại .

b-Tab Option
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Chương trình sử dụng thông tin trên những kích thước của những đối tượng raster được thiết lập trong tab Option, để định nghĩa sự thực hiện tối ưu của những giải thuật 

Bạn có thể vào những giá trị tham số từ bàn phím hoặc đo những giá trị của nó trên màn ảnh.

	Min Length
	Thiết đặt độ dài cực tiểu của một đoạn raster , mà cần phải được đoán nhận như một line, vòng tròn hoặc cung trong khi vectơ .

Chỉ rõ giá trị của tham số này bằng độ dài ngắn nhất  của line raster hoặc đường kính của vòng tròn ( cung).

· 

	Max Width
	· Thiết đặt chiều rộng cực đại của đối tượng raster  mà cần phải được đoán nhận như một đường, cung hoặc polyline. Chỉ rõ giá trị tham số này hơi lớn, hơn chiều rộng cực đại của một đường raster, cái nào mà bạn muốn để vectơ Sử dụng những giải thuật : Lines, Arc và Circles hoặc Polylines. Nếu Chương trình không vectơ những đoạn Raster , những vòng tròn, những cung trên hình ảnh, bạn cần phải tăng thêm giá trị này. Nếu chương trình không ước lượng  đầy đủ những vùng raster với những đường viền (outline), bạn giảm bớt giá trị này. 

	Max Break xe "Break:ignoring"
	Thiết đặt độ dài cực đại được chấp nhận để bỏ qua những đoạn gãy của những line raster.

Nếu một đoạn ( cung) trên hình ảnh bị gãy thành hai phần và bạn muốn vectơ đoạn này như một đối tượng vectơ toàn bộ, chỉ rõ giá trị này hơi lớn, hơn khoảng cách giữa hai phần này, Sự gãy (khoảng hở) sẽ được bỏ qua, và những bộ phận của đoạn vectơ ( cung) sẽ được nối lại thành một.

· 

	Text Heightxe "Text:height"
	Chỉ rõ giá trị này bằng chiều cao cực đại của ký hiệu văn bản raster của trường hợp trên (ký tự h, k, l vân vân.)

· 


c- Tab Text


Thiết đặt trên mô đun WiseImage Pro OCR được thực hiện trong tab text. 

[image: image413.png]Recogniton | Optons | Separte | Trace [ Texs | Symbos|

Orentation: ntal v
%,  [JOveriapped by Graphics
5 [
Vs - e
fText —E=
A | TFext
= B
e =3






Sự xử lý của những văn bản raster có hai bước. Trước hết WiseImage Pro tìm kiếm những đoạn raster chứa đựng những văn bản raster.  Những đoạn này có tên là Text Areas. Sau đó WiseImage Pro áp dụng để tìm những thao tác văn bản raster được thiết đặt như tham số bổ sung của những giải thuật Text Areas trong tab Recognition.  

 
Thao tác phức tạp nhất là sự đoán nhận văn bản raster với việc sử dụng mô đun có sẵn của sự đoán nhận những văn bản ( OCR) hoặc sử dụng mô đun bổ sung.


Mô đun WiseImage Pro OCR đoán nhận những văn bản raster và tạo ra những đối tượng văn bản WiseImage Pro. Ngoài ra chiều cao và góc nghiêng tạo ra những văn bản được tính toán.


Có hai file mẫu những đặc tính OCR ( DEFAULT.OCR và CYRILLIC.OCR) sử dụng chương trình nào để đoán nhận những ký tự bảng chữ cái tiếng Anh, những chữ số, những sự dánh dấu chấm câu và những ký tự đặc biệt ( nửa đầu tiên của bảng ASCII). Bạn có thể cũng “huấn luyện” mô đun OCR để đoán nhận những văn bản khác.


Nếu OCR không thể đoán nhận ký tự, thì nó thay thế bằng ký tự "~"  ( Dấu ngã) trong hàng văn bản. Nếu hoàn toàn không nhận ra những ký tự, OCR không phát sinh đối tượng văn bản.

*Các tùy chọn đoán nhận text:


+Orientation :định nghĩa thao tác văn bản raster được công nhận


-Horizontal: Tìm kiếm những hàng văn bản nằm ngang. Những vùng văn bản sẽ chỉ nằm ngang

-Horizontal và Vertical:Tìm kiếm những hàng văn bản thẳng đứng và nằm ngang. Những vùng văn bản sẽ chỉ nằm ngang và thẳng đứng

-Arbitrary:Tìm kiếm những hàng văn bản nghiêng. Sự lựa chọn tùy chọn này có thể làm chậm tốc độ tìm kiếm những vùng văn bản 


+Overlapped by Graphic:  Nếu tùy chọn này bật, thì WiseImage Pro tìm kiếm những văn bản raster chéo qua những đối tượng raster khác. Sự lựa chọn tùy chọn này có thể làm chậm tốc độ tìm kiếm vùng văn bản


+Standalone Letters: Cho phép tìm kiếm những ký tự văn bản độc lập.  Nếu tùy chọn này tắt, thì WiseImage Pro sẽ không tìm thấy những ký tự văn bản đơn, và sẽ không xác định những đối tượng đồ họa như văn bản ,cũng như số , nét vẽ, vân vân.


+Patternsxe "Patterns"

xe "Recognition:Templates": Để tùy biến OCR bạn cần phải chỉ rõ một tập hợp mẫu các từ. Một mẫu là một quy tắc cho phép chỉ định một chuỗi liên tiếp những ký tự trong một từ đoán nhận. Danh sách này chứa đựng định nghĩa của những mẫu từ được công nhận. WiseImage Pro OCR có thể phát sinh những từ duy nhất, mà tương ứng tới một trong những mẫu xác định (nếu hộp kiểm Patterns trong tab Texts của  hội thoại Conversion Options được chọn).

+Nút thêm và xóa  [image: image414.png]
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 :Để biên tập danh sách những định nghĩa của những mẫu từ


Đây là mô tả hình thức của định nghĩa mẫu từ :

" [% [length] character type] || [letter]] ... "

	 [%]
	Bắt đầu của định nghĩa chuỗi ký tự

	[length]
	 Bất kỳ số thập phân nào; không tồn tại nếu length là biến

	[type]
	Kiểu ký tự ( D,E,e, N,n, S)

	[letter]
	ký tự độc lập



Kiểu ký tự được chỉ rõ trong cách  sau :

	D
	Những chữ số

	E
	Những ký tự trường hợp trên của bảng chữ cái tiếng Anh

	e
	Những ký tự trường hợp dưới của bảng chữ cái tiếng Anh

	N
	ký tự viết hoa của những bảng chữ cái 

	n
	Những ký tự thường của những bảng chữ cái 

	S
	Những ký tự đặc biệt ( ký hiệu dấu trừ và cộng, ký hiệu của đẳng thức vân vân.)

	%%
	ký tự độc lập "%"

	[characters]
	ký tự độc lập 



Cho ví dụ :


Mẫu "Rz%D"  cho phép phát sinh những từ, mà bắt đầu Với " Rz ", theo sau là bất kỳ chuỗi nào của những chữ số, cho ví dụ, " Rz40 ", " Rz2. 5 ", " Rz5000 ".



Mẫu "%1N%n" cho phép phát sinh những từ của bảng chữ cái với ký tự đầu tiên viết hoa .



" % D %% " cho phép phát sinh số phần trăm những mẫu sau : “20 %",  "1100 %", "12.50% ", vân vân.


"% DV " cho phép phát sinh  những mẫu sau : " 5 V ", " 220 V ", " 13.8 V ", vân vân


+Height Table: Bạn có thể chỉ rõ những chiều cao văn bản trong hộp này. nếu checkbox đã bật, khi đótrong thời gian phát sinh đoán nhận text, mô đun OCR sẽ tạo ra những đối tượng văn bản với những chiều cao từ danh sách này, chiều cao được thừa nhận làm tròn tới giá trị gần nhất chỉ rõ trong danh sách.


*Thư viện mẫu ký tự:


Thiết đặt một file thư viện khung mẫu  để sử dụng đoán nhận. Những khung mẫu là những mô hình hình học tôpô của những đặc tính văn bản ( Những ký tự​, những ký hiệu đặc biệt ....), với những đặc tính văn bản raster nào được đoán nhận.


Danh sách chứa đựng những file DEFAULT.OCR và CYRILLIC.OCR. Sử dụng file "DEFAULT", mô đun OCR có thể đoán nhận những đặc tính của bảng chữ cái tiếng Anh, những chữ số, những dấu hiệu, những dấu chấm câu và những ký hiệu đặc biệt ( nửa đầu tiên của bảng ASCII). Sự lựa chọn file CYRILLIC cho phép đoán nhận mọi đặc tính đề cập ở trên, và những ký tự tiếng Nga.


Bạn có thể huấn luyện OCR để đoán nhận những đặc tính văn bản khác. Xem phần “Huấn luyện OCR ” .


Trong thời gian “học”, quá trình OCR tạo ra những khung mẫu và ghi chúng trong thư viện. Bạn có thể lưu trữ đặc tính cho những khung mẫu trong file thư viện hiện hữu hoặc tạo ra một một file mới.


Nếu bạn sử dụng file của chính mình , OCR sẽ chỉ đoán nhận những đặc tính mô tả trong file này .


+To place on layer: Trong hộp này bạn có thể đặt tên của một lớp để đặt những văn bản nào thu được 

d-Tab Trace


-Orthogonalization



 Nếu tùy chọn này bật, thì tất cả các đoạn trở thành đường thẳng góc hoặc song song tới góc cơ sở. Góc cơ sở là thiết lập trong Base angle của Tab Parameters .  Nếu checkbox Auto đã bật, thì chương trình tự động định nghĩa góc cơ sở bởi phương hướng của đoạn polyline . Bạn có thể sử dụng tùy chọn này khi  trace đối tượng raster gồm có đường thẳng góc , cho ví dụ, khi trace trên bản vẽ xây dựng


-Auto:


Tự động định nghĩa phương hướng cơ sở của đoạn polyline trực giao. Góc cơ sở cho mỗi polyline được định nghĩa riêng rẽ.


-Auto Detect Direction:

Thiết đặt kiểu cho sự dò tìm tự động  phương hướng vạch dấu.  Khi chương trình gặp nút những đường raster giao nhau, nó cố gắng tìm thấy phần đường raster sau (là phần mở rộng của đối tượng trace.


-Pause
:



Thiết đặt một quãng thời gian bằng giây, trong thời gian đó bạn cần phải chọn một đoạn để trace khi kiểu auto của việc trace mở rộng đã bật. Trừ phi Bạn chỉ rõ bằng tay, chương trình sẽ tiếp tục trace tự động trong phương hướng chọn.


-Place vertex on nodes:



Nếu checkbox này bật, khi trace polylines, chương trình chèn đỉnh ở tại những vị trí giao nhau của một vectơ polyline phát sinh với những đối tượng raster ( ở tại những nút). 


-Auto Extend vectors:


 Đặc tính này đơn giản hóa sự chọn lọc và sự vạch dấu bắt buộc của những cung và line. Trong khi đoán nhận một line  bạn có thể kích hai điểm riêng biệt trên nó; và WiseImage tự động mở rộng line kết quả tới endpoints của nó. Trong khi đoán nhận một cung bạn có thể kích ba điểm trên nó; và WiseImage tự động mở rộng cung kết quả tới endpoints của nó.


-Export single contour:



checkbox này bật thực hiện của trace outline. Nếu checkmark đã bật, thì sự vạch dấu tạo ra đường viền ở phía ngoài của đối tượng.  Nếu checkmark tắt, thì sự vạch dấu sinh ra đường viền ở phía ngoài và một đường bên trong, Nếu có " những lỗ " trong đối tượng raster.


đ-Tab Separate 


-Use table:



 Nếu checkbox này tắt, chương trình gán những giá trị hiện thời của màu chương trình và thuộc tính lớp để tạo ra đối tượng; giá trị của lực nét đối tượng đường được thiết lập bởi chiều rộng của những đường raster tương ứng.


-New interval: [image: image416.png]
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Cho phép tạo thành và xóa những khoảng chiều rộng trong bảng. 


-Width table:


Cho phép biên tập khoảng của những khoảng chiều rộng đối tượng và gán màu, lớp, và lực nét line cho mỗi khoảng.


-Template:


Lư​u trữ và tải những khung mẫu công cụ.

e-Tab symbol


-SRTL path:


Định nghĩa đường dẫn tới file thư viện Khung mẫu Đoán nhận Ký hiệu 


-Strategy:


Định nghĩa một kế hoạch được sử dụng cho sự đoán nhận ký hiệu. Sự lựa chọn kế hoạch ảnh hưởng sự cân bằng của tốc độ / Sự chính xác của giải thuật. Có ba kế hoạch : Fast, Standard và Smart,  kế hoạch Fast  có tốc độ cao nhất của sự phân tích ký hiệu raster, nhưng nó có thể không tìm thấy những ký hiệu thậm chí rất giống khung mẫu. Kế hoạch Smart chậm nhất , nhưng kết quả đúng nhất. Kế hoạch Standard được sử dụng theo mặc định.


-Fixed scale:


Tham số này đặt dung sai để đoán nhận những ký hiệu với nhiều kích thước.  Nếu checkbox  bật, thì chỉ những những ký hiệu mà có kích thước cân đối tới những khung mẫu với những hệ số thiết lập trong hộp sẽ được đoán nhận. Khi thay thế những ký hiệu raster được thừa nhận, hệ số này sẽ được sử dụng để tỷ lệ ký hiệu vectơ được chèn vào.  Nếu checkbox tắt, thì tất cả các ký hiệu raster sẽ được kiểm tra trên độ dung sai cho phép, và tỷ lệ hệ số sẽ được tính toán tự động. Trong trường hợp này thao tác chương trình có thể bị làm chậm.


-Accuracy:

Tham số này định nghĩa độlệch được công nhận của hình học ký hiệu raster so với mẫu. ở những giá trị sao, chương trình sẽ chỉ đoán nhận những ký hiệu mà rất gần với mẫu , tỷ lệ và phương hướng với mẫu. ở những giá trị thấp hiều ký hiệu hơn sẽ được đoán nhận nhưng xác suất của sự đoán nhận bất thường tăng thêm.


-Orientation:


Thiết đặt những sự lệch góc có thể của những ký hiệu raster từ những khung mẫu xác định.  Nếu giá trị Horizontal được chọn, thì chỉ những ký hiệu có cùng sự định hướng đó sẽ được đoán nhận; nếu Horizontal and Vertical được chọn, những ký hiệu quay bởi một góc 90 sẽ được đoán nhận;  nếu Arbitrary được chọn, thì những ký hiệu quay bởi những góc đó sẽ được đoán nhận. Tùy chọn cuối cùng làm chậm đáng kể thao tác của những giải thuật đoán nhận.


-Standalone Symbols: 


Checkbox này định nghĩa liệu có phải ký hiệu chứa đựng những đối tượng raster không có từ khung mẫu sẽ được đoán nhận.  Nếu checkbox tắt, tất cả các ký hiệu phù hợp với khung mẫu sẽ được đoán nhận, dù chúng bị cắt qua bởi những đối tượng raster mà không phù hợp cho những đối tượng, thiết lập khung mẫu. Nếu không chỉ những ký hiệu mà không bị chéo qua bởi những đối tượng khác sẽ được khôi phục.

chương 9: biên tập vec ter

i-Vẽ thực thể vecctor


+Vẽ line theo góc và độ dài chỉ định trên màn hình :[image: image418.png]




Draw menu:  Line By> Angle and Length.


+Vẽ bằng 2 điểm [image: image419.png]




Draw menu: Line By> Two Points.

+Vẽ cung tròn qua 3 điểm: [image: image420.png]




Draw menu: Arc by>3 points.


+Vẽ cung tròn bỡi tâm, góc và bán kính [image: image421.png]




Draw menu: Arc by> Center, Angles and Radius.


+Vẽ cung tròn bỡi tâm, điểm bắt đầu và góc: [image: image422.png]




Draw menu: Arc by> Center, Start Point, Angle.


+Vẽ đường tròn bằng 3 điểm [image: image423.png]




Draw menu: Circle by> Three Points.


+Vẽ đường tròn bỡi đường kính: [image: image424.png]




Draw menu:  Circle by> Diameter.


+Vẽ đường tròn với tâm và bán kính: [image: image425.png]




Draw menu: Circle by> Center and Radius.


+Vẽ chữ nhật bỡi hai điểm: [image: image426.png]




Draw menu:  Rectangle by> Two Points.


+Vẽ hình chữ nhật bỡi 3 điểm: [image: image427.png]




Draw menu: Rectangle by>Three points.


+Vẽ Elip với tâm và bán kính: [image: image428.png]




Draw menu:  Ellipse By> Center and radiuses.


+vẽ Elip với đường kính và bán kính: [image: image429.png]




Draw menu: Ellipse By> Diameter And Radius

+Vẽ cung của Elip: [image: image430.png]




Draw menu: Ellipse By>Elip Arc

+Polyline : [image: image431.png]




Draw menu: Polyline.

+Spline : [image: image432.png]




Draw menu: spline.

+Point: [image: image433.png]




Draw menu: Point.

+Hatch : [image: image434.png]




Draw menu: Hatch.


+Text : [image: image435.png]


 [image: image436.png]


 [image: image437.png]




Draw  menu: Text.

+Multiline text: Draw menu: Multiline Text.


1. Khởi động lệnh.


2. Nhập văn bản bằng tay trong hội thoại hoặc chèn nó từ file trên đĩa. để chèn sử dụng nút [image: image438.png]


 và chỉ rõ file chứa đựng văn bản. File phải trong khuôn dạng văn bản.


3. Chọn kiểu phông và kích thước.


4. Chỉ rõ một điểm cơ sở cho văn bản. Chú ý khi tạo ra văn bản kiểu RDRAW, cũng như trong trường hợp việc vẽ tất cả các kiểu của những thực thể vectơ. Nếu kiểu này đã bật [image: image439.png]) [RoRAW |




 sau khi nhập những văn bản sẽ tự động là raster tới tất cả các hình ảnh raster ở bên dưới nó. Nếu duy nhất một hình ảnh được chọn, thì chúng sẽ là raster trên  nó.


Biên tập Multiline text


1. Khởi động Inspector..

2. Chọn đối tượng văn bản và kích nút trong thuộc tính Text. [image: image440.png]




Xuất hiện hội thoại,bạn có thể nhập vàấpoạn thảo văn bản hoặc bạn có thể trích từ một file văn bản hiện hữu. Có năm nút trong hội thoại này :

 
[image: image441.png]


 mở file văn bản 


[image: image442.png]


 lưu giữ văn bản


[image: image443.png]


 xóa văn bản


[image: image444.png]


 Chèn những ký hiệu đặc biệt trong văn bản

 
[image: image445.png]


 Chèn dữ liệu đặc biệt từ danh sách : 


 - Ngày tháng hiện thời (Short) 


- Ngày tháng Hiện thời (Long) 


- Thời gian hiện thời 


- Tên người dùng


Bạn có thể thay đổi màu, kích thước kiểu phông văn bản bởi việc sửa đổi tương ứng những thuộc tính đối tượng (Color, Text Font, Text Height) trong Inspector. 


Sự sắp thành hàng văn bản:


Văn bản đ​ợc liên kết bởi điểm cơ sở của nó ( nhìn thấy thuộc tính

Base Point trong Inspector). Để sắp thẳng hàng nằm ngang văn bản sử 

dụng thuộc tính Horizontal. Có những phương án : Left, Center, Right.

 Để sắp thẳng hàng văn bản thẳng đứng sử dụng thuộc tính Vertical.

 Sau khi nhập sự sắp thành hàng văn bản được thiết lập bởi góc dưới- trái.



Với lệnh Explode bạn có thể bung multiline text thành single-line texts.


+Vẽ đường dóng kích thước: 


Draw menu: Dimension sau đó chọn một lọai để sử dụng, hoặc kích các nút tương ứng sau: [image: image446.png]


 [image: image447.png]


 [image: image448.png]


 trên thanh công cụ Dimension
ii-thứ tự hiển thị


+ Bring forward: đưa đối tượng chọn ra phía trước đối tượng nằm trước nó [image: image449.png]


.



View menu:  Display Order> Bring Forward.


+ Bring to front: đưa những đối tượng chọn ra phía trước tất cả các đối tượng khác [image: image450.png]


.


View menu: Display Order > Bring to Front.


+ Send backward: đưa những đối tượng chọn ra đằng sau đối tượng kề sau nó [image: image451.png]


.


View menu: Display Order> Send Backward.


+ Send to back: đưa những đối tượng chọn ra đằng sau tất cả các đối tượng khác [image: image452.png]


.


View menu: Display Order> Send to Back.

iii-hiệu chỉnh vector


+ Break: [image: image453.png]


 hoặc Correct menu: Break Vectors.


+ Sắp thẳng hàng góc và khoảng cách


Từ thực đơn Correct, chọn Align Angle and Distance. hoặc  Kích nút [image: image454.png]N



 trên thanh công cụ Correction

Lệnh này để sắp thẳng hàng những cung và những vòng tròn vectơ kết quả tương đối từ vectorizing hoặc trace đến một đối tượng xác định. Những vòng tròn và những cung có tâm chồng lên nhau, Những cung vectơ được cùng góc trở thành song song.


1. Lựa chọn một nhóm những đối tượng để sắp thẳng hàng và một đối tượng mà bạn muốn sắp thẳng hàng những đối tượng theo nó.


2. Thiết lập những tùy chọn liên kết trong cửa sổ Inspector ( nhìn thấy sự mô tả ở bên dưới).


3. Đặt chuột cursor gần đối tượng làm chuẩn để sắp thẳng hàng. WiseImage đưa ra vài phương án cho vị trí sắp thẳng hàng những đối tượng.


4. Nhấn Enter để xác nhận.

    [image: image455.png]


   [image: image456.png]


      [image: image457.png]



       Chọn các đối tượng        Đưa chuột tới line làm chuẩn   Các đường khác sẽ song song theo nó


Lệnh có hai tùy chọn mà có thể kiểm soát trong cửa sổ inspector.


-AutoResizing:


 Nếu Auto resizing được thiế lập tới TRUE, thì WiseImage sắp thẳng hàng những đối tượng tự động, phân bố chúng trên những khoảng cách.Thuộc tính của việc chỉ rõ khoảng cách thì không được họat động.


Nếu Auto resizing được thiế lập tới FALSE, thì bạn có thể thiết đặt khoảng cách giữa những hàng hoặc những bán kính của sắp thẳng hàng cung và vòng tròn trong trường Distance. 


- Distance: Giá trị Zêrô trong Distance có nghĩa là không thay đổi kích thước được áp dụng, Những hàng giữ nguyên vị trí của nó và chỉ những góc được thay đổi; những vòng tròn và những cung giữ gìn những bán kính của nó. 


Khi liên kết một nhóm những đối tượng bạn có thể chỉ rõ những khoảng cách riêng lẻ cho chúng. Với điều này, bạn cần chọn phương pháp sắp thành hàng - Several distances và chỉ rõ những khoảng cách phân ra chúng với những dấu phẩy. Nếu bạn chỉ rõ số của những khoảng cách mà ít hơn hơn số của những đối tượng được chọn, thì khoảng cách sử dụng gần đây nhất được sử dụng để  xác định cho khoảng cách nhập thiếu đó.


Lệnh này làm việc với những đường, những cung và những vòng tròn.  Nếu những cung và những đường được lựa chọn cùng lúc, thì chỉ những đường được sắp thẳng hàng.


Để sắp thẳng hàng những cung với lệnh Align Angle and Distance, tâm của một cung phải bên trong vùng khác ( hình 2).  Nếu áp dụng tới những vòng tròn, tâm của chúng phải ở trong lẫn nhau ( hình 3).

[image: image458.png]


          hình 1
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  Hình 2
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 Hình 3


+ Hiệu chỉnh tới vị trí giao nhau:


Mở rộng một đối tượng tới điểm giao nhau của nó và cắt đứt những phần mở rộng.


-Lựa chọn những đối tượng để sao chép và khởi động lệnh.


Từ thực đơn Correct > Correct to Intersection. hoặc kích nút [image: image461.png]


 trên thanh công cụ Vector Correction.

[image: image462.png]NN





+Cắt đối tượng: [image: image463.png]




Correct menu: Trim Vector by Edge.


+kéo dài đối tượng: [image: image464.png]




Correct menu: Extend Vector by Edge..


+Sửa chữa viền Vectơ 


Thiết đặt sự xuất hiện của mép được làm với lệnh Group/Ungroup Edge.


-Width
:
Thiết lập chiều rộng viền .


-Color
:
Thiết lập màu.


Mô tả những tùy chọn được sửa đổi với hội thoại Preferences.


+Hiệu chỉnh Polyline:


-Kiểu chọn lọc Nút 


Bật kiểu biên tập polyline , có hai quy tắc đơn giản cho sự chọn  đỉnh và đoạn trong kiểu này :


1. Nếu đoạn được lựa chọn thì đỉnh kề bên của nó cũng được lựa chọn.


2. Nếu hai đinh kề bên được lựa chọn, thì đoạn cũng được lựa chọn.


Để khởi động lệnh : Từ thực đơn Modify, chọn Polyline.

hoặc kích nút [image: image465.png]


 trên thanh công cụ Select .


Chọn đối tượng polyline, Có thể chọn trước khi khởi động lệnh, nếu muốn di chuyển đỉnh, kích vào grip của đỉnh và di chuyển, nếu muốn hiệu chỉnh đoạn, kích vào đoạn và di chuyển


-Xóa đỉnh


Xóa những đoạn và đinh polyline.


1.Lựa chọn một polyline trong kiểu  Polyline edit mode..


2.Lựa chọn đỉnh và đoạn để xóa. Những đỉnh xác định và đoạn sẽ được chiếu sáng.


3.Chạy lệnh :

 Kích nút [image: image466.png]


 Trên thanh công cụ Edit Polyline . hoặc chọn Delete Vertex từ menu nút phải chuột hoặc nhấn  nút Delete trên bàn phím.


-Mở rộng polyline để đóng


Đóng polyline bởi việc thêm một đoạn.

Để khởi động lệnh : Kích nút [image: image467.png]


 trên thanh công cụ Edit Polyline.


-đóng Polyline bởi việc nối hai đỉnh cuối


Kích nút [image: image468.png]


 trên thanh công cụ Edit Polyline.


-Thêm đỉnh: Kích nút [image: image469.png]


 trên thanh công cụ Edit Polyline

-Kết nối line:


nối polylines, line, arc bởi việc thêm một đoạn thẳng.


1.Lựa chọn những đối tượng để nối ( polylines, line, arc) trong kiểu Polyline edit mode.


2.Chỉ rõ đinh để nối (nhấn SHIFF và kích vào các đỉnh) . Đỉnh được chọn sẽ được chiếu sáng màu xanh lục.


3.Chạy lệnh này để nối những đối tượng .

[image: image470.png]




Để khởi động lệnh : Kích nút [image: image471.png]


 trên thanh công cụ Edit Polyline 

hoặc chọn Join by Line từ thực đơn  phải chuột.


-Kết nối bởi cung


Nối polylines, line, arc bởi việc thêm một đoạn cung .


1.Lựa chọn những đối tượng để nối trong kiểu Polyline edit mode.


2.Chỉ rõ các đỉnh để nối . đỉnh chọn chiếu sáng màu xanh lục.


3.Chạy lệnh này để nối những đối tượng 

[image: image472.png]



Để khởi động lệnh :

 Kích nút [image: image473.png]


 trên thanh công cụ hoặc chọn join by Arc  từ thực đơn nút phải.


-Nối (các đỉnh gặp nhau)


Nối polylines, line, arc bằng cách nối endpoints của chúng.


1.Lựa chọn những đối tượng để nối 


2.Chỉ rõ đinh để nối .

[image: image474.png]




3.Chạy lệnh để nối  : Kích nút [image: image475.png]


 trên thanh công cụ Edit Polyline hoặc chọn Join  từ thực đơn nút phải.


-Chuyển đổi đoạn polyline tới một line.


1.Lựa chọn một polyline .


2.Lựa chọn một hoặc vài đoạn cung sẽ được chuyển đổi tới đoạn thẳng. Xác định đoạn và đỉnh của nó sẽ được chiếu sáng.


3.Chạy lệnh : Kích nút [image: image476.png]


 trên thanh công cụ  hoặc Chọn Convrt to line từ thực đơn nút phải.


-Chuyển đổi đoạn polyline tới một cung:


1.Lựa chọn một polyline 


2.Lựa chọn một hoặc vài đoạn thẳng sẽ được chuyển đổi tới cung . Xác định đoạn và đỉnh của nó sẽ được chiếu sáng.


3.Chạy lệnh : Kích nút [image: image477.png]


 trên o thanh công cụ . hoặc chọn Convrt to arc từ thực đơn nút phải.

[image: image478.png]




+Chuyển đổi tới Spline :


Lệnh này chuyển đổi một polyline tới một spline; Một spline có thể cũng được vẽ với lệnh Spline. Kết quả của việc chuyển đổi Một polyline đóng như một spline đóng. 


1. Lựa chọn polyline chuyển đổi.


2. Chạy lệnh từ thực đơn Correct,  chọn Convert to Spline.

iv-Hiệu chỉnh tự động

1-Hiệu chỉnh tự động vectorr 


Tự động sửa chữa những đối tượng vectơ được chọn với những tùy chọn xác định. Những tùy chọn là tập hợp với những tùy chọn Vector Correction Options

1. Lựa chọn những đối tượng để sửa chữa.


2. Khởi động lệnh từ thực đơn Convert>Vector Autocorrect  hoặc [image: image479.png]


 thanh công cụ Vector Correction .

 2-Vector Correction Options


-Restore Tangents: Thiết lập khôi phục lại những tiếp giáp đối tượng . 


-Merge Vectors: Thiết đặt hòa trộn đối tượng.


-[image: image480.png]


 Remove Smal: Thiết đặt loại bỏ đối tượng với một kích thước xác định.


[image: image481.png]


Công cụ đo sử dụng  trên màn hình  

[image: image482.png]


  Thiết đặt sự chính xác khi hiệu chỉnh.


[image: image483.png]


 Thiết đặt sự sắp thành hàng cho đường và góc line ( từ 1 đến 5 độ).

Để khởi động lệnh :

 Từ thực đơn Convert,  chọn Vector Corrections Options
hoặc kích nút [image: image484.png]HE



 trên thanh công cụ Vector Correction
3-Hiệu chỉnh tự động polyline


Lệnh này sửa chữa polylines chủ yếu được sản sinh vectơ tự động hoặc trace. Phụ thuộc trên những sự thiết đặt nó có thể thực hiện hòa trộn, loại bỏ hoặc kết hợp polylines. ở đó có thể có những kiểu đối tượng khác nhưng chúng sẽ tự động được chuyển đổi thành polylines. 

Lệnh này chỉ có thể được thực hiện trong những đối tượng vectơ được lựa chọn. Bạn có thể thiết lập những tùy chọn lệnh trong hội thoại Polyline Correction Options 

Để khởi động lệnh : Từ thực đơn Correct , hãy chọn Polylines Autocorrect.

hoặc kích nút [image: image485.png]


 trên thanh công cụ VectorCorrection.

4-Những tùy chọn sửa chữa Polyline


Trình bày hộp thoại với những tùy chọn cho lệnh Polylines Autocorrect.


-Remove Small Segments:

Hợp nhất những nút polyline nối với một đoạn mà nhỏ hơn hoặc bằng giá trị tham số Minimal Size to remove.  Đây là kiểu hiệu chỉnh cho phép loại bỏ đoạn gối lên nhau và thừa . Để đạt đ​ợc kết quả tốt nhất bạn cần thiết đặt chính xác kích thước cực tiểu để loại bỏ giá trị. Bạn có thể đo điều này trực tiếp từ mán hình.


Kích thước cực tiểu của đoạn polyline được sản sinh do vectơ tự động hoặc trace phụ thuộc vào tham số chính xác . tham số cao sản sinh đoạn polyline kích thước nhỏ 
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-Remove Small Objects:


Loại bỏ những đối tượng kích thước nhỏ hơn một giá trị thích hợp. Kiểu sự sửa chữa này có thể được sử dụng loại bỏ vectơ có kích thước nhỏ  xuất hiện trong qua trình vectơ tự động
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-Kill Internal Objects: 


 Nếu checkbox này thiết lập, thì trong thời gian sửa chữa những đối tượng định vị trong polylines đóng sẽ được xóa. 

[image: image488.png]




-Merge Nearest Polylines:


Hòa trộn polylines gần nhất thành một bởi việc thêm đoạn mới giữa các endpoints của polylines. Khoảng cách cực tiểu để hòa trộn có thể được thiết lập bởi một tham số thích hợp.
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-Snap Nearest Polylines:


Snaps vị trí gần polylines. Cùng lúc thay đổi kích thước và vị trí của nó để nối một polyline tới polyline khác. 
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-Combine Closest Polygons:


Kết hợp vào trong một đối tượng polylines đóng ( hình đa giác) 
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-Make Orthogonal Segment:


Thay đổi góc của một đoạn polyline sao cho nó có thể trực giao với đường khác. Bạn thiết đặt giá trị góc trực tiếp trong tham số base angle hoặc  cho phép ứng dụng tính toán góc tự động. 
[image: image492.png]




Làm sao để thực hiện một sự sửa chữa polyline?


1. Mở file với  những đối tượng vectơ cần sửa chữa


2. Đánh giá sự sửa chữa và kích hoạt những giải thuật yêu cầu. Gần như tất cả chúng yêu cầu bạn cài đặt những tham số, như vậy cần đo những giá trị trong tài liệu sử dụng những công cụ thước đo. Thiết lập những tham số có thể được thực hiện từ hộp thoại Polyline Correction Options


 3. Lựa chọn những đối tượng vectơ cần sửa chữa.


4. Chạy lệnh Polylines Autocorrect.

Để khởi động lệnh :

 Từ thực đơn Correct , chọn Polyline Correction Options..
hoặc kích nút [image: image493.png]


 trên thanh công cụ VectorCorrection.

v-blocks

1-Tạo khối


Tạo ra một khối từ những đối tượng chọn.


1. Lựa chọn một đối tượng sẽ đưa vào trong khối tạo. 


2. Khởi động lệnh từ thực đơn Draw >Create block hoặc [image: image494.png]


thanh công cụ. 


3. Chỉ rõ một điểm cơ sở của khối. 

2-Chèn khối


1. Khởi động Inspector.


2. Khởi động lệnh từ thực đơn Insert> Insert Block hoặc [image: image495.png]


 thanh công cụ. 


3. Lựa chọn tên của khối từ Block Name trong Inspector. Rồi kích vị trí của điểm lchèn vào.

vi-làm đầy

1-Tạo ra shape đầy


Làm tạo ra shape đầy trên những đối tượng vectơ chọn.



[image: image496.png]


 mở một shape file.
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 lư​u trữ một shape đầy trong file.


[image: image498.png]


 lư​u trữ một shape đầy với vị trí và tên file xác định.


[image: image499.png]


chọn lọc. Thiết đặt dữ liệu chọn trên cửa sổ.


1. Lựa chọn một đối tượng để tạo .


2. Khởi động lệnh từ thực đơnTools >Create Fill Shape. hoặc [image: image500.png]


 thanh công cụ Draw .


3. Kích Save và chỉ rõ trong hội thoại tên fill shape .


4. Kích Save 

[ bmc fig_fillshapeexample.bmp }

2-kiểu Hatch nửa trong suốt


Để thiết đặt kiểu Hatch nửa trong suốt , lựa chọn một đối tượng vectơ đóng.

Trong Inspector lựa chọn giá trị TRUE cho thuộc tính Fill , và lựa chọn Semitransparent fill Trong thuộc tính Hatch type. Bây giờ bạn có thể thay đổi màu Hatch bởi việc thay đổi màu đối tượng

vii-Kiểu Ortho


Sử dụng kiểu này bạn có thể chỉ sử dụng những góc bình thường ( 0,90,180,270) để vẽ những đối tượng ( Vẽ đường, cung, hình chữ nhật v.v.) và chọn vùng ( Sự chọn lọc, sự cắt xén ) 


Những góc được vẽ trực giao với trục hệ thống tọa độ hiện thời , việc sửa đổi góc hệ thống tọa độ  ảnh hưởng thao tác kiểu ORTHO.

Những lệnh và những thao tác sau có thể làm việc trong kiểu ORTHO :


-  vẽ đối tượng( những lệnh : Draw Line, Draw Arc, Draw Rectangle, Draw Circle, Draw Polyline),


- Biên tập đối tượng với những grip,


- những lệnh : polygonal clip, manual deskew, rotate by arbitrary angle, lệnh measure 


- Đo góc [image: image501.png]


 và cách [image: image502.png]


trong hội thoại : Coordinate System, R2V Conversion options, Calibration grid


Kiểu này không ảnh hưởng các lệnh chọn lọc hoặc vẽ đường dóng .


Làm sao để vẽ những đường trực giao?


Bật trực giao bởi việc nhấn nút ORTHO trong bộ phận dưới của màn ảnh [image: image503.png]GRID(CRIHO JRoRAW





1. Tab Coordinate System  trong Tools > Coordinate System .


2. Vào giá trị góc nghiêng trong Angle,, hoặc đo góc trực tiếp trên hình ảnh với nút Measure angle

3. Nhấn Apply


4. Vẽ những đối tượng. Chú ý rằng những đường cursor bây giờ nghiêng bởi góc xác định.


5. Nếu cần thiết, mở hội thoại Coordinate System lần nữa và thiết lập lại giá trị bên trong Angle.


Để chuyển đổi kiểu ORTHO :  Kích nút [image: image504.png]ORTHO



 định vị ở đáy cửa sổ chương trình.

chương 10: thao tác bằng tay đối tượng raster và vector

i- di chuyển


1. Chọn Move từ thực đơn Modify hoặc nhấn nút [image: image505.png]


 trên thanh công cụ Modify .


2. Chỉ rõ điểm cơ sở và điểm thứ hai để di chuyển. Bạn có thể cũng di chuyển  những đối tượng chọn theo phương thẳng đứng hoặc nằm ngang bằng cách nhấn  những phím mũi tên trên bàn phím. 

ii- copy


1. Lựa chọn đối tượng sao chép.


2. Khởi động lệnh từ thực đơn Modify >Copy hoặc [image: image506.png]


thanh công cụ.

3. Để chỉ rõ một khoảng cách giữa những đối tượng sao chép, kích gần đối tượng để sao chép. Số lượng sao chép chỉ rõ trong Copy của Inspector sẽ được trình bày. Di chuyển thiết bị chuột bạn có thể sửa đổi  khoảng cách giữa chúng. Khi bạn chỉ rõ khoảng cách mong muốn bởi việc di chuyển chuột, kích để tạo ra sao chép.
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iii- quay đối tượng


1. Chọn Rotate từ thực đơn Modify hoặc nhấn nút [image: image508.png]


 trên thanh công cụ.


2. Nếu cần thiết, chỉ rõ số lượng đối tượng quay  trong trường copy của Inspector.


3. Chỉ rõ một điểm tâm quay : nhập tọa độ của nó trong Center của Inspector hoặc chỉ rõ nó trên màn ảnh, sử dụng công cụ [image: image509.png]


 được hiển thị khi hộp này được kích hoạt. 


4. Vào một góc quay trong Angle  của Inspector hoặc chỉ rõ nó trên màn ảnh với hai điểm. Nếu bạn không chỉ rõ những tọa độ  tâm quay trên bước 3, đối tượng sẽ được quay xung quanh  tâm  hình học của sự chọn lọc.

Ngoài ra, WiseImage còn hỗ trợ một số chức năng tương tự như trong Cad như: Scale, Mirror, Flip, Duplicate, Array, Offset, Align, Explode...Các công cụ này có trên thực đơn Modify

chương 11-raster và vector snap

i-Snap theo yêu cầu


Để thực hiện Snap đơn tới raster hoặc vectơ, sử dụng thực đơn cursor.  Để mở thực đơn cursor , hãy nhấn phải với CTRL. Chọn kiểu đột xuất bạn cần từ thực đơn. Để Snap tới điểm đặc trưng của đối tượng, hãy di chuyển cursor tới vị trí gần điểm cần Snap. Bạn sẽ nhìn thấy một  đánh dấu và tooltips . Kích để chấp nhận điểm snap.

Bạn có thể thay đổi những kiểu snap và kết hợp với những nút snap cho đến khi nhấn ESC, hoặc biên tập kiểu drawing/editing , hoặc thoát khỏi  nút snap.


Có thể sử dụng Snap cả raster lẫn vectơ đồng thời; cả những điểm đối tượng vectơ lẫn raster được Snap. Snap tới raster có quyền ưu tiên thấp hơn. .


 Để bật Snap cả raster lẫn vectơ , hãy thiết đặt những checkboxes trong hội thoạiSnap Settings hoặc nhấn cả hai nút tương ứng trên màn ảnh.

ii-polar Snap 


Polar snap đề xuất  phương hướng và điểm trên nó để chấp nhận. những kiểu Snap khác nhau có thể được bật và tắt trong hội thoại Snap Setup. Hội thoại này có thể được mở từ thực đơn cursor khi bạn nhấn phải trên những nút điều khiển snap. [image: image510.png]



Rsnap: Snap raster; Vsnap: snap Vectorr

iii-Thiết đặt Lưới


Thiết lập kích thước lưới, hiển thị, và snap đối tượng lưới

Những tùy chọn :


-Grid Spacing (Horizontal and Vertical):


Định nghĩa bước l​ới trong phương nằm ngang và thẳng đứng.


-Show Grid:


Trình bày lưới trên màn ảnh.


-Snap to Grid:


Bật/tắt kiểu snap lưới, giống như việc nhấn  nút GRID [image: image511.png]


.ở đáy màn hình


-Step Size (Horizontal and Vertical):


Thiết lập giá trị khoảng cách di chuyển đối tượng với những phím mũi tên trên bàn phím


-Use Grid:


Việc đặt checkbox này làm cho kích thước ô bằng những kích thước bước lưới.


Ghi chú :Việc snap tới lưới có quyền ưu tiên cao nhất qua những snap khác.

Để thay đổi màu lưới sử dụng tiết mục Colors > Grid Color trong hội thoại  Preferences 

Để khởi động lệnh : Từ thực đơn những Tools , chọn Grid Setup..

hoặc kích nút [image: image512.png]



chương 12: tìm kiếm và thay thê

i-Tìm kiếm và thay thế những đối tượng Raster và Vectơ


Thao tác tìm kiếm và thay thế có thể tìm thấy đối tượng vectơ hoặc raster ( màu và đơn sắc) và thay thế chúng với mọi tiết mục vectơ hoặc raster khác. Thao tác có thể được áp dụng thiết đặt những đối tượng vectơ.


Thao tác tìm kiếm và thay thế được thực hiện sử dụng hội thoại Search and Replace.

Trước hết nó cần chỉ rõ những khung mẫu nào cần phải được tìm thấy và thay thế cái gì. Cho  tìm kiếm và thay thế những khung mẫu của kiểu đơn Tab Classic được sử dụng. Nếu cần tới kọat động với thiết đặt phức tạp của kiểu khác, tab  SRTL được sử dụng.


Để chỉ rõ sự chuyển đổi khung mẫu đơn tới bảng Classic. Đặt một sự chọn lọc dữ liệu raster hoặc vectơ trong hộp Find What để định nghĩa một mẫu tìm kiếm và cài đặt những tham số Tìm kiếm. Để thay thế những đối tượng tìm thấy, chọn vectơ hoặc raster trong hộp Replace With.


Những Raster chọn có thể được thay thế với những mẫu Raster hoặc vectơ. Những Vectơ chọn chỉ được thay thế với những mẫu Vectơ.


Lệnh cũng cho phép cho tìm thấy những tập hợp của những đối tượng vectơ kết hợp trông như một mẫu vectơ xác định. Bạn có thể sử dụng như một tập hợp mẫu của những đường, cung, vòng tròn, và polylines. 


Tab SRTL cho phép thiết lập và bật thư viện khung mẫu đoán nhận Ký hiệu cho thao tác tìm kiếm và thay thế hiện thời.


Ghi chú : Làm việc với tab SRTL  tương tự làm việc với công cụ SRTL editor và mô tả trong chủ đề Thư viện khung mẫu đoán nhận Ký hiệu.


Để chỉ rõ mẫu tìm kiếm và thay thế đơn


1. Khởi động hội thoại Search and Replace.


2. Chọn tab Classic.


3. Đặt một mẫu tìm kiếm trong hộp Find What : Lựa chọn vùng raster trên một trong những hình ảnh raster hoặc dữ liệu vectơ trong bản vẽ. Kích nút Replace With ở trên cửa sổ hội thoại 


Trong thực đơn thả xuống, chọn tiết mục Search raster cho dữ liệu raster, hoặc tiết mục Search selection cho mẫu vectơ .


4. Chỗ thay thế mẫu bên trong hộp Replace With : Lựa chọn vùng raster trên một trong những hình ảnh raster hoặc dữ liệu vectơ trong bản vẽ.


Kích nút Replace With  ở trên cửa sổ hội thoại 


Trong thực đơn thả xuống chọn tiết mục Search raster cho dữ liệu raster , hoặc tiết mục Search selection cho mẫu vectơ .


Ghi chú : để xóa bỏ những mẫu tìm thấy, tắt hộp Replace With và bật checkbox Erase. Để làm sạch dữ liệu từ hộp Find What và Replace With ,kích nút thích hợp ở trên hộp và Clear item trong thực đơn thả xuống.


Để định nghĩa những tham số tìm kiếm và thay thế 


1. Đặt tham số Accuracy với thanh trượt - Mức được phép khác nhau giữa một đối tượng tìm kiếm với một đối tượng tìm thấy .


2. Bật  tùy chọn Erase để xóa bỏ những đối tượng tìm thấy trong quá trình thay thế. Những ký hiệu raster màu hoặc grayscale được xóa bỏ với màu chỉ rõ trong thuộc tính Background Color của hình ảnh raster hiện thời.


3. Bật Only Standalone Letters để tìm kiếm chỉ những đối tượng raster độc lập  hoặc những ký hiệu vectơ, mà không chồng lên những đối tượng khác.


Tìm kiếm và thay thế đối tượng raster và vectơ:

 
1.Nếu một raster chọn được sử dụng như một mẫu cho sự tìm kiếm và có vài hình ảnh raster sẵn có ( rõ ràng, được đặt trên những lớp không khóa) trong bản vẽ, hãy lựa chọn hình ảnh raster thích hợp với những phương pháp chọn lọc chuẩn để thực hiện thao tác.


2. Kích nút Replace All để khởi động thủ tục tìm kiếm tự động - thay thế cho những hình ảnh raster tìm thấy hoặc kích nút Find; chương trình sẽ khởi động thủ tục tìm kiếm đặc tính đầu tiên. thanh công cụ Tìm kiếm và Thay thế trình bày.
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Sử dụng những nút của nó bạn có thể điều khiển sự tìm kiếm và thay thế.


3. Khi chương trình tìm thấy một đối tượng, nó pan bản vẽ, đối tượng được trình bày trong trung tâm màn ảnh. Đối tượng này được chiếu sáng với một màu và đánh dấu chấm khung. Nếu một đối tượng thay thế được chỉ rõ, nó kéo lại qua đối tượng tìm thấy. Điểm cơ sở của những đối tượng tìm thấy và thay thế trùng nhau.
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4.  Nếu bạn không thỏa mãn với đối tượng tìm thấy, hãy kích  nút Find Next đối tượng sẽ được bỏ qua.
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 Kích nút này tiết mục sẽ được bỏ qua.
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 Nếu việc thay thế mẫu được chỉ rõ, nó được chèn vào.  Tiết mục tìm thấy có thể cũng được xóa bỏ. Nó phụ thuộc vào sự thiết đặt checkbox Erase. Sau khi thay thế, chương trình tiếp tục tìm kiếm tiết mục tiếp theo.
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 Thay thế Mọi thứ:
Tiếp tục thao tác trong kiểu tự động.
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Hủy bỏ thao tác tìm kiếm - Thay thế hiện thời.
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 Dừng thủ tục tìm kiếm - Thay thế.


5.  Nếu chương trình tìm thấy đối tượng tiếp theo, thì bạn có thể thực hiện bất kỳ thao tác nào mô tả trong bước 4.  Nếu đối tượng tiếp theo chưa được tìm thấy, thì thủ tục được hoàn thành.
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Tìm thấy những đối tượng raster trên bản đồ RGB và đặt một vòng tròn vectơ nửa trong suốt trên chúng

ii- Tìm Ký hiệu Raster


Tiết mục này chỉ rõ màu của một đối tượng raster bitonal tìm thấy khi sử dụng Search and Replace.


Mô tả tùy chọn được sửa đổi trong hộp thoại Preferences.
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Chương 13-in tài liệu

1-In


Làm sao để chọn dữ liệu để in? Trước khi in một tài liệu WiseImage, bạn cần quyết định những lớp hiện hữu nào để in.  Nếu bạn không muốn in một phần nào đó, hãy tắt hiển thị chúng trong những lớp. Bạn cần phải chú ý rằng những đối tượng WiseImage được in trong cùng màu đó và trong cùng thứ tự như chúng được trình bày trong màn ảnh. Bạn có thể thay đổi thứ tự hiển thị đối tượng, sử dụng những lệnh từ thực đơn con Display Order của thực đơn Draw

Làm sao để chỉ rõ vùng in, tỷ lệ và lề in? 


1. Từ thực đơn File, chọn Print. Hộp thoại xuất hiện.


2. Lựa chọn thiết bị máy in nếu máy bạn cài đặt nhiều máy in. 


3. Chọn nút cài đặt nếu bạn muốn thay đổi những sự thiết đặt máy in hiện thời như kích thước giấy, nguồn giấy, vân vân.


4. Chỉ rõ một vùng in trong Area. Chọn Extensions để in toàn bộ tài liệu,

 hoặc chọn View  để in vùng they được trên màn ảnh,

 hoặc Chọn Window và chỉ rõ tọa độ góc của một vùng hình chữ nhật sẽ được in. Để chỉ rõ góc một vùng in:


Nhập những tọa độ góc trong hộp tương ứng X và Y. Bạn có thể sử dụng nút đo để chỉ rõ những góc của vùng trên màn ảnh.


5. Trong Scale đặt một tỷ lệ in. Chọn Fit to Paper để tỷ lệ vùng in lấp đầy khổ giấy đã chọn. Chọn Scaled để đặt hệ số tỷ lệ chính xác và nhập sự tăng / Giảm hệ số trong phần trăm. Cho ví dụ, 200 % có nghĩa là tăng gấp đôi một hình ảnh Khi In; Nếu bạn muốn một đơn vị hiển thị hình ảnh tương ứng tới một đơn vị In hình ảnh, đặt 100 %.


6. Chỉ rõ những lề trang. 


7.  Nếu máy in đầu ra nhỏ hơn kích thước giấy hiện thời, thì bạn có thể chỉ rõ kiểu sắp hàng vùng in trong quan hệ tới lề giấy.  Để chỉ rõ kiểu sắp thành hàng , hãy nhấn nút thích hợp trong trường Alignment. [image: image522.png]


, nếu đầu ra in lớn hơn kích thước giấy hiện thời, trường này được vô hiệu hóa.



8. Đặt số lượng bản in.


9. Trong mục Page Range thiết lập trang để in .  Nếu hình ảnh của bạn lớn hơn kích thước trang hiện thời, thì nó tách thành nhiều phần. Trong trường hợp nhiều trang, hình ảnh của bạn phân tán bởi những trang theo thứ tự : phải- trái, trên - xuống. 


10.  Để khởi động in , nhấn Ok.

ii-vùng in và lưới in


Print Area - Tùy chọn này đặt màu cho viền của một vùng sẽ được In với lệnh In. Vùng này có thể đại diện một đoạn tài liệu, dữ liệu định vị trên  màn ảnh hiện thời hoặc tất cả các đối tượng được chứa đựng trong tài liệu. 


Print Grid - Tùy chọn này đặt màu cho viền của khuôn dạng giấy hiện thời.  Nếu dữ liệu được chứa đựng trong một trang, thì nó phân tán tự động bởi số danh sách. Định dạng giấy hiện thời là tập hợp được thiết đặt trong máy in, ở đó bạn có thể chuyển bởi việc kích vào Setup.


Print Area  và Print Grid được trình bày khi hội thoại In hiển thị. 


Trong ví dụ này chúng ta cho thấy tình  trạng 

mặc định màu: hình chữ nhật đỏ cho thấy dữ liệu sẽ

 được in, hai hình chữ nhật xanh lục đại diện hai

 khuôn dạng giấy hiện thời trên sẽ thực hiện in.


Nếu khuôn dạng giấy được cân bằng với vùng

in, thì các viền trùng nhau.


Khi thay đổi những tham số Trong hội thoại In

 (tỷ lệ, định dạng giấy,) khung cũng được thay đổi theo

 những tham số này.

.

Mục lục:

1Chương 1:tổng quan


2Chương 2: Các version của WiseImage


3Chương 3: cơ sở WiseImage


3i-Cơ sở WiseImage


3ii-WiseImage Document


4Chương 4: giao diện


4i-Trình bày hoặc che giấu những thanh công cụ.


4ii-Trình bày hoặc che giấu thanh tình trạng trên màn ảnh.


4iii-Trình bày hoặc che giấu thước đo trên màn ảnh.


4iv-Chia nhiều cửa sổ tài liệu


5v-Named views


5vi-Cửa sổ Xem trước


5vii-Birds Eye


5viii-ẩn những vectơ


5ix-ẩn những raster


6x-hiển thị chiều rộng


6xi- Command Line


6xii- Yêu cầu tảI


7xiii-Những lệnh xuyên suốt


7xiv-Giao diện tiếng Anh trong Những phiên bản WiseImage


7Chương 5: quá trình hoạt động


7i-Tạo:


71-Tài liệu mới


72-Tạo raster image mới


83-Khung mẫu tài liệu và raster


9ii-Mở và lưu:


91- Mở


112-Lưu dữ liệu:


133-Mở/Lưu định file:


18iii-Nhập khẩu, xuất khẩu:


181- Nhập khẩu:


182- Nhập khẩu định dạng file DGN:


183- Nhập khẩu shap file


194-Xuất khẩu:


205-Tuỳ chọn xuất khẩu Mapinfor:


206-Xuất khẩu tới khuôn dạng shape-file:


21iv-Thao tác với Raster


221-Thay đổi những thuộc tính hình ảnh:


222-Quản lý những hình ảnh :


233-Kiểu xem trước ( Mờ đục, nửa trong suốt, Trong suốt):


244-Làm việc với Clipboord


245-Làm việc với text


26Chương 6: các công cụ chính


26i-Inspector


271-Inspector


292-kiểu lọc Inspector


293-Những thuộc tính đối tượng chung


30ii-quản lý ảnh


301-Hội thoại quản lý hình ảnh


312-Lưu hình ảnh raster liên kết hoặc nhúng


323-Xóa hình ảnh raster từ tài liệu


324-Làm tăng tốc độ tải một tài liệu chứa đựng nhiều hình ảnh raster


32iii-quản lý lớp


321-Tạo ra một lớp


322- Xoá lớp


323-Đôi tên lớp


334- Làm cho một lớp hoạt động


335-Điều khiển tính thấy được của Lớp


336-Khoá, mở lớp


337-Mở hộp thoại quản lú lớp


33iv-quản lý khối


34v-kiểu đường


351-Kiểu đường là gì?


352- Quản lý kiểu đường


363-Hội thoại Pattern Style


364-Những kiểu phức tập


37vi-kiểu text


37Vii- sự làm sạch


38viii-Clipbook


381-Di chuyển đồ họa vào trong Clipbook


392-quản lý nội dung clipbook


393-Quản lý những tiết mục Clipbook


394-Dán đồ họa từ Clipbook


40ix-hệ thống tọa độ


401-Tab Coordinate System:


412-Bảng Units


413-Tab Advanced


42x-Cửa sổ Đo (Measure)


43xi-hộp thoại Preferences


45Chương 7: chọn lọc


45i-Thiếp lập chọn lọc


45ii-Các phương pháp và nút Chọn lọc


48iii-Thủ tục tạo thiết đặt Chọn lựa


481-Chọn lựa đối tượng Vectơ


482-Chọn lựa toàn bộ hình ảnh


483-Lựa chọn một hình ảnh raster


484-Lựa chọn vài hình ảnh raster


495- Chọn lựa những đối tượng Raster


496-Lựa chọn một hoặc vài vùng trên những hình ảnh raster


497-Tạo những kiểu thiết đặt chọn lọc


508-Lựa chọn / bỏ lựa chọn tất cả


509-Chọn lọc đích


5010-Những kiểu Chọn lọc


50iv-Những kiểu chọn lọc


501-Lựa chọn đối tượng Raster bằng cách pick chuột


512-Chọn đối tượng raster độc lập


523-Chọn lựa bắt buộc


524-Chọn ký hiệu raster


535-Chọn lựa với cửa sổ và vùng đa giác


546-So sánh phương pháp chọn lọc Within Window


557-Lựa chọn bằng Fence


56v-công cụ lọc


57vi-Điều chỉnh Chọn lọc


571-Những tham số chọn lọc Raster


582-Đo chiều rộng Max trên một hình ảnh


583-Để đo Max Break  trên một hình ảnh


58Chương 8: biên tập raster


58i-công cụ làm sạch


581-Crop


592-Thay đổi kích thước và resample


613-xóa vết lốm đốm


614-Tách hình ảnh


635- Deskew (chỉnh nghiêng)


636- Làm trơn


647- Sự đảo ngược


648-Hiệu chỉnh 4 điểm


659-Nắn ảnh(Calibration)


7310-Auto Correction (hiệu chỉnh tự động)


7411- Làm dày/mỏng raster


7512- Làm đầy những đọan gãy


7513-Đường viền


75ii-vẽ raster


751- Flood Erase


752- Flood Fill


763- Pencil


764-Biên tập text raster


765-Màu tô đầy


77iii-đối xứng


77iv-Quay


77v-lọc


771-lọc đơn sắc


782-lọc màu


79vi-xử lý màu


791-Thay đổi khỏang cách màu


812-Thay đổi số màu


833- Binarization


844-Adaptive Binarization


845-Sự tách màu


856-Độ chói và tương phản


857-hiệu chỉnh bằng biểu đồ


87viii-Clip


87chương 9 :chuyển đổi (raster to vectorr)


87i-trace


871-trace tự động


882-trace bắt buộc(thủ công)


893-trace outline


894-trace symbol


895-Trace Hatch


906-Tracing polylines


927-các kiểu trace:


938-Sự điều chỉnh trace


939-Mô tả những tham số trace


9510-điều khiển thuộc tính đối tượng tạo ra


9711-Sửa đổi những thuộc tính khoảng


9712-Lưu trữ những sự thiết đặt cho bảng chiều rộng


97ii-automatic


971-Raster to vectorr


982-Giải thuật đoán nhận điểm


983-Đoán nhận text


993-Thiết lập số hóa trong hộp thoại Conversion Options


107chương 9: biên tập vec ter


107i-Vẽ thực thể vecctor


109ii-thứ tự hiển thị


109iii-hiệu chỉnh vector


113iv-Hiệu chỉnh tự động


1131-Hiệu chỉnh tự động vectorr


1132-Vector Correction Options


1133-Hiệu chỉnh tự động polyline


1144-Những tùy chọn sửa chữa Polyline
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1161-Tạo khối


1162-Chèn khối


116vi-làm đầy


1161-Tạo ra shape đầy


1162-kiểu Hatch nửa trong suốt


116vii-Kiểu Ortho
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117ii- copy
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119i-Tìm kiếm và thay thế những đối tượng Raster và Vectơ


121ii- Tìm Ký hiệu Raster
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1211-In


122ii-vùng in và lưới in
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Một đối tượng raster ( 1) là một loạt những điểm đại diện một hình ảnh. 


Một đối tượng vectơ ( 2) là một biểu thức toán học phát sinh một thực thể đồ họa
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Trình bày tên khối. Nhấn đúp vào tên này bạn có thể đổi tên khối. Bạn không thể gán tới một tên của một khối đã có. Điều này có thể làm được khi một khối mới được tạo ra;  nếu bạn vào tên một khối hiện hữu, thì bạn được nhắc để thay thế khối cũ với tên mới này. 
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Chương trình lựa chọn  ký tự A, vòng tròn, và hình chữ nhật bên trong cửa sổ chọn lọc. 





Chú ý rằng toàn bộ line raster chéo qua ranh giới cửa sổ chọn lọc không được chọn





Khi sử dụng phư�ơng pháp Within Window dựa vào  giải thuật Line Following , sự chọn lọc bao gồm ký tự  raster “A ”, Vòng tròn, hình chữ nhật và những bộ phận của những line raster giữa hình chữ nhật raster và vòng tròn.  Chương trình không chọn những bộ phận nằm ngoài
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Hình này cho thấy kết quả Sử dụng phương pháp chọn lọc Within Window  dựa vào Floodfilling. Chương trình chỉ lựa chọn một đối t�ợng raster cô lập ( ký tự “ A ”), và loại trừ tất cả các đối tượng raster khác bởi vì chúng không là outline





Danh sách Type cho thấy những kiểu các đối tượng trong tài liệu. Việc chọn Any lựa chọn tất cả các đối tượng trong danh sách Type. Trong colorr, có thể chọn màu và lệnh sẽ lựa chọn  duy nhất những đối tượng có màu xác định. Any là “ bất kỳ màu nào”. Danh sách layer cho thấy tất cả các lớp. 
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Cho ví dụ, bạn có thể canh lề hình ảnh tới cạnh trên-trái bởi việc chọn nút upper-left .  Để đặt hình ảnh Tới trung tâm , hãy chọn nút central.	
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1. Định nghĩa tập hợp chọn lọc bạn muốn xử lý và chọn Thickening từ thực đơn Filters hoặc nhấn nút  � trên  thanh công cụ .	


2.	Lựa chọn một phương hướng mong muốn làm đặc : Horizontal, Vertical , All


3.	Chọn Apply
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Trong nử phải của Tab là Entities tree. Trên mức đầu tiên có những giải thuật đoán nhận. Để bật giải thuật cần thiết, bạn cần chọn một checkmark của nó. Trên mức thứ hai có những hàm và những tham số bổ sung của những giải thuật tương ứng mà có những khả năng để chọn của sự đoán nhận rõ ràng với Những ký hiệu  “+”/”-“ : nếu mức thứ hai được che giấu thì có ký hiệu "+", còn không là "-".


Để có sự truy nhập tới những tham số bổ sung của giải thuật được ẩn, kích vào dấu "+" của nó.


	 





Hình trình bày vectơ kết quả khi chỉ có giải thuật đoán nhận line bật. Đoạn raster nguyên bản bên trái; bên phải là vectơ kết quả khi tùy chọn chiều rộng đối tượng được tắt.





Hình bên thể hiện kết quả  vectơ của những line và arc, circles.  hình bên  phải đại diện vectơ kết quả khi hiển thị chiều rộng đối tượng đã tắt.





None - Không sản sinh kết quả số hóa text raster. Những vùng chứa những văn bản raster được lờ đi.


Text Areas - Tạo ranh giới hình chữ nhật của  text raster .  Những vùng này không được số hóa. Những text Vectơ có thể được vào bằng tay với sự giúp đỡ của thủ tục xem và sửa chữa văn bản mô tả ở bên dưới trong chương này.


Polylines - ước lượng những đường trung tâm của text raster với polylines .


Outlines- ước lượng ranh giới của những text raster bởi polylines.


OCR - Đoán nhận những text raster và tạo ra những đối tượng văn bản. 
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